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Copyright and Trademarks

Copyright

Osprey Technologies, Inc., a wholly owned subsidiary of ViewCast Corporation,
copyrights this document. No part of this specification may be reproduced,
transcribed, transmitted or stored in a retrieval system in any part or by any means
without the express written consent of Osprey Technologies, Inc.

Disclaimer

Osprey Technologies, Inc. reserves the right to change any products herein at any
time and without notice. ViewCast Corporation and Osprey Technologies, Inc. make
no representations or warranties regarding the content of this document, and
assume no responsibility for any errors contained herein.

Trademark Acknowledgment

Osprey-2000, Osprey-2000 Pro, Osprey-2000 DV Pro, Osprey-2000 D DV, Osprey-
2000 D Pro, and Osprey-2000 D DV Pro are trademarks of Osprey Technologies, Inc.
RealProducer and RealPlayer are trademarks or registered trademarks of
RealNetworks, Inc. Microsoft, Windows 2000, Windows NT, NetMeeting, Windows
Media Encoder, and Video for Windows are trademarks or registered trademarks of
Microsoft Corporation. Any other product names, trademarks, trade names, service
marks, or service names owned or registered by any other company and mentioned
herein are the property of their respective companies.

FCC Notice

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this device does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the computer and the receiver.

Connect the computer into an outlet on a circuit different from that to which
the receiver is connected.

¢+ Consult the dealer or an experienced radio/TV technician for help.
Shielded Cables

Connections between this device and peripherals must be made using shielded
cables in order to maintain compliance with FCC radio emission limits.



Modifications

Modifications to this device not approved by Osprey Technologies, Inc. could void the
authority granted to the user by the FCC to operate the device.

Note to CATV Installer

This reminder is provided to call to the CATV installer’s attention Section 820-40 of
the NEC, which provides guidelines for proper grounding and, in particular, specifies
that the cable ground shall be connected to the grounding system of the building, as
close to the point of cable entry as practical.
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Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

Chapter 1 - Getting to Know the Osprey-
2000 Capture Cards

The Osprey-2000 Driver User’'s Guide provides practical information for installing and
configuring the hardware and software for the Osprey-2000 family of cards. This
guide has been designed with the needs of the end user in mind, particularly novices
and those working with existing applications.

Symbols

Introduction

Overview of the Basic Data Flow
Features

Software Included

Compatible Third-Party Applications
Getting Help

Symbols

& This symbol denotes an important note or warning.

This shortcut icon points more experienced users to sections or chapters
that summarize step-by-step instructions.

Introduction

The Osprey-2000 family of products is designed for the growing sector of
professional media creators, broadcasters and providers seeking solutions for MPEG
encoding, streaming, transcoding and digital archiving. Osprey-2000 is a complete
MPEG-1 and MPEG-2 codec that can handle all network video communication needs.
Osprey-2000 delivers the ability to multicast broadband video streams from both
analog and digital sources, archive professional quality MPEG streams, and transcode
DV to MPEG or MPEG to a streaming media format.

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 11



Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

Ranging from an analog MPEG-1 and MPEG-2 codec to a complete analog and digital
capture card with MPEG encode, decode and transcoding capabilities, this family of
cards brings everything together:

Three Operating Modes Available with Osprey-2000
Six Models of the Osprey-2000
Model Breakdown by Feature and Input Type

Overview of the Basic Data Flow

Three Operating Modes

Three independent operating modes are available with the Osprey-2000:

¢ Capture/Preview
¢ MPEG Encode
¢ MPEG Decode

Capture/Preview

Preview is defined as viewing video in a window on the computer monitor and
listening to audio via the audio output jack. Preview can be utilized by itself or during
audio/video capture, encode and decode.

Capture is defined by the providing of audio/video data to a host application. This
application could save the data to disk (i.e., AVI based capture), further process the
data (i.e., encode into the Real or Windows Media format), or other such tasks. The
capture feature is also possible during decoding, which makes MPEG transcoding
possible.

Starting with Software Release 2.1, the Osprey-2000 is SimulStream capable.
SimulStreaming is an added-cost upgrade that allows the driver to capture and
display video and audio to multiple destinations from a single card. Please see the
SimulStreaming User’s Guide which is installed in the Osprey 2000 Program group
for details about this feature.

Also see Chapter 7 - MPEG Transcode

MPEG Encode

MPEG-based encoding serves the streaming space for both live and video-on-demand
purposes. It is ideally suited for enterprise networked video applications where
quality is paramount. MPEG encoding is available from any of the input sources,
including DV, which makes DV to MPEG transcoding possible.

12 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

Encoded MPEG streams are moved to a host application where the data can be
archived to disk for later on-demand retrieval or further processing (such as
transcoding into another streaming format), streamed over a network, or authored
onto a DVD. Optionally, the material being encoded may be previewed by using the
audio/video preview feature.

Also see Chapter 5 - MPEG Encoding

MPEG Decode

The MPEG decoding feature allows hardware decoding of high quality MPEG content.
The decoding of an MPEG source can be either viewed using the preview feature or
recaptured using the capture feature. The video during decode may be previewed
either on the computer monitor or on an externally NTSC/PAL monitor using the
composite/S-Video output jacks. Using the capture feature with MPEG decode, it is
possible to transcode MPEG to another streaming media format such as Real or
Windows Media.

Also see Chapter 6 - MPEG Decoding

Six Models of the Osprey-2000

Codec Models
Decode Models

Within the three modes of operation (capture/preview, MPEG encode, and MPEG
decode), six versions of the Osprey-2000 are available. All six models have
capture/preview functionality.

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 13
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Codec Models

Three MPEG codec models act as audio/video capture cards and differ only by input
types. Three models have both MPEG encode and MPEG decode capabilities:

Board Type

Description

Osprey-2000

Full MPEG-2 codec with analog inputs.

The Osprey-2000 model is the base
MPEG encoder and decoder card coupled
with capture card capabilities. All
inputs/output are analog. These include
analog composite and S-Video, and
unbalanced and balanced audio.

Osprey-2000 Pro

Full MPEG-2 codec with SDI, AES/EBU
and analog inputs.

The Osprey-2000 Pro includes all of the
features of the Osprey-2000 plus
professional digital video and audio
inputs. These inputs are SDI video
(SMPTE-259M) with embedded audio and
an external AES/EBU audio input.

Osprey-2000 DV Pro

Full MPEG-2 codec with SDI, AES/EBU,
DV and analog inputs.

The Osprey-2000 DV Pro includes
everything found in the Osprey-2000 Pro
model plus an IEEE-1394 port for a DV
input. The DV input provides for real
time decoding of DV in hardware. The
result of this decode is a digital
uncompressed audio and video stream.
Audio and video can be selected just like
the other inputs for capture or for MPEG
encoding, facilitating DV to MPEG
transcoding as well as capture of
decompressed DV in real time.

14 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation
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Decode Models

The three MPEG decode models also act as audio/video capture cards with analog
inputs, and differ only in their digital input options. All models provide for decoding
of MPEG in real time. The decoded stream can be viewed (i.e., playback) and can
also be captured back to the host. This recapture effectively enables transcoding of
MPEG content into other formats (for instance, .mpg to .rm or .asf).

Board Type Description

Osprey-2000 D DV MPEG-2 decoder/transcoder with DV and
analog inputs.

The Osprey-2000 D DV model is the base
MPEG decoder with an IEEE-1394 port
for a DV input. The DV input provides for
real time decoding of DV in hardware.
The result of this decode is a digital
uncompressed audio and video stream
that can be selected as any other input
for capture. This feature makes possible
the capture of decompressed DV in real
time.

Osprey-2000 D Pro MPEG-2 decoder/transcoder with DV and
analog inputs.

The Osprey-2000 D Pro model is similar
to the Osprey-2000 D DV, except that it
has an SDI input and an AES/EBU input
for capture of digital audio and video.
There is no DV capture on this board.

Osprey-2000 D DV Pro MPEG-2 decoder/transcoder with SDI,
AES/EBU, DV and analog inputs.

The Osprey-2000 D DV Pro model
combines all the capture capabilities of
the Osprey-2000 D DV and the Osprey-
2000 D Pro models.

Also see Model Breakdown by Feature and Input Type and Overview of the
Basic Data Flow.

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 15
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Model Breakdown by Feature and Input Type

Model MPEG MPEG Analog DV (IEEE |SDI video, |Outputs:
Encode Decode composite, {1394) input|SDI Composite,
S-Video, (video and |[embedded ([S-Video,
unbalanced |audio) audio, unbalanced
and external audio
balanced AES/EBU
audio
Codec Models
2000 X X
2000 Pro
2000 DV X X X
Pro
Decode Models
2000 D DV X X X X
2000 D-Pro
2000 D-DV X X X X X
Pro
Overview of the Basic Data Flow
Thnbalanced Audiow Dis | * A PEG
Composite Videod— " y V] Decods —
awide o4—
Composite Video—m . | Video .
_ AT Video §»| Capture
sideo—m Tnput
=D Extract
STl—» 2ot Vg Sefect ¥ audio
—»
DV (TEEE-13%)— T Decode [V ™ Capture
Tnbalance ry L : Lo
A S o Fonde [
Baanced
o select
Digital AESEET -
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Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

Features

Inputs

Outputs

Audio/Video Processing
MPEG Encoding

MPEG Decoding

MPEG Encoding/Decoding
Computing Platforms
Hardware System
Connections

Video Frame Rates and Performance

Inputs

The inputs feed both the MPEG encoder and audio/video capture nature of the
device. Inputs are either on the back plate of the card or on one of the three
breakout options (breakout cable, breakout box, 1u rack-mount dual-card input
unit).

Video Inputs

Audio Inputs

Video Inputs

NTSC and PAL

Composite (BNC, a BNC to RCA converter is supplied)
S-Video (mini-DIN)

DV (via IEEE-1394 4-pin connector)

SDI (SMPTE-259M)

* & & o o

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 17
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Audio Inputs

Unbalanced stereo (two RCA connectors)

Balanced stereo (two XLR connectors)

DV (IEEE 1394 4-pin connector)

SDI (SMPTE-259M) embedded 2 channel audio
External AES/EBU digital audio (single XLR connector)

* & & o o

Outputs

The video output is applicable only to the result of decoded MPEG video.

The audio output can be either a loopback (i.e., monitor) output from one of the
various audio inputs or the audio from a decoded MPEG stream.

Video Outputs

¢ Composite (BNC)
¢ S-Video (mini-DIN)

Audio Outputs
+ Unbalanced audio (two RCA connectors)

Audio/Video Processing

A variety of processing options can be applied to audio and video data as it flows
through the hardware and to the host. Some options are applicable only for certain
inputs; others may be applicable only for capture, encode or decode. Some
processing options may be handled in software instead of in hardware.

Audio
Video

Audio

+ Multiple Sample Rates are provided in hardware for analog audio sources
(32 KHz, 44.1KHz and 48 KHz). Audio sample rate down conversion can be
applied in software for capture applications.

+ Gain and Attenuation can be controlled in hardware for analog inputs. For
digital inputs a software gain or attenuation can be applied for capture
applications.

+ External Monitoring of Audio is provided for any of the audio input sources
as well for the decoded MPEG audio. The audio output is a stereo unbalanced
output. There is no additional gain or attenuation applied in the audio output
path.

18 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation
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Video

Cropping can be applied in hardware to any video source before capture.

Scaling can be applied in hardware to any video source before capture. The
MPEG encoding processing can also scale input video sources providing for a
range of MPEG encoding resolutions.

Color-Space Conversion can be applied in hardware before video is
captured to the host. Supported color formats are:

3 RGB (32/24/16/15)

. YUV (4:2:2 packed or planar YVU9/YUV12)

. Grayscale (Y)

Brightness/Contrast/Saturation/Hue adjustments can be applied to the
analog inputs prior to capture or encoding (hue not applicable to PAL signals).
For digital inputs, only the first three can be adjusted and only prior to
capture.

DV Decoding in hardware produces a decompressed video and
uncompressed audio stream that can be MPEG encoded or captured. This

allows for DV->MPEG transcoding or decompressed DV capture to feed host
applications (such as RealProducer or the Windows Media Encoder).

MPEG Encoding

Any of the audio or video inputs can be encoded into MPEG including the DV input
which makes possible DV->MPEG real time transcoding.

* & 6 6 6 o o o

MPEG-1 System Streams

MPEG-2 Program and Transport streams

Resolutions up to and including 704x480 NTSC, 704x576 PAL
Variable and Constant bitrate encoding

MPEG-1 Layer-I or II audio

Up to 8Mbits/sec

Audio optionally monitored via external connection

Video optionally previewed in a window on host

MPEG Decoding

The Osprey-2000 handles streaming decode of MPEG content. The decoded audio
and video can be viewed externally (speakers/video-monitor), viewed on the
computer monitor, or recaptured to feed the audio/video needs of a host application.
The recapture nature allows for real time transcoding of MPEG into other formats
such as the Real or Windows Media formats. When recapturing, the capture
processing options described under MPEG Encoding can be applied.

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 19
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¢ MPEG-1 System Streams
MPEG-2 Program Streams

MPEG-2 Transport streams via software Transport->Program stream
conversion*

MPEG-1 Layer-I or II audio

Up to 8Mbits/sec

Audio optionally monitored via external connection

Video optionally monitored externally via composite/S-Video outputs
Video optionally previewed in a window on host

Video and/or Audio optionally recaptured to the host for saving to disk or
recompression into another host application dependent format

* & & 6 o o

*Not available in Release 1.0.1

MPEG Encoding/Decoding

Both MPEG encoding and decoding can be processed at the same time using digital
inputs.

Audio monitored on speakers
Video in a window or on external monitor (decoded MPEG video only)
Audio can be dynamically switched between encode and decode

Video view on host monitor can be dynamically switched between encode and
decode

Encode and Decode are physically separate units. They can, for example,
encode MPEG-2 and decode MPEG-1, or encode NTSC and decode PAL
streams.

* & o o

<>

Computing Platforms

¢ Windows 2000 Professional
¢ Windows NT 4.0 (DirectShow software is not supported under Windows NT)

Hardware System

¢ 32-bit/5-volt PCI card
¢ Full PCI Rev. 2.2 compliance
¢ Multiple board support
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|
Connections

BNC for SDI input on back-plate
4Pin IEEE-1394 for DV input on back-plate

A Mini-DIN provides for all outputs: composite, S-Video, unbalanced audio
(8mm)

¢ A DB-15 provides for all other inputs: composite (BNC), S-Video, unbalanced
audio (2xRCA), balanced audio (2xXLR) and AES/EBU digital audio (1xXLR)

DB-15 can be used to connect to:
Breakout box

Breakout cable

Optional 1U Osprey Breakout Panel

* & o o

Video Frame Rates and Performance

The Osprey-2000 can deliver to the host 29.97 frames per second (fps) full
resolution NTSC (720x480) as well as 25 fps full resolution PAL (720x576). The
Osprey-2000 uses Direct Memory Access (DMA) to efficiently perform this delivery of
both video and audio data to the host.

Once the data is in host memory, performance is directly affected by how the data is
processed. The different encoding options of various streaming encoding applications
have varying CPU requirements and are outside the scope of this manual.

The Osprey-2000 also supports DirectDraw for displaying video with minimal load on
the system processor.

It should be noted that uncompressed video bandwidth is very large.

Video at 640x480 with a 16bit color format at 30fps results in more than
18Mbytes/sec of data transfer across the PCI bus. PCI bandwidth issues,
which may result due to other high bandwidth demanding devices on the

ii PCI bus, can limit performance.

For example, having PCI based SCSI controllers on the same bus as the
Osprey-2000 may consume large amounts of PCI bandwidth if there is a
significant amount of SCSI disk activity (such as capturing uncompressed
video to disk). The most optimal configuration is to use a 64bit SCSI
controller that is physically on a separate PCI bus than the Osprey-2000.
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Software Included

The products for Windows 2000 and Windows NT 4.0 include:
MPEG Software
Audio/Video Capture Software

Software Development Kits (SDK) and Application Programming Interfaces
(API)

MPEG Software

DirectShow Filters for MPEG encode and decode (for Windows 2000 only)
OPI Drivers

MPEG encode demo (applicable for encode models only) (for Windows 2000
only)

¢ MPEG decode demo for external audio/video and transcoding use (for
Windows 2000 only)

¢ MPEG transcode demo for converting MPEG files to uncompressed AVI files
(for Windows 2000 only)

¢ MpegVCR, a digital VCR application

Audio/Video Capture Software

+ A Video for Windows compatible video capture driver (capable of being
upgraded to SimulStream)

+ An audio Mixer and an audio Wave capture driver (capable of being upgraded
to SimulStream)

VidCap32 - a simple capture application and testing and demo program

AmCap - a simple capture application (and testing and demo program) using
the DirectX/DirectShow API (same API used by Windows Media Encoder)

CropApp — an application to control cropping the input video source
Indeo codec (provides YVU9 color format and software for AVI compression)

Beginning with Version 2.1, the driver is SimulStream capable. SimulStreaming is an
added-cost upgrade that allows the driver to capture and display video and audio to
multiple destinations from a single card. Please see the SimulStreaming User’s Guide
which is installed in the Osprey 2000 Program group for details about this feature.

22 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

SDKs and API Software

¢ DirectShow Runtime (includes MPEG decode and MPEG encode applets; for
Windows 2000 only)

OPI Runtime (includes MpegVCR, a digital VCR application)

DirectShow SDK (for Windows 2000 only)

Video For Windows SDK

OPI (Osprey Programming Interface) SDK

DXMedia (Microsoft runtime for DirectShow, only needed for Windows NT 4.0)

* & & o o

The three software development kits (Video for Windows, DirectShow, and OPI) and
the two Runtimes are packaged as optional components that the user may install.
These components are not required, but they provide beneficial features. For
instance, the OPI Runtime provides a digital VCR application, and the DirectShow
Runtime provides MPEG encode/decode applications, and DirectShow filters.

The DirectShow features are available only under Windows 2000.

Compatible Third-Party Applications

RealNetworks' RealProducer and Microsoft's Windows Media Encoder are compatible
with the Osprey-2000 family.

Other compatible applications are being determined at this time. For the latest
product news, please continue to visit our web site http://www.ospreyvideo.com/.

Getting Help

Before contacting Osprey support, please do the following:

¢ Work through Testing the Installation for Windows 2000 in Chapter 3 or
Testing the Installation for Windows NT in Chapter 4.

Read through Chapter 11 - Troubleshooting.

Visit our web site at http://www.ospreyvideo.com/ and read the Osprey-2000
FAQs by selecting FAQ -> Osprey-2000.

If you have done that and you’re still having problems, contact the Osprey Support
Group at:

Voice, toll free (888) 684-6622
Voice (919) 319-9200
Fax (919) 319-9814
Email mailto:Support@viewcast.com

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 23


mailto:Support@viewcast.com

Chapter 1 - Getting to Know the Osprey-2000 Capture Cards

When you contact support, especially if it is by email, please include the following

information:

1.  Which product you have:

Osprey-2000 Osprey-2000 D DV

Osprey-2000 Pro Osprey-2000 D Pro

Osprey-2000 DV Pro Osprey-2000 D DV Pro

2.  Which operating system you are using. Certain minor aspects of the Osprey-
2000 drivers are different between Windows 2000 and Windows NT 4.

3.  Which version of the Osprey-2000 driver you are using. The version information
is on the title bar of the driver’s Control Dialog, as well as in the first message
of the installation program and in the ReadMe.txt file in the Osprey-2000
Program group. The version number is also in a file named ReadMe.txt in the
top-level folder of the CD that contains the driver and software.

4.  Which optional components of the Osprey-2000 software you have installed.
The optional components are OPI Runtime, DirectShow Runtime, VFW Software
Developers' Kit (SDK), OPI SDK, and DirectShow SDK.

5. The type of audio and video source being used (for example: SDI video and
AES/EBU audio) and the type of equipment being used as the source (for
example: a Sony A500 Digital Betacam Deck).

6. Any additional details about your system configuration would be helpful - for
example, the system speed, processor type, motherboard chipset, whether you
have a SCSI or IDE hard drive, whether you have a network adapter card, and
the type of display adapter card.

7. A detailed description of the problem.
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Chapter 2- Osprey-2000 Hardware

The Osprey-2000 MPEG cards are 32-bit, 5-Volt PCI cards. They are compliant with
version 2.2 of the PCI hardware specification.

The DV option of the Osprey-2000 is a daughter card. The following models have
both the base card and a daughter card.

¢ Osprey-2000 DV Pro
¢ Osprey-2000 D DV
¢ Osprey-2000 D DV Pro

Below is a picture of the Osprey-2000 DV Pro (actual hardware may differ in minor
ways).

the back side of the board. The model name (for instance, Osprey-2000 D

i To determine the model of any Osprey-2000 product, check the sticker on
DV Pro) appears on the edge opposite the back plate.

System Requirements
Configuring the Video Capture Driver
Installing the Osprey Card

Connecting Cables
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System Requirements

For x86 PCs, the minimum system requirements are as follows:

A Pentium III processor or higher for the hardware

One available PCI slot

Windows NT 4.0 or Windows 2000

DirectX 8 or higher for Windows 2000

Approximately 27 megabytes of storage for system files

* & & o o

For optimum performance, we recommend a video display adapter with the following
additional features:

+ 8MBytes memory minimum

¢ Direct Draw capability

+ An up-to-date display device driver with Direct Draw capability

With the Osprey-2000 you can use on-board audio capture capability to
capture sound and multiple cards to capture multiple audio streams.
However, you still need a sound card to monitor or play back audio since
the Osprey-2000 is a capture/codec device and not an audio playback
device. The Osprey-2000 will only provide audio-out while the card is
capturing or encoding/decoding MPEG.

Configuring the Audio Capture Driver in
AmCap

Hln AMCAP - G2\ junk.avi

File | Devices Options Capture  Help
i__! v ozkve.dll - Dsprey-2000 Codec 1

v Osprey 2000 Sudio
Aureal Audio

Captured 334 frames in 226 zec (0 diopped): 14.7 fpz 4.534 Meg,
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AmCap requires configuring the audio device before you can capture audio.

1. Use menu item Devices to show a dropdown list of the audio devices present.

If there is only one Osprey-2000 card present, the audio device will appear as
Osprey-2000 Audio in the list. For only one Osprey-2000 card present, see
step 4.

3. If there are multiple Osprey-2000 cards present, they will appear as Osprey-
2000 Audio Board 1, Osprey-2000 Audio Board 2, etc.

Do not use menu item Options -> Audio Format to set the individual audio input
for multiple cards. You must use the mixer applet to select among Balanced Audio,
SDI, etc. Please see Selecting the Audio Source and Input Volume for
information on using the mixer applet.

WMEap - D4 Yideo' captest.avi
File Devices Options | Caphre  Help

Start Capbure
Siop Caphure

v Capture Audio
Clorsed Captioning
IMaster Stream
Sek Frame Rate...
Set Time Limit. ..

| ob00ve.dl - Osprey-200 Cand 1 - :

4.  You must enable audio capture in AmCap before starting capture by clicking on
menu item Capture -> Capture Audio. Until you do this, the menu items
Capture -> Master Stream and Options -> Audio Format will appear
grayed out.

Multiple board installations are a specialized subject discussed in Appendix F:
Multiboard Installations.
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Installing the Osprey Card

You should install the Osprey card before installing the software driver!

All computer cards are sensitive to electrostatic discharge. Slight
discharges from clothing or even from the normal work environment can
adversely affect these cards. By following these simple guidelines,
however, you can minimize the chance of damaging your Osprey card.

To be used only with UL Listed computers that include instructions for

user installed accessories.

Handle cards only by the non-conducting edges.

& Do not touch the card components or any other metal parts.

Wear a grounding strap while handling the cards (especially when located

in a high static area).

Provide a continuous ground path by leaving the power cord plugged into

a grounded power outlet.

Ensure that the workstation is powered OFF before installing any
components.

If you are not familiar with how to install a PCI bus card, refer to your
system’s documentation for more complete, step-by-step instructions.

Use the following steps to install the Osprey card:

1.

w

@

10.

Power down the computer. Make sure that the computer power switch is turned

OFF. Read caution note in the box above for grounding precautions.
Remove the computer cover.
Locate an empty PCI slot.

Remove the slot-cover screw from the empty PCI slot cover, set the screw
aside, and remove the slot cover.

Remove the card from its anti-static bag.

Install the Osprey card into the empty slot, and make sure that it is seated
evenly in the slot.

Secure the backpanel of the card with the slot cover screw.
Replace the computer cover.

Connect video and audio cables to the Osprey card. Refer to Connecting
Cables for details of the card’s backplate connector.

Turn the computer on.
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Connecting Cables

Osprey-2000 Backplate

Breakout Connector

Rack Mount Unit

Connecting a Composite Source
Connecting an S-Video Source
Connecting an SDI Source

Connecting an IEEE-1394 Source
Connecting Audio with the Osprey-2000

Osprey-2000 Backplate

The Osprey-2000 DV Pro board has four connectors on the backplate for audio and
video.

- Output Connector
- 4+ {to breakout cable)
" IEEE1394 DY
I Input 4PIN

@' 4— BNC SDI Input

Input Connector
To breakout
oy, cable or 1U

rack)

LI EEY]
LELL Y]

Ty

iy

¢ The Osprey-2000 backplate does not include the SDI or the IEEE-1394 DC
input.

¢ The Osprey-2000 D Pro and Osprey-2000 Pro do not have the IEEE-1394
connector.

¢ The Osprey-2000 D DV does not have the SDI connector.
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Osprey-2000 Input Breakout Cable

S-Video

Unbalanced Audio
Left (RCA style)

Unbalanced Audio
’ Right (RCA style)
Composite Video
(BNC style)

Connector Styles

S-Video
RCA style

Balanced Audio
@ XLR style Right (XLR style)

Digital AES/EBU Audio

Balanced Audio
Left (XLR style)

The breakout connector has inputs for composite video, S-Video, balanced and
unbalanced audio, and professional digital audio. The breakout cable has a set (L/R)
of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR) audio

connectors. Additionally, the right XLR balanced input also is used as the professional
digital audio input.

9 The input breakout cable is ViewCast Part Number 34-05009-01.

Osprey-2000 Output Breakout Cable

S-Video
Unbalanced Audio
Left (RCA style)

Unbalanced Audio
Right (RCA style)

Composite Video
(BNC style)
The output breakout cable has a set (L/R) of unbalanced RCA style audio connectors,
a S-video connector, and a BNC style video connector.
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0 The output breakout cable is ViewCast Part Number 34-05008-01.

Osprey-2000 Input Breakout Box

The breakout connector has inputs for composite video, S-Video, balanced and
unbalanced audio, and professional digital audio. The breakout cable/box has a set
(L/R) of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR)
audio connectors. Additionally, the right XLR balanced input also is used as the
professional digital audio input (AES/EBU) for:

Osprey-2000 Pro
Osprey-2000 DV Pro

Osprey-2000 D Pro
Osprey-2000 D DV Pro

* & o o

BMC

) Unbalanced Balanced
Composite

Audio Right Audio Right
|

AESFEBU
4] Crigital
Audio

l i
@ @
i

|
SVideo Unbalanced Balanced
Audio Left Audio Left

9 The input breakout box is ViewCast Part Number 95-00157-01.
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Osprey-2000 Input Rack-mount Panel

A rack mount version of the breakout box is also available. The 1 unit high rack
mount input box has the same inputs as the breakout box but includes two sets of
inputs. A single rack mount input unit provides for two Osprey-2000 cards.

AES/EBL  Balanced  Unbalanced  SWideo SWideo  Unbalanced — AES/EBU  Balanced
fuwdio Cugrtal Audio
Left Aidio Left

Cigital Audio Audio
.ﬁudl:lin Left Left ‘

3 —

8 @@éé-@- @-é@é(@ &)

F 3
|
I I I I

Balanced Unbalanced BMNC BNC Unbalanced B alanced
Audia Audia Composite  Composite Audia Audia
Right Right Yideo Wideno Right Rught

9 The rack-mount breakout box is ViewCast Part Number 95-00151-02.

& Exact connector layouts are subject to change.

Connecting a Composite Source

If your video source provides only composite video, connect the source output cable
to the Composite Video In connector. This is a BNC connector on the breakout box. A
BNC to RCA adapter is provided if you don’t have a BNC composite cable.

Connecting an S-Video Source

If your video source supports S-Video, connect the source output cable to the S-
Video In connector on the breakout box. Compared to composite signals, S-Video
provides a sharper image with better color separation. S-Video uses a four-pin mini-
DIN connector that provides separate Y (luminance) and C (chrominance) signals.
Refer to Chapter 8 - Osprey-2000 Video Control Dialog for instructions on
configuring the driver for S-Video.
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Connecting an SDI Source

Four of the Osprey-2000 cards support SDI input:

Osprey-2000 Pro
Osprey-2000 DV Pro
Osprey-2000 D Pro
Osprey-2000 D DV Pro

* & o o

These cards have a BNC connector for SDI (SMPTE-259M) video. A high quality SDI-
qualified cable should be used when utilizing this connection, especially when the
cable length is long. SDI carries both digital video and embedded digital audio. If
your video or audio source supports SDI, connect the source output to the SDI input
connector on the card backplate.

Connecting an IEEE-1394 Source

Three of the Osprey-2000 cards support a DV input:

¢ Osprey-2000 DV Pro
¢ Osprey-2000 D DV
¢ Osprey-2000 D DV Pro

DV carries digital audio and video, and both can be independently used by the
Osprey-2000. The DV input is a 4 pin IEEE-1394 connection. If your video or audio
source supports DV, connect a 4 pin IEEE-1394 cable between your source and the
DV connector on the Osprey-2000 backplate.

Connecting Audio with the Osprey-2000

The Osprey-2000 has a variety of audio inputs, both analog and digital. Typically, the
unbalanced analog RCA audio inputs should be the most versatile. Balanced audio
inputs (via XLR connectors) provide cleaner audio, especially if the cable length is
very long.

The prosumer may have a DV camera source and choose to use the audio embedded
in the IEEE-1394 DV stream.

A choice of two digital audio inputs is available for professional and broadcast users.
Embedded SDI and DV audio inputs are located on the card backplate. The breakout
box contains a single professional AES/EBU stereo digital audio input. This input is
shared with the right balanced analog input to prevent having both balanced audio
and professional digital audio connected at the same time.
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The selection of audio input to capture is independent of the video input selection.
For example, even if you choose to use DV video as a source, you can still opt to use
the analog balanced inputs instead of audio embedded in the DV stream. Refer to
Chapter 9 - Capturing Audio for information about how to select the audio input
for software applications.
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Chapter 3 - Installing the Software -
Windows 2000

The Windows NT 4.0 Osprey drivers do not work with Windows 2000. If
your Osprey card(s) were installed under the Windows NT 4.0 operating
system and the PC has now been upgraded to Windows 2000, you need to
install the Windows 2000 drivers.

Please note:
Administrative privileges are required for installation.

Before installing software, check the ViewCast.com support website or the
ftp site for the any driver update releases subsequent to the software
shipped on your CD. For the ViewCast.com support website, go to
http://www.ospreyvideo.com/ -> Osprey-2000 -> MPEG Codec ->
2000 -> Get Software. To reach the ViewCast.com ftp site, go to
ftp://ftp.viewcast.com/pub/OSP-2000/win2000/latest. It's a good idea to
check these sites periodically for update releases.

The screens used to illustrate the installation steps may not be exactly
what appear on your computer screen. In some cases, version numbers
and other minor differences may appear in the installation you are
running.

The Osprey-2000 software is packaged as a base driver (required) and five optional
components.

OPI Runtime
DirectShow Runtime
OPI Software Developer Kit

DirectShow Software Developer Kit
VFW Software Developer Kit

* & & o o
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The installation program installs the base driver first, then provides the choice of
installing the optional components.

Basics: Installing from CD
Basics: Downloading and Installing Updated Drivers

¢+ Canceling Out the Found New Hardware Wizard
Installation Options

+ Installation Scenario: Osprey Card(s) Physically Installed, but Osprey
Software not Installed

. Option A: Run the Installation Program (Recommended)

. Option B: Use the Found New Hardware Wizard (Not
Recommended)

Testing the Installation
Ligos Technology's Indeo

Uninstalling the Software

Basics: Installing from CD

If necessary, follow the directions in Chapter 2 - Osprey-2000 Hardware to install
the Osprey card. This software installation procedure works properly only if the card
is already installed.

1. Turn on the machine and start Windows 2000.
2. Cancel out of the Found New Hardware wizard.

3. If you are updating from a previous version of the driver, it is not necessary to
uninstall the old driver before installing the new driver. The instructions for
uninstalling the driver are documented in Uninstalling the Software.

4. Insert the Osprey-2000 driver CD into your CDROM drive. The installation
instructions assume this is the (D:) drive. Substitute the proper drive as it
appears on your system, if necessary.

5.  Run the installation program
a. Click the Start button
b. Click Run
c. Enter D:\Win2000\Setup in the dialog box
d. Click OK

6. The installation program steps are self-explanatory for many users. If you need
additional information, please refer to the section entitled Option A: Run the
Installation Program (Recommended).

7. The driver and demo programs are ready for use as soon as the installation
program completes and you have rebooted the system. We suggest that you
test the driver immediately. Please refer to Testing the Installation for
Windows 2000.
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Basics: Downloading and Installing
Updated Drivers

Both
your

5.

The latest software drivers for Osprey-2000 MPEG cards are available via FTP
(file transfer protocol) at the following locations:

ftp://ftp.viewcast.com/pub/OSP-2000/win2000/latest

The same driver is used for the six models of the Osprey card, so these links
point to the same download file. There are also links to the drivers from our
web site at http://www.ospreyvideo.com/.

It is not necessary to uninstall your existing Osprey-2000 driver before
installing a newer version of the driver. The instructions for uninstalling the
driver are documented in Uninstalling the Software.

Use your web browser, such as Microsoft Internet Explorer or Netscape
Navigator, to find our FTP site and download the file. Type the FTP address
ftp://ftp.viewcast.com/pub/OSP-2000/win2000/latest into the address box at
the top of your browser window. You may find it simpler to type just the first
part of the address - ftp:/ /ftp.viewcast.com - and then click on the list of
directories that appear until you reach the win2000/latest location. Refer to
your browser’s help files for more specific and detailed assistance.

There are two different methods for downloading the Osprey-2000 driver:

. MasterInstallation - large, all-inclusive download package.
Approximately 13MB, includes base driver and all five optional
components

. IndividualComponentInstallation - collection of individual component
download packages. Download the base driver (1.8MB) and only the
desired optional components (0.9 - 1.6MB each)

are on the ftp site. Download the web package file(s) in win2000/latest to

hard disk.

The Found New Hardware wizard will appear detecting each Osprey-2000 card
in the computer. Follow the directions for Canceling Out of the Found New
Hardware Wizard at each prompt.

Run the web package program:
1. Click the Start button.
2. Click Run.

3. Enter <pathname> in the dialog box, where <pathname> is the location
and name of the file that you have downloaded.

4. Click OK.
5. The program prompts for a temporary location for unpacking the install
files.

6. See Option A: Run the Installation Program (Recommended) for a full
description of the Installation Program steps.
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7. The MasterlInstallation option looks almost exactly like the instructions in
Option A: Run the Installation Program (Recommended). Simply double-
click on file Osprey-2000MasterInstallationforW2k.exe to run the
installation. If you selected the IndividualComponentlnstallation, run the
package 02k_100_w00.exe, restart your computer, and then install the
other package components by double-clicking on each one.

These files are not automatically deleted after setup has run. This feature
exists to offer the option of performing the manual Plug and Play install
later. If you want to conserve disk space, make a note of where these
files are being unpacked, and delete them after the install.

Canceling Out of the Found New Hardware Wizard

You can install an updated Osprey-2000 driver on top of an existing driver; there is
no need to uninstall the existing driver first. The Found New Hardware wizard will run
after this reboot. To cancel out of the Found New Hardware wizard:

The Digital Signature Not Found window displays for the Osprey-2000 video
capture device.

Digital Signature Mok Found ._ 4B x|

The Microzoft digital signature affirms that software has
been tested wath Windows and that the software haz not
besn altered since it was tested.

The software vou are about to inztall doez not contain a
bicrosoft duptal signature. Therefore, there iz no
guarantes that this software works comrectly with
efirndows.

D zprey-2000 Video Capture Device

[f yous want ko zeanch for Microzoft digitally signed
softweare, yisit the 'Windows Update 'Web site at

hittp: £ fwindowsupdate microzoft. com to see if one iz
avallable.

Do poLs want ko continue the installation?

Ho More [nfo
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1. Click No.
The Completing Found New Hardware wizard window displays.

Conpleting the Found New Hardware Wizard

\@’; Multimedia Contraller

-
-

A erar occured during the installation of the device

The form zpecified for the zubject iz not one supported or
known by the specified tust provider.

To cloge thiz wizard, click Finizh.

< Back

Caticel |

2. Click Finish.

The Digital Signature Not Found window displays for the Osprey-2000 audio
capture device.

Digital Signature Mok Found , g X

The Microzoft digital signature affirms that software hasz
been tested wath Windows and that the saftware has not
besn altered since it was tested.

The software vou are about to inztall doez not contain a
ticrosoft digital signature. Therefore, there iz no
guarantes that this software works comrectly with
findiows.

Dzprep-2000 Audio Capture Device

I wous want ko seanch for Microsoft digitally signed
softweare, vizit the ‘Windows Update 'web site at
hittp: £ fwindowsupdate microzoft.com to see if one iz
available.

Do poLs want ko continue the inztallation?

Ho tore [nfo
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3. Click No.
The Completing Found New Hardware wizard window displays.

Conpleting the Found New Hardware Wizard

\e:e Mulimedia Contraller

-

A erar occured during the installation of the device

The form zpecified for the zubject iz not one supported or
known by the specified tust provider.

To cloge thiz wizard, click Finizh.

¢Back | Cancel |

4, Click Finish.

Installation Options

In all cases, the most efficient and complete installation method is to run the
setup.exe program on the product CD or in the web package that you downloaded.
The setup program automates the Plug and Play steps required to install the drivers
and ensures that they are performed correctly. It also installs the bundled applets
and User's Guide. If you have multiple Osprey capture cards in the system, it
configures all of the boards at the same time.

Installation Scenario: Osprey Card(s) Physically Installed, but Osprey
Software Not Installed

¢+ Option A: Run the Installation Program (Recommended)
¢ Option B: Use the Found New Hardware Wizard (Not Recommended)

Osprey driver version to another. Just run the setup.exe file to install all
the updated components. You will be prompted to install the optional
components after the base driver update has been installed.

: You can skip the detailed instructions if you are upgrading from one
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Installation Scenario: Osprey Card(s) Physically Installed,
but Osprey Software not Installed

In this case you have two options:

¢+ Option A: Run the Installation Program (Recommended)
¢ Option B: Use the New Hardware Found Wizard (Not Recommended)

Option A: Run the Installation Program (Recommended)

When windows 2000 is started for the first time after the Osprey card is installed,
the Found New Hardware wizard appears one or more times. Cancel out of these
wizards. After Windows 2000 has finished starting, do the following:

To install the Osprey drivers:

1. Using Windows Explorer, locate and access the CD-ROM drive containing the
Osprey Installation CD-ROM.

2. Navigate to the WIN2000O directory.

3. Double-click SETUP.EXE. This executes the Osprey-2000 Master Installation
Program, which will install the base driver and then prompt the user through
installing the optional components.

The Osprey-2000 Master Installation Program window displays

Osprey-2000 Master Installation Program 5'

Thiz program will install the Osprey-2000 Criver for
Windaws 2000 Caomputers, Yerzion 1.00 reb.

[t iz strongly recommended that you exit all Wwindows programs
befare running thiz Setup pragram.

Click Cancel to guit Setup and then cloze any programs you
hawve running. Click Mest to continue with the Setup program.

WARMIMG: This program is protected by copyright law and
international treaties.

IInauthorized reproduction or digtribution of thig program, or any
portion af it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

Cancel |
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4, Click Next.

The Osprey-2000 Driver Installation Information window displays.

e
o

Osprey-2000 Driver Installation Information

Y'ou can view thiz info later by clicking the Readie icon.

b

Ozprey Technologies, [he.
e azt. Com

Ozprey-2000 MPEG Codec

Far Windows 2000
Yerzioh 1.0.0 Beta 1
01.02.09

Feleaze Motes

Thiz iz a Beta releaze.

ol

Thiz werzion of the driver iz for Windows 2000 only.
[t iz a MPEGT Codec and Yideo for Windows YWideo capture

i

o

Cancel I

5. Click Next.
The Software License Agreement window displays.

Osprey-2000 Driver Setup

Fleaze read the following Licenze Agreement. Press the PAGE DOWH ke to zee
the rezt of the agreement.

EMD USER SOFTWARE LICEMSE

READ THE TERMS AMD COMDITIONS OF THIS LICEMSE
CAREFULLY BEFORE USING THIS HARDWARE, SOFTWARE.
OF THE ACCOMPANYIMG MATERIALS [THE "FRODUCTS").
B% USING THE PRODUCTS, YOU ARE ACCEPTIMG AND
AGREEING TO THE TERMS AMND COMDITIONS OF THE
LICEMSE AGREEMEMNT. IF 0Ol ARE MOT WILLING TO BE
EOUMD BY THE TERMS &ND COWDITIONS OF THE LICEMSE
AGREEMEMT. YOU SHOULD RETURM THE FRODUCTS

Do you accept all the terms of the preceding Licenze Agreement? [F pou choose Mo, Setup

will cloze. Toinstall the Osprep-2000, you must accept thiz agreement.

¢ Back Yes

i

=

42 - Osprey-2000 User's Guide Version 2.2.0

ViewCast Corporation



Chapter 3 - Installing the Software - Windows 2000

6. Click Yes to accept the End User Software License Agreement. If you do not
wish to accept the agreement, click No to terminate the installation routine.

The Master Installation Program Installation Options window displays.

Osprey-2000 Master Installation Program Installation lfl 5[

Typical ingtall will inztall the driver and MPEG operation
companentz. The Cuztom install will allow a choice of 3
Developer components. Select Typical or Cugtom,

% iTypical: minimumn install for full Deprey-2000 operatior:

™ Custom: developer and driver companents selectable

< Back I Mest > I Cancel |

7.  Select Typical (to install the Main Driver Software and the Runtime
components necessary for full MPEG operation) or select Custom (and be
prompted to choose among all the typical and developer components).

8. Click Next to continue or Cancel to abort the installation.

ViewCast Corporation Osprey-2000 User's Guide Version 2.2.0- 43



Chapter 3 - Installing the Software - Windows 2000

9. If you select the Typical installation, skip Step 10. Your next step will be to
choose the Destination Folder. If you select the Custom installation, continue
with Step 10.

The Master Installation Program Component Selection window displays.

Osprey-2000 Master Installation ProgramComponent Ge El

Choose which of the Dgprey-2000 driver components pou would
like b inztall

v Main Driver Software

¥ Widen For Windows Software Developmert Kit
¥ 0PI Runtime Driver Component

¥ 0PI Software Development it

¥ DirectShow Funtime Driver Componsnt

¥ DirectShow Software Development Kit

< Back I Mewt > I Cancel |

The Osprey-2000 software consists of the Main Driver Software (required)
and five optional components:

Video For Windows Software Development Kit supplements the Windows
Video For Windows (VFW) control interface with Osprey-specific routines for
selecting video port, decoding closed captions, and cropping, among other
features. This component contains source code for several sample applications,
documentation, and the software components necessary for users to write their
own VFW applications using C++.

OPI Runtime Driver Component contains a digital VCR application
(MpegVCR) and the software components necessary to use it.

DirectShow Runtime Driver Component contains DirectShow filters, MPEG
encode, and MPEG decode applications along with the necessary libraries and
DLL's for these applications. Adding these DirectShow filters allows Windows
Media Player, RealEncoder, and other DirectShow enabled applications to work
with MPEG2 bitstreams.

OPI Software Development Kit contains source for the MpegVCR application
and all software and documentation components necessary for users to write
their own applications using the Osprey Programming Interface.

DirectShow Software Development Kit contains source code for the sample
applications and the ViewCast.com components necessary to write user
applications in Visual Basic and C++.
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10. Check the box for Main Driver Software (required) and choose the
checkboxes for any other components that you wish to install. Click Next to
continue.

If you decide to install one of the optional components later, you can
always install it from the CD.

The choose Destination Location window displays.

Osprey-2000 Driver Setup Destination Location 3 El

Setup will install the Deprey-2000 in the following folder.
T o ingtall tothiz folder, click Mest.

T inztall ta a different falder, click Browse and zelect anaother
folder.

Y'ou can chooge not ta inztal the Ozprey-2000 by clicking Cancel
b exit Setup.

" Drestination Falder

D:MProgram Files'0sprey-2000 Browsze... |
Cancel |

¢ Back
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11. If you wish to change the destination location for the files, click Browse. Click
Next.
The window to select a Program Folder displays.
Dsprey-2000 Driver Setup x|
Setup will add program icong to the Program Falder listed belaw.
t'ou may twpe a new falder name, or zelect one from the exizting
Falders list. Click Mest to continue.
Frogram Folders;
| |
E sizting Folders:
Accezzofies
Adminigtrative Tools
Adobe Acrobat 4.0
Development Kitz
Microzoft Office Tools
Startup
< Back I Mesxt > I Cancel
12.

If you wish to change the program folder, type the new name in the Program
Folders field. Click Next.

The Start Copying Files window displays.

Osprey-2000 Driver Setup

x|

Setup has enough information to start copying the program files.
IF wou want ko review or change any zettings, click Back. If you
are zatisfied with the settingz, click Mext to begin copying files.
Current Settings:
Destination Directany: ;I

[:%Frogram FilezhOzprep-2000
Frogram Folder:

O zprey-2000

4]
< Back
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13. If there are any settings to be changed prior to installation, click Back to return
to the previous windows. Click Next.

The Digital Signature Not Found window for the Osprey-2000 Video Capture

Device displays.

Digital Signature Mok Found

=1HS
o

The Microzoft digital signature affirms that software has
been tested wath Windows and that the software haz not
besn altered since it was tested.

The software vou are about to inztall doez not contain a
icrosoft diptal signature. Therefore, there is no
guarantes that this software workz comrectly with
findoms.

Dzprey-2000 Video Capture Device

[f yous want ko zeanch for Microsoft digitally zigned
software, visk the Windows Update ‘web site at

hitp: £ fwndowsupdate. microzoft. com to zee if one iz
available.

Do poLs want ko continue the installation?

Ho More [nfo

2000 card in the computer. Windows 2000 recognizes the audio and video

i The Digital Signature Not Found window displays twice for each Osprey-

portions of the Osprey cards as separate items.

ViewCast Corporation
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14. Click Yes to continue with the installation process.

The Digital Signature Not Found window for the Osprey-2000 Audio Capture
Device displays.

Digital Signature Mokt Found i : |

The Microzoft digital signature affirms that zoftware haz
been tested with Windows and that the software has not
been altered since it was tested.

The zofftware pou are about bo inztall does not contain a
Picrosoft diptal sianature. Therefore, there iz no
guarantes that thiz software works comrecth with

o Trchoms.

Dzprey-2000 Audio Capture Device

I pou want bo search for Microzoft digitally signed
software, visk the ‘Windows Update web site at

hittp: £ fwindowsupdate microzoft.com fo see if one iz
avallable.

Do you want bo conbinue the nstallation’?

Ho More Info

15. Click Yes to continue with the installation process.

16. If you have installed a program or device driver which installed an 1420 or YUY2
codec, you may also see the following two dialog windows.

The Question Dialog window for the 1420 codec displays.

17. Click Yes to use ViewCast.com’s 1420 codec.
The Question Dialog window for the YUYZ2 codec displays.
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18. Click Yes to use ViewCast.com's YUY2 codec.

If you do not have the Runtime portion of Microsoft's DirectX 8 installed, the
following window displays.

Severe x|

Wou do not currently have Direcks 8.0 installed wou will need it to properly run this component The Direct® &, 0 runtime
component is provided on the Osprey-2000 CD,

19. If this window is displayed, click OK. The DirectX 8 Runtime is on the Osprey-
2000 CD (in \DirectX8_redist\). The URL to download this from Microsoft is
listed in DirectXMedia Details.

20. If you selected the Typical install option, the next window prompts you to
restart your computer. Please skip to the final step in this series.

21. If you selected the Custom install option, please complete all the remaining
steps.

The Osprey-2000 DirectShow SDK Choose Destination window displays.

Osprey-2000 DirectShow SDK j x|

Setup will ingtall Deprep-2000 Directshow SDE. in the following
folder.

To inztall ko thiz folder, click Mext,

Ta inztall ko a different falder, click Brawse and select another
folder.

You can chooge not ta install Dzprey-2000 DirectS haw SOE. by
clicking Cancel ko exit Setup.

Ot ADzprey-20004DirectS howhS DK Browse... |
Cancel |

If you plan to use the Osprey DirectShow Software Developer's Kit (SDK), you should
read the Configuration of the Development Environment section of the Osprey
DirectShow SDK document for special instructions on installing the software. In
particular, the Microsoft DirectX 8 SDK is required. The installation program for
Osprey DirectShow SDK generates a warning message if this component is not
present.

" D estination Faolder

< Back
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22. If you want to install this optional component, click Next. Click Cancel to skip
installation of this component.

The Osprey-2000 DirectShow SDK Choose Destination window displays.

Osprey 2000 DirectShow SDK I x|

Setup will ingtall Dzprep 2000 DirectShow 50K in the following
fiolder.

T o inztall to this folder, click Mest.

T o inztall ta a different falder, click Browse and zelect another
folder.

Yaou can chooge not ta inztall Dzprey 2000 DirectShow SOE. by
clicking Cancel to exit Setup.

Dt sOzpreg-2000%DirectShowh SDE, Browse... |
Cancel |

23. If you wish to change the destination location for the files, click Browse.
Otherwise, click Next.

If you do not have the DirectX 8 SDK installed, the following window displays.

" Destination Folder

< Back

Yiou do not have the Direckl 5.0 SDEK instaled of your curvent instalation Is missing the desvelopment k. This complete installation i .
required in order ko properhy use the Csprey-2000 DirectShos SDK.
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24. Click OK, and refer to the DirectShow SDK documentation for further
information.

The Osprey-2000 DirectShow SDK Setup Complete window displays.

Setup Complete

Setup has finished installing verzion 1.00.000 F of the Ozprey
2000 DirectShow SOE.

Click. Finish to complete Setup.

< Back

25. Click Finish.
The Osprey-2000 OPI Runtime Component Choose Destination window displays.

Osprey-2000 OPI Runtime Component El

Setup will ingtall Deprep-2000 0P Buntime Component in the
following folder.

To inztall ko thiz folder, click Mext,

Ta inztall ko a different falder, click Brawse and select another
folder.

Y'ou can chooge not bo install Dzprey-2000 0P Runtimne
Compaonent by clicking Cancel to exit Setup.

[ Program Filezh0zprey-2000 Browse. |
Cancel |

" D estination Faolder

< Back
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26. If you want to change the destination location for the files, click Browse.
Otherwise, click Next. Click Cancel to skip the installation of this component.

The Osprey-2000 OPI Runtime Component Setup Complete window displays.

Setup Complete _ !

Setup haz finished instaling werzion 1.00 e of the Ozprey-2000
0PI Buntime Component

Click. Finizh to camplete Setup.

< Back

27. Click Finish.
The Osprey-2000 OPI SDK Setup Choose Destination window displays.

Osprey 2000 OPI SDK Setup : il

Setup will ingtall Dzprep 2000 OF SDE in the following folder.
T o inztall ta thiz folder, click Nest.

Toingtall to a different folder, click Browse and select another
falder.

Y'ou can chooze not toinstall Deprey 2000 OF1 SOE. by clicking
Cancel to exit Setup.

[:%Program Filez\Ozprey-2000850F1 S0E. Browse... |
Cancel |

" Destination Folder

< Back

52 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 3 - Installing the Software - Windows 2000

28. If you wish to change the destination location for the files, click Browse.
Otherwise, click Next. Click Cancel to skip the installation this component.

The Osprey-2000 OPI SDK Setup Complete window displays.

Setup Complete B

Setup haz finished instaling werzion 1.00 e of the Ozprey-2000
0Pl SOk

Click. Finizh to camplete Setup.

< Back

29. Click Finish.
The Osprey-2000 VFW SDK Install window displays.

Osprey-2000 ¥YFW SDK - X]

Thiz product will now inztall the Ozprey-2000 YW
SO Yerzion 1.00 rc

[t iz gtrongly recommended that you exit all Windows programs
before running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs poul
have running. Click Mest to continue with the Setup program.

"WARMIMG: Thiz program iz protected by copuright law and
international treaties.

IJnauthorized reproduction or distribution of thiz program, or any
partiaon af it, may result in severs civil and criminal penalties, and
will be prozecuted to the masimum extent pozzible under law.

Cancel |
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30. If you want to install this optional component, click Next. Click Cancel to skip
the installation component.

The Osprey-2000 VFW SDK Software License Agreement window displays.

Osprey 2000 ¥YFW SDK Software License Agr& x|

Pleaze read the following License Agreement. Press the PAGE DOWHN key to see
the rest of the agreement.

| iI
END USER SOFTwWARE LICEMSE

READ THE TERMS AND COMNDITIOMS OF THIS LICEMSE

CAREFULLY BEFORE USING THIS HARDWARE, SOFTWARE.

OR THE ACCOMPANYIMG MATERIALS [THE "PROCUCTS").

B USING THE FRODUCTS, vOU ARE ACCEPTIMG AND

AGREEING TO THE TERMS AND COMDITIONS OF THE

LICEMSE AGREEMEMNT. IF 0Ol ARE MOT WILLING TO BE

EOUMD BY THE TERMS &ND COMWDITIONS OF THE LICEMSE

AGREEMENT. ¥OU SHOULD RETURM THE FRODLUCTS LI

Do you accept all the termz of the preceding License Agreement’? [F pou chooze Mo, Setup
will cloge. Tainstall Dzprey 2000 WEW SDE., you must accept thiz agreement,

< Back ez Mo |
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31. Review this message and make sure that the licensing terms are acceptable.
Click Yes to accept the agreement. Click No to terminate installation of this
component.

If you clicked Yes, the Osprey-2000 VFW SDK ReadMe Information window
displays.

Osprey 2000 ¥FW SDK ReadMe Information 5[

Ozprey-100 MT Wiw' SDE
Werzsion 1.54
FRelease Motez

Full uze af thiz SDE. requires Osprep-100MT or

windowes 2000 driver werzion 1.54 or higher, o
ar Depreg-2000 M T MAvfindows 2000 verzion 1.000.

These diivers are available from our frp site

[zee below] under . Asinntd or . AsinZ000.

The SDF. documentation iz o1 00N Tedk. POF. This file
iz in Adobe \POF format and requires Adobe Acrobat
reader. Acrobat reader iz available for free at

v, adobe, comdprodindes/acrobat Areadstep. hitml,

i o

< Back
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32. Read this file and click Next.
The Osprey-2000 VFW SDK Setup Destination Folder window displays.

Osprey 2000 ¥YFW SDK Setup Destination Folder g El

Setup will install Dzprey 2000 WFw SDE. in the following folder.
T o ingtall o thiz folder, click Mest.

T inztall ta a different falder, click Browse and zelect anather
folder.

Y'ou can chooge not ta inztall Dzprey 2000w SDE by clicking
Cancel to exit Setup.

C:\Program FilezhOzprep-20004Fud SOE, Browse... |
Cancel |

33. Click Browse to change the destination location for the files. Click Next.
The Osprey-2000 VFW Setup Complete window displays.

" Drestination Faolder

¢ Back

Osprey 2000 ¥YFW SDK Setup Complete

Setup has now finizhed installing Version 1.00.000 F of the
Ozprey 2000 °WEw SDE

Click Finish to complete Setup.

¢ Back
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34. Click Finish.
The Osprey-2000 Master Installation Setup Complete window displays.

Setup Complete

Setup has finizhed copying files ko your compter.

Before vou can uze the program, you must restart \Windows or
VaUr cornpuker.

% ez | want bo restart my computer mow,

£ Mo, | will restart my computer later.

Remove any disks fram their drives, and then click Finizh to
complete zetup.

< Back I Finizh I

35. Click Finish to complete the installation. You must restart your computer
before you can use the Osprey-2000 card.
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Option B: Use the Found New Hardware Wizard (Not
Recommended)

This method is more complicated than Option A. It is particularly inconvenient if you
are installing multiple cards at once, since each card has to be set up separately.
This process installs only the driver and is useful only for updating the driver
component. Furthermore, to get the sample applications and other required items,
you must still run the setup.exe program.

The following windows and instructions assume that you are working with
& a computer on which the Osprey-2000 software has never previously
been installed.

When Windows 2000 starts, it detects the new card(s) and starts the Found New
Hardware Wizard.

Please carefully note the terminology in the Found New Hardware Wizard.

For all Bt/Ct878-based Osprey cards, the Wizard detects two logical
devices for each card - a Multimedia Video Controller device and a
& Multimedia Controller device.

The Multimedia Video Controller corresponds to the Osprey-2000 video
device. The Multimedia Controller corresponds to the Osprey-2000 audio
device.

The Found New Hardware window displays first, and is quickly obscured by the
Welcome window.

Found Mew Hardware

kultimedia Wideo Confrolisr

[nztalling ...

58 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 3 - Installing the Software - Windows 2000

Found New Hardware Wizard

Waelcome to the Found New
Hardware Wizard

Thiz wizard helpz pou inztall a device diver for a
hardware device.

To continue, chok MNext,

Cancel |

1. Click Next.
The Install Hardware Device Drivers window displays.

Found New Hardware Wizard

Install Hardware Device Dnvers

A device driver iz a zoftware program that enables a hardware device to wark, with
an operating zysten.

T hiz wizard will complete the installation for thiz device:

@ Multimedia Video Contraller

A device driver iz a zoftbware program that makes a hardware device work., Windows
needs driver filez for pour new device, Ta lozate diiver filez and complete the
inztallation click Mest.

YWhat do you want the wizard o do’?

" Search for a suitable driver for my device [recommended)

&+ Dizplay a list of the known divers for this device so that | can choose a specific
driver

< Back ! Hest » 1 Cancel
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2.  Select the option to Display a list of the known drivers for this device and
click Next to continue.

The Install Hardware Type window displays.

Hardware Type
What tppe of hardware do pou want ko install?

Select a hardware type, and then click Hest.

Hardware types:

BIR Network adapters ﬂ
ﬁ_.!;! MT &pmélegacy Support

c@ Other devices

“@ PCMCIA adapters

o Parts [COM & LPT)

Cﬁ Prirbers

€2 5051 and RAID contrallers

,\E

-System devices . ;I

—

¢ Back I Mest > I Cancel |
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Scroll down to Sound, video and game controllers, click to select, and click
Next to continue.

The Select a Device Driver window displays.

Select a Device Dnver
Which driver do wou want to install for this device?

= Select the manufacturer and model of pour hardware device and then click Mext. [f pou
5 have a dizk that containz the driver pou want to install, chck Hawve Disk.

Manufacturers: b odels:
i i &l | Audio Codecs -
Analog Devices Aureal Vortex Game Port
Aztech Systemsz Legacy Audio Drivers
CH Products Game Parts Legacy Wideo Capture Devices
Creative Technology Lid. bedia Control Devices
Crpztal Semiconductor Standard Game Part
FCC Tarknalaon lae ;I Vidan Cadans ll

Hawve Dizgk.... |

¢ Back I Mest > I Cancel |

4., Click Have Disk.
The Install from Disk window displays.

Install From Disk

H [nzert the manufacturer's installabon dizk into the diive 0k,
[E=tf  selected, and then click D —l

Cancel

LCopy manufacturer's files frome

F:hwfin2000
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5. The default path is usually A:\. Reset the path to the directory containing the

Osprey-2000 install files. In this example, they are on the CD in F:\WIN2000.
Click OK once the path has been set.

The Select a Device Driver window displays.

Found MNew Hardware Wizard

Select a Device Driver
Which driver do vou want to install far this device™?

'~ have a dizk that containg the driver pou want boinstall, click Hawve Disk.

_\0"} Select the manufacturer and model of your hardware device and then click Mest. [F pou

bodels:
Dzprey-2000 Audio Capture Device

Have Disk. .. |

< Back I MNewt > I Cancel |

6. Select the Osprey-2000 Video Capture Device and click Next.
A warning message displays.

Update Driver Warning s i |

cannot verity that it is compatible with wour hardware. IF the driver
is mot compatible, your hardware will nok work correctly and wour
computer might become unskable or stop working completely, Do
wou want bo continue installing this driver?

& Instaling this device driver is not recommended because Windows
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8.

Click Yes.
The Start Device Driver Installation window displays.

Start Device Driver Installation
The device driver will be installed with the default zettings.

The wizard iz ready to install the driver for the following hardware device:

\@i_, Dzprey-2000 Yideo Capture Device

-
-

YWindows will uze default zettings to install the software far thiz hardware device. To
inztall the zoftware far pour new hardware, click Mest.

< Back

Cancel |

Click Next.
The Digital Signature Not Found window displays.

Digital Signature Mok Found

The Microzoft digital signature affirms that zoftware haz
been tested with Windows and that the software has not
been altered since it was tested.

The zoffware pou are about to inztall doez not contain a
bicrosoft diptal signature. Therefore, there iz no
guarantes that this software works comrecth with
o

O zprey-2000 Yiden Caphure Device

If you want bo search for Microzoft digitally signed
software, yvisk the Windows Update Web site at

hittp: fwindowsupdate microsoft.com to see if one iz
avallable.

Do you want bo conbinue the installation’?

Ho More Info
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9. Click Yes.
The Completion window displays.

Completing the Found New
Hardware Wizard

\@: D sprep-2000 Video Capture Device

-
-

Windows has finished instaling the software for this device.

To cloge thiz wizard, click Finizh.

Cancel |

10. Click Finish.

& At this point, the Osprey-2000 video driver has been installed.

The second Found New Hardware Wizard window displays and is quickly
obscured by the second Digital Signature Not Found Window.

\@f« Osprey-2000 Audio Capture Device

Inztalling ...
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Digital Signature Nok Found E |

The Microzoft digital signature affirms that zoftware haz
been tested with Windows and that the saftware has not
been altered since it was tested.

The zofftware pou are about bo inztall does not contain a
Picrosoft diptal sianature. Therefore, there iz no
guarantes that thiz software works comrecth with

o Trchoms.

Dzprey-2000 Audio Capture Device

I pou want bo search for Microzoft digitally signed
software, visk the ‘Windows Update web site at

hittp: £ fwindowsupdate microzoft.com fo see if one iz
avallable.

Do you want bo conbinue the nstallation’?

Ho tare [nfo

11. Click Yes to complete the driver installation process.
12. You must restart your computer before you can use the Osprey-2000 card.

The Digital Signature Not Found window displays twice. Windows 2000
recognizes the audio and video portions of the Osprey cards as separate
items. You will not see these messages if you've disabled signature

This process installs only the driver and is useful only for updating the
driver component. To get the sample applications and other required
items, you must still run the setup.exe program. See Option A in Chapter
3 for those instructions.

requirement under Windows 2000.
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Testing the Installation for Windows 2000

1.  Verify that the hardware installation is complete according to the directions in
Chapter 2 - Osprey-2000 Hardware.

2. Connect a video signal source to one of the Osprey-2000 connectors
(Composite/S-video/SDI/DV). See Connecting Cables.

3. Open the Osprey-2000 group in the Start menu.

4.  Click the VidCap32 icon. Refer to Chapter 10 - VidCap32, AmCap, and
Included Demo Programs for more information on this application.

5. If your input is composite video, the screen displays a still video frame from the
Osprey-2000 board. Click the Overlay button. The screen should display
moving video frames. If your input choice is not composite video (the default),
select the Video Source option under the Options menu to bring up the
Osprey-2000 video capture driver configuration box where you can select your
video input.

6. If the video area does not contain video, it could be for one of the following
reasons:

7. The driver is looking for video on the wrong input connector. You can either
move the video cable to another connector or reconfigure the driver using its
Control Dialog. Refer to Chapter 8 - Osprey-2000 Video Control Dialog.

8. The video source is not turned on or activated.

9. If the video area is scrambled or has bad color, the signal format of your video
source may be different from the signal format selected in the driver software.
Since the driver defaults to NTSC-M signal format, users of PAL equipment
always need to change the driver’s signal format the first time they run the
driver. Refer to Chapter 8 - Osprey-2000 Video Control Dialog for more
information.

Indeo

Ligos Technology's Indeo codec is provided on the Osprey-2000 CD. Double-click on
file Indeo\Disk1\Setup.exe to install this package containing compression and
color formats.

Please see Ligos Technology's Indeo in Chapter 10 - VidCap32, AmCap, and
Included Demo Programs for a description of this package.
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Uninstalling the Software - Windows 2000

If necessary, you may remove the Osprey Driver from your system or deactivate the
driver under Windows 2000.

To Remove the Osprey Driver

To Deactivate the Driver under Windows 2000

To Remove the Osprey Driver

1. If you have installed one of the DirectShow optional components, the first step
in the uninstall process is to remove DirectShow filter entries from the registry.
Double-click on the file

\Program Files\Osprey-2000\DirectShow\Filters\unregister.bat
Open the Control Panel.
Double-click Add/Remove Programs.
Click to select Change or Remove Programs.
Highlight the Osprey-2000 entry.
Click the Change/Remove in the Osprey entry.
The uninstall program begins.
Click Yes to proceed.
Click OK when the process is complete.
9. Repeat this for each optional component that you have installed:
Osprey-2000 DirectShow SDK
Osprey-2000 OPI SDK
Osprey-2000 DirectShow Runtime
Osprey-2000 OPI Runtime Component
Osprey-2000 VFW SDK
10. Reboot your computer to complete removing the driver.

ok WwN

®© N

To Deactivate the Driver under Windows 2000

Open the Control Panel.

Double-click System to open the System Properties applet.

Click the Hardware tab.

Click on the Device Manager button.

Open Sound, video and game controllers.

Select Osprey-2000 Audio Capture Device. Right-click it and select disable.
Select Osprey-2000 Video Capture Device. Right-click it and select disable.

NOoUuAWNHE

reboot the machine, or right-click the audio and video portions of the

i You have disabled the Osprey-2000 driver. To enable it again, either
device and select enable.
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Chapter 4 - Installing the Software -
Windows NT 4.0

The Osprey-2000 MPEG/Capture card product contains a single CD for Windows 2000
and Windows NT 4.0. The software consists of the base driver and three optional
components. The installation program requires you to install the base driver, and
then prompts to install each of the optional components:

OPI Runtime (contains MpegVCR application)
OPI SDK (contains source code for MpegVCR)

VFW SDK (contains source code for control panel applet and closed caption
decoding software)

After you have installed the software, you can test the card and software by running
the included application program VidCap32.

Please note:
Administrative privileges are required for installation.

Before installing software, check the ViewCast.com support website or the
ftp site for any driver update releases subsequent to the software shipped
on your CD.

The screens used to illustrate the installation steps may differ slightly
from those that appear on your computer. In some cases, version
numbers and other minor differences may appear in the installation you
are running.

& If you already have the Osprey driver software installed on your system
and are updating it, you do not have to remove the old version before
installing the new version. The installation program removes or replaces
any files or registry settings that are outdated.

For the ViewCast.com support website, go to
http://www.ospreyvideo.com/ -> Osprey-2000 -> MPEG Codec ->
2000 -> Get Software.

To reach the ViewCast.com ftp site, go to
ftp://ftp.viewcast.com/pub/OSP-2000/winnt/latest. It is a good idea to
check these sites periodically for update releases.

For more information, see Getting Help in Chapter 1.
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Installing from CD

Downloading and Installing Updated Drivers

Setup Program: Details

Testing the Installation for Windows NT

DXMedia

Indeo

Uninstalling the Software

Installing from CD

If necessary, follow the directions in Chapter 2 - Osprey-2000 Hardware to install
the Osprey card. This software installation procedure works properly only if the card
is already installed.

1.

Turn on the machine and start Windows NT.

If you are updating from a previous version of the driver, it is not necessary to
uninstall the old driver before installing the new driver. The instructions for
uninstalling the driver are documented in Uninstalling the Software.

Insert the Osprey-2000 driver CD into your CDROM drive. The installation
instructions assume this is the (D:) drive. Substitute the proper drive as it
appears on your system, if necessary.

Run the installation program

a. Click the Start button

b. Click Run

c. Enter D:\WinNT\Setup in the dialog box
d. Click OK

The installation program steps are self-explanatory for many users. If you need
additional information, please refer to Setup Program: Details.

The driver and demo program are ready for use as soon as the installation
program completes and you have rebooted the system. We suggest you test
the driver immediately. Refer to Testing the Installation for Windows NT.
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Downloading and Installing Updated
Drivers

1. Install the Osprey board in the PC if you have not already done so, turn on the
machine and start Windows NT.

2. The latest software drivers for Osprey-2000 cards are available via FTP (file
transfer protocol) at the following location:

ftp://ftp.viewcast.com/pub/OSP-2000/winnt/latest
There are also links to the drivers from our web site at:
http://www.ospreyvideo.com/

3. Use your web browser, such as Microsoft Internet Explorer or Netscape
Navigator, to find our FTP site and download the file. Type the FTP address
shown above into the address box at the top of your browser window. You may
find it simpler to type just the first part of the address -
ftp:/ /ftp.viewcast.com/ - and then click on the list of directories that appear
until you have reached the winnt/latest location. Refer to your browser help
files for more detailed assistance.

4. There are two different methods for downloading the Osprey-2000 driver:

. MasterInstallation - large, all-inclusive download package.
Approximately 13MB, includes base driver and all five optional
components

. IndividualComponentInstallation - collection of individual component
download packages. Download the base driver (1.8MB) and only the
desired optional components (0.9 - 1.6MB each)

Both are on the ftp site. Download the web package file(s) in win2000/latest to
your hard disk.

5. It is not necessary to uninstall your existing Osprey-2000 driver before
installing a newer version of the driver. The instructions for uninstalling the
driver are documented in Uninstalling the Software.

6. Run the web package program.

1.  Click the Start button.

2. Click Run.

3. Enter <pathname> in the dialog box, where <pathname> is the location
and name of the file that you have downloaded.

4. Click OK.

5. The MasterlInstallation option looks almost exactly like the instructions in
Option A: Run the Installation Program (Recommended). Simply double-
click on file Osprey-2000MasterInstallationforNT.exe to run the
installation. If you selected the IndividualComponentInstallation, run the

package 02k_100_nt4.exe, restart your computer, and then install the
other package components by double-clicking on each one.
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7. The program prompts for a temporary location in which to unpack the
installation files and starts the setup program. The setup program guides you
through the installation steps. For many users this process is self-explanatory.
If you need additional information, refer to Setup Program: Details.

The installation files are not automatically deleted after setup has run. If
you want to conserve disk space, make a note of the temporary location
where these files are being unpacked and delete them after the

installation.

8. You must restart the computer before the driver and sample applications will be
ready for use. We recommend that you test the driver immediately after

restarting your computer.

Setup Program: Details

The setup program presents a sequence of windows and dialogs to guide you
through the setup process. In general, click the Next button to continue to the next
screen. At any point you can click Back to return to a previous screen or Cancel to

exit the installation.

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the

Osprey-2000 software CD.
2. Navigate to the WinNT directory.

3. Double-click SETUP.EXE. The installation of the Osprey-2000 driver for
Windows NT begins with a confirmation that the setup program is beginning.

The Osprey-2000 Master Installation Program window displays.

Oszpreyp-2000 M aster Installation Program

Thiz program will install the Osprey-2000 Criver for
Windaws T #88 Camputers, Version 1.00 re2.

[t iz strongly recommended that you exit all Wwindows programs
befare running thiz Setup pragram.

Click Cancel to guit Setup and then cloze any programs you
hawve running. Click Mest to continue with the Setup program.

WARMIMG: This program is protected by copyright law and
international treaties.

|Inauthorized reproduction or digtribution of this program., or any
portion af it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

Cancel |
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4. Click Next.
The Software License Agreement window displays.

0 sprey-2000 Driver Setup l

Fleaze read the following Licenze Agreement. Press the PAGE DOWHN key to zee
the rest of the agreement.

EMD USER SOFTWARE LICEMSE :I

READ THE TERMS AND CONDITIONS OF THIS LICEMSE

CAREFULLY BEFORE USING THIS HARDWARE, SOFTWARE.

OR THE ACCOMPANYIMG MATERIALS (THE "PRODUCTS").

BY USING THE PRODUCTS, YOU ARE ACCEFTIMG AND

AGREEING TO THE TERMS AMND COMDITIONMS OF THE

LICEMSE AGREEMENT. IF*¥0OU ARE NOT WILLING TO BE

BOUWD BY THE TERMS AWD COMWDITIONS OF THE LICEMSE

AGREEMENMT, ¥OU SHOULD RETURM THE PRODUCTS _ll

Do you accept all the terms of the preceding License Agreement? |F pou choose Mo, Setup
will cloge. Toinstall the Osprep-2000, you must accept thiz agreement.

¢ Back Yes Mo 1

5. Review this message and make sure that the licensing terms are acceptable.
Click Yes to accept the agreement or No to terminate the installation routine.

The Osprey-2000 Master Installation Program Installation Options window
displays.

Osprey-2000 Master Installation Program Installa x|

Typical ingtall will inztal the device driver and MPEG operation
companentz. The Custom install will allow a choice of 2
Developer components. Select Topical or Custom.

' Typical: minimum inztall for full Dsprey-2000 operatior

" Custom: developer and diiver components selectable

< Back I Hest > I Cancel
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6. Select Typical (to install the Main Driver Software and the Runtime
components necessary for full MPEG operation) or select Custom (and be
prompted to choose among all the typical and developer components).

7. Click Next to continue or Cancel to abort the installation.

8. If you select the Typical installation, skip Step 9. Your next step will be to
choose the Destination Folder. If you select the Custom installation, continue
with Step 9.

The Osprey-2000 Master Installation Program Component window displays.

Oszprey-2000 M aster Installation ProgramComponent Selection |

Chooze which of the Ozprey-2000 diver components you would
like b inztall

¥ #dain Driver Software

[+ 0Pl RBuntime Driver Component
[T 0Pl SDE [for developers only]
[ Wideo For Windows SDE [for developers only]

< Back I Mest > I Cancel |

The Osprey-2000 software consists of the Main Driver Software (required) and
three optional components:

Video For Windows Software Development Kit supplements the Windows Video
For Windows (VFW) control interface with Osprey-specific routines for selecting video
port, decoding closed captions, and cropping, among other features. This component
contains source code for several sample applications, documentation, and the
software components necessary for users to write their own VFW applications using
C++.

OPI Runtime Driver Component contains a digital VCR application (MpegVCR) and
the software components necessary to use it.

OPI Software Development Kit contains source for the MpegVCR application and
all software and documentation components necessary for users to write their own
applications using the Osprey Programming Interface.
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9. Check the box for Main Driver Software (required) and choose the
checkboxes for any other components that you wish to install. Click Next to
continue.

If you decide to install one of the optional components later, you can
always install it from the CD.

The Osprey-2000 Driver Setup Destination Location window displays.

O zprey-2000 Dnver Setup Destination Location

Setup will install the Deprey-2000 in the following folder.
T o ingtall o thiz folder, click Mest.

T inztall ta a different falder, click Browse and zelect anaother
folder.

Y'ou can chooge not ta inztall the Ozprey-2000 by clicking Cancel
b exit Setup.

" Drestination Faolder

C:“Frogram FileshOsprey-2000 Browsze... i
Cancel |

¢ Back
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10. The destination location is the folder where VidCap32 (the demo applet),
ReadMe, and other auxiliary files are located. (The core video capture driver
files are located in Windows NT system directories regardless of the destination
location chosen here.) The default location, in the Program Files folder, should
be appropriate for most systems. Click the Browse button near the bottom of
the dialog if you want to change the location.

The Osprey-2000 Driver Setup window displays.

Ozprey-2000 Dnver Setup

Setup will add program iconz to the Program Folder listed below.
Y'au may tpe a hew falder name, ar select ane from the exizting
Folders list. Click Mest to continue.

Program Folders:

Exizting Folders:

ve T oolz [Common]
Adobe Acrobat 4.0
HF Infa
MATRD® POWERDESK NT
MEDIAMATICS DWDEPRESS
METSCAPE INSTALLATION
Ozprey 500
Ozprey Multitedia Capture

Startup ;I
¢ Back I MHewt » I Cancel |
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11. The setup program suggests placing the Osprey icons in a new program folder
entitled Osprey-2000. You may change this name by editing the Program
Folders field, or you can add the icons to an existing folder by highlighting it in
the Existing Folders window. Click Next to continue.

The Start Copying Files window displays.

O zprey-2000 Driver 5etup

Setup has enough information to start copying the program files.
If you want ko review or change any zettings, click Back. If you
are zatisfied with the settingz, click Megt to begin copying files.

Current Settings:

Destination Directany: :I
C:%Program FileshOzprep-2000

Program Folder;
Qzprey-2000

i o
Cancel |

12. Click Back to modify the directory and program folder destinations or click
Next to continue. The installation program copies the files to their destinations,
sets up the Osprey driver registry entries, and starts the driver.

If another kind of video capture driver is already installed on your system, this
question appears.

< Back

Ozprey-2000 Yideo Capture Driver i

@ Do pou want ko make thiz your primary wideo capture driver?

o |

13. Click Yes to make the Osprey driver your primary video capture driver, unless
you have a particular reason for doing otherwise. Refer to Appendix D - Using
the Osprey Video Capture Driver with Other Drivers for more detailed
information about this message.

If another kind of audio capture device such as a soundcard is already installed on
your system, a message similar to the one above displays asking, "Do you want to
make this your primary audio capture driver?”
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Oszprey-2000 Yideo Capture Driver

14. Click No to continue using your soundcard as your primary audio recording
device.

Although this question asks about audio capture, you do not want to choose
Yes, because that would set the Osprey-2000 as the default audio Playback
Device. Chapter 9 - Capturing Audio contains instructions for setting the
Osprey-2000 as the default audio capture device.

15. If you selected the Typical install option, the next window prompts you to
restart your computer. Please skip to the final step in this series.

16. If you selected the Custom install option, please complete all the remaining
steps.

The OPI SDK Setup Choose Destination window displays.

Ozprey 2000 OFI SDK Setup

Setup will install Qzprey 2000 0P SDE. in the following folder.
T o ingtall tothiz folder, click Mest.

T o inztall to a different folder, click Browse and zelect another
folder.

Y'ou can chooge not to inzstall Deprey 2000 OF| S0DE. by clicking
Cancel to exit Setup.

" Destination Folder

C:AProagram Filezh0zprey-200080F1 S0OE. Browsze... |
Cancel |

¢ Back
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17. If you wish to change the destination location for the files, click Browse. Click

Next to install the OPI SDK or Cancel to skip the installation of this

component.

The Setup Complete window for the OPI SDK installation displays.

Setup Complete

Setup haz finizhed installing werzion 1.00 re2 of the Ozprey-2000
0Pl SOk

Click Finizh to complete Setup.

< Hack

18. Click Finish.

The Osprey-2000 VFW SDK Install window displays.

Osprey 2000 YW 5DEK

T hiz product will now inztall the Ozprey 2000 %W
SOk Yersion 1.00.000 F

[t iz ztrongly recommended that you exit all Windows programs
before running thiz Setup program.

Click Cancel to quit Setup and then close any programs youl
have running. Click Mest to continue with the Setup program.

WARMIMG: This program is protected by copueright law and
international treaties.

Ilnauthorized reproduction or distriibution of this program, or any
partian af it may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozzible under law.

Cancel |
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19. Click Next to install the VFW SDK or Cancel to skip the installation of this
component.

The VFW SDK Software License Agreement window displays.
Osprey 2000 YW 5DK Software License Agreement

Pleaze read the following License Agreement. Press the PAGE DOWM key to see
the rest of the agreement.

| i‘
END USER SOFTWARE LICENSE

READ THE TERMS AND CONDITIONS OF THIS LICEMSE

CAREFULLY BEFORE USING THIS HARDWARE, SOFTWARE.

OR THE ACCOMPANYIMG MATERIALS [THE "PROCUCTS").

By USING THE FRODUCTS, vOU ARE ACCEPTIMG AND

AGREEING TO THE TERMS AND COMDITIONS OF THE

LICEMSE AGREEMENT. IF*0U ARE NOT WILLING TO BE

BOUMD BY THE TERMS AND CONDITIONS OF THE LICEMSE

AGREEMENT. YOU SHOULD RETURM THE FRODUCTS j

Do you accept all the termsz of the preceding License Agreement? [f you chooze Mo, Setup
will cloge. Tao install Dzprey 2000 WFW SDE., you must accept this agreement.

< Back Tez Mo l
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20. Review this message and make sure that the licensing terms are acceptable.
Click Yes to accept the agreement or No to terminate installation of this
component.

If you clicked Yes, the Osprey-2000 VFW SDK ReadMe Information window
displays.

Osprey 2000 YW 5DK BeadMe Information

Ozprey-100 MT Wi SDE
Werzion 1.54
Feleaze Motex

Full uze of thiz SDE. requires Dsprey-100 KT or

“findowves 2000 driver werzsion 1.54 ar higher, o
ar Deprep-2000 M T MAvfindows 2000 verzion 1.000,

These diivers are available from our frp site

[zee below] under .. Asinntd or . AsinZ0007.

The S0k documentation iz o1 00N Tzdk. POF. This file
iz in Adobe .\POF format and requires Adobe Acrobat
reader. Acrobat reader iz available for free at

vy, adobe, comdprodindes/acrobat Areadstep. hitml,

H o

< Back
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21. Read this file and click Next.
The Osprey-2000 VFW SDK Setup Destination Folder window displays.

Ozprey 2000 YW SDE Setup Destination Folder

Setup will install Dzprey 2000 YFw SDE. in the following folder.
T o ingtall to thiz folder, click Mest.

T inztall ta a different falder, click Browse and zelect anaother
folder.

Y'ou can chooge not ta inztall Dzprey 2000w SDE by clicking
Cancel to exit Setup.

C:AProgram FileshO zprep-2 0005 F SDE, Browse... |
Cancel |

22. 1If you wish to change the destination location for the files, click Browse. Click
Next.

The Osprey-2000 VFW Setup Complete window displays.

" Drestination Falder

¢ Back

Oszprey-2000 ¥Fw SDE Setup Complete

Setup haz now finished instaling Yersion 1.00 re] of the
Dzprey-2000 YFwW SDE,

Click Finizh to complete Setup.

< Hach
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23. Click Finish.
The Osprey-2000 Master Installation Setup Complete window displays.

S

etup Complete

The Ozprep-2000 program group coktaing icons for the VidCap32
zample applet and for the Readide.

Run VidCap32 ta test and calibrate the driver.

Y'ou will need to restart the machine before uzing the
Ozprey-2000.

% ez | want bo restart my computer notw.

€ Mo, | will restart my computer later.

Remove any disks fram their drives, and then click Finizh to
complete zetup.

¢ Hack I Finizh I

24. Click Finish to complete the installation. You must restart Windows NT before
you can use the Osprey-2000 card.

& To change your setup at a later time, see Chapter 9 - Capturing Audio.
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Testing the Installation for Windows NT

1.  Verify that the hardware installation is complete according to the directions in
Chapter 2 - Osprey-2000 Hardware.

2. Connect a video signal source to one of the Osprey-2000 connectors
(Composite/S-Video/SDI/DV). Refer to Connecting Cables.

3. Open the Osprey-2000 group in the Start menu.
4, Click the VidCap32 icon.

5. If your input is composite video, the screen displays a preview mode window
with live video. Click the Overlay button. The screen should display moving
video frames. If your input choice is not composite video, select the Video
Source option under the Options menu to bring up the Osprey-2000 video
capture driver configuration box where you select your video input.

6. If the video area does not contain video, it could be for one of the following
reasons:

7. The driver is looking for video on the wrong input connector. You can either
move the video cable to another connector or reconfigure the driver using its
Control Dialog. See Chapter 8 - Osprey-2000 Video Control Dialog.

8. The video source is not turned on or activated.

9. If the video area is scrambled or has bad color, the signal format of your video
source may be different from the signal format selected in the driver software.
Since the driver defaults to NTSC-M signal format, users of PAL equipment
always need to change the driver’s signal format the first time they run the
driver. See Chapter 8 - Osprey-2000 Video Control Dialog.

DXMedia

Under Windows NT 4.0, the included program AmCap cannot be run unless
Microsoft’s DirectX Media package (also known as DirectShow) has been installed.
This package is included on the Osprey-2000 Driver CD, and it can also be
downloaded from Microsoft’s website.

DirectX Media Details

Indeo

Ligos Technology's Indeo codec is provided on the Osprey-2000 CD. To install this
package containing compression and color formats, double-click file
Indeo\Disk1l\Setup.exe.

Please see Ligos Technology's Indeo in Chapter 10 - VidCap32, AmCap, and
Included Demo Programs for a description of this package.
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Uninstalling the Software - Windows NT

If you need to remove the Osprey driver from your system:

iAW E

o

Open Control Panel.

Double-click Add/Remove Programs.

Click the Install/Uninstall tab.

Click to select the Osprey-2000 Driver in the list of programs.
Click Add/Remove.

The uninstall program begins.

Click Yes to proceed.

Click OK when the process is complete.

Repeat this for each optional component that you have installed:
Osprey-2000 OPI SDK

Osprey-2000 OPI Runtime

Osprey-2000 VFW SDK

Reboot your computer to complete removing the driver.

You have the option of deactivating the Osprey drivers without

another device as your primary video capture device. Refer to Appendix
D - Using the Osprey Video Capture Driver with Other Drivers for
more information.

i permanently uninstalling them. For example, this option allows you to use
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Chapter 5 - MPEG Encoding

DirectShow Encoding Demo

Uncompressed video and audio consume a significant amount of bandwidth. For
example, a 704x480 YUV4:2:2 video stream consumes over 154Mbits/sec or
19MBytes/sec. Saving uncompressed data to disk would consume over a Gigabyte a
minute, which is impractical for many users. Such consumption far exceeds the
bandwidth available on most networks today.

With the Osprey-2000, encoding/compression techniques are used to reduce the
bandwidth of uncompressed audio and video. Three of the six models of the Osprey-
2000 card provide MPEG encoding:

¢ Osprey-2000
¢ Osprey-2000 Pro
¢ Osprey-2000 DV Pro

The MPEG-1 and MPEG-2 encoding of these models provides from VHS to DVD
quality encoding in hardware, thereby minimizing the computational load on a
computer main processor.

Any of the audio or video inputs can be used as the source for MPEG encoding,
including the DV input which makes possible DV->MPEG real time transcoding.

The Osprey-2000 provides for:

MPEG-1 System Streams

MPEG-2 Program and Transport streams

Resolutions up to and including 704x480 NTSC, 704x576 PAL
Variable and Constant bitrate encoding**

MPEG-1 Layer-I or II audio

Up to 8Mbits/sec

* & 6 & o o

*x For Variable bitrate encoding (VBR), specify a target bitrate. Bitrate achieved
will vary by 30% + or - from the target bitrate setting.

The primary end user encoding experience is intended to be through third-party
encoding applications. Please see our web site at http://www.viewcast.com/for
an updated list of supported third-party ISV encoding solutions.

Some DirectShow based applications may run unmodified on the card. Other
developers may use either the OPI SDK or the DirectShow SDK for developing
applications that work with the Osprey-2000. Note that DirectShow support for the
Osprey-2000 is limited to Windows 2000; therefore, some third-party applications
may be supported only under Windows 2000.
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The MpegVCR mini-application can be used for encoding MPEG files. This application
is installed as part of the optional OPI Runtime component. Source code, in Visual
C++, is included in the Osprey-2000 OPI SDK distributed with the Osprey-2000. The
intent of this demo is to allow for basic MPEG content creation and playback. It does
not represent the full capabilities of the SDK nor the underlying options for the
encoder.

DirectShow Encoding Demo

Preview Video Size
Video Format
Encoder Control Dialog

For Windows 2000 users only, a very simple encoding demo program is provided in
executable form in the Osprey DirectShow runtime package. Source code, in Visual
C++, is included in the Osprey DirectShow software development kit (SDK)
distributed with the Osprey-2000. The intent of this demo is to allow for basic MPEG
content creation. It does not represent the full capabilities of the SDK nor the
underlying options for the encoder.

When started, the DirectShow Encode Demo application displays a dialog box to
announce the application and accept user input.

|—‘ 0Osprey-2000 DirectShow Encode Demo (Dev & x|
Recaord | Preview | Exit |
Encade Control | Preview Control |
FileMame: |BRUE=Rss) Browse |

Filz Size [KEB) I i} Elapsed Time I i}

Record button is a toggle; press it once to start encoding, and press it again to stop.

Encode Control button brings up the encoder control dialog box, where users can
configure the attributes of the encoded stream.

The audio selections include the input port, bit rate, sample rate, and the type of
MPEG1 audio encoding.

Note that the sample rate for digital sources (SDI, DV and AES/EBU) is
set by the source itself and is not changeable on the Osprey-2000.

To produce valid encoded material, the sample rate set for digital sources must
match the sample rate of the source. In a future software release the drivers will
auto detect the digital audio input sample rate and set the encoding sample rate
automatically.
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Preview button allows the user to view video being received on the selected video
input in real time without having to start the encoder. This control is a toggle; press
it once to open the preview window, and press it again to close the preview window.
By default, the preview size is a small (QCIF) window.

Preview Control button lets the user change the preview size. Note that using a
large preview window increases PCI bus traffic, which may overload your CPU during
precoding.

Browse button is the standard function for locating where you want to store the
encoded stream.

Wideo

Board Mumber 1

— Preview Video Size

" Use MPEG Encoder size [ 704« 480)

% Resize video:

1 Full [ 540 450)
™ 1/2 (320 % 240)
144 (160 % 120)

7 Custom: Iﬁ b W

ideo Format:

Ok I Cancel Apply

Preview Video Size

To make previewed video the same size as the video encoded, select Use MPEG
Encoder Size. To choose an output size for previewed video, select Resize Video.

Video Format

Instructs the capture filter to produce the selected format on its preview pin.
Normally, it is best to leave this format RGB 555.
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Encoder Control Dialog

While the encoder is running, the file size (in Kilobytes), the bit rate (in Kilobits) and
the elapsed time (in seconds) is displayed in the Encoder Control Dialog box.

=
MPEG | F'icturel Advancedl About I

Inputs
Yide:

Jevice 1 [0V Pro
— Strearn Format—————— ICUmDUSitE 'I
IMF‘EGZF‘rogram Vl & NTSC  PAL
" CER = VBR il

Wﬂ S Wﬂ IUnbaIanced 'I

— Stream Bitrates

Video: 4.00mbps ' 4 0ottt !

Tranzport: 4.00 mbpz E e

—Audio P,

T28kbps v v v 0 v
Steren

Sample Fate: |48_thz 'l  Layer| @ Layerll
Ok I Cancel I Apply |

In the Encode Control dialog box the user has control over the:

Selected board (if multiple Osprey-2000s are installed in your system)
Source of the video and audio from the Osprey-2000 inputs

Video format (either NTSC or PAL)

Stream format to produce

Selection of constant bit rate (CBR) or variable bit rate (VBR) encoding
Size of the video image to capture

Target bit rates for the stream

Audio parameters

* & & 6 6 o o o

In addition, the Picture tab controls video settings such as Brightness, Contrast,
Saturation and Hue. The Advanced tab allows control of some video frame
parameters which are specific to the Osprey-2000, and control of a number of
advanced MPEG-1 and MPEG-2 parameters. The Advanced tab contains the Video
Encoding, Stream Settings, and Filter Coefficients property pages. Again, these
represent only a small number of the configurable options for the Osprey-2000 MPEG
encoding feature.
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Advanced tab

On the Video Encoding page, the following parameters control features which are
specific to the Osprey-2000 and outside the MPEG specifications:

Frame Skip: Allows decimation of video frames. Value of 2 divides frame rate in
half. Should be set to 1. Changing this parameter is not recommended.

Threshold: Inverse Telecine threshold. Ignored.

The following 3 parameters are for adjusting the vertical horizontal start positions in
the image. Use care when modifying these parameters.

¢ Top Field: line number to use as first line of "top" field.
¢+ Bottom Field: line number to use as first line of "bottom" field.
¢ Horizontal: pixel number for start of line

All of the other parameters and property pages available in the Advanced tab affect
MPEG parameters which are explained in the MPEG-1 and MPEG-2 specifications.
Changing the values of the parameters exposed through these property pages may
affect the performance of the Osprey-2000 product. Only advanced users who are
thoroughly familiar with the MPEG specifications should modify these MPEG settings.
MPEG is a group of ISO/IEC standards. Please see http://mpeg.telecomitalialab.com/
to get a copy of these international standards.
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While MPEG-1 content is not CPU intensive and is easily decoded on most platforms,
decoding MPEG-2 content is extremely CPU intensive. Although many computers
shipping today have DVD drives and are capable of playing back DVD movies, the
configuration of these machines with respect to how they decode DVD does not
enable general purpose MPEG-2 decode. Even if a user's machine can playback DVD
movies with ease (DVDs are encoded in MPEG-2), the machine probably cannot
playback an MPEG-2 file. And even when a machine is capable of playing back MPEG-
2 files, it generally does so in a window on the machine and does not provide the
decoded audio and video back to a host application for further processing. These
deficiencies are the main reasons why all six models of the Osprey-2000 provide for
MPEG decoding (the last usage is important to transcoding and is discussed in
Chapter 7- MPEG Transcode).

MPEG decoding is primarily provided through the DirectShow interface on Windows-
2000. This interface requires at least DirectX8 and thus is not provided for on WinNT.
The cross-platform API OPI also provides for MPEG decoding and does so on WinNT
as well as on Win2000.

Decoding through DirectShow
Decode_Demo

MPEG Decode Configuration Applet
Decoding through OPI

Decoding Through DirectShow

Since MPEG-1 content is not CPU intensive, the DirectShow filters for the Osprey-
2000 usually allow installed software decoders to handle MPEG-1. In any case, to
play back a MPEG-1 or MPEG-2 file simply open it and it will play in a Windows Media
Player, Real Player, or whatever player you have file-extension associated to play
MPEG files. In the MPEG-1 case video will be displayed in a window in the host
application and audio will be directed to your soundcard and can be heard on
external speakers. In the case of MPEG-2, video will also be displayed in a window in
the host application and audio will be both directed to your soundcard to be heard on
external speakers as well as sent out the audio output on the Osprey-2000. That is,
you can use either the Osprey-2000 or your soundcard for listening to the audio
decoded from the Osprey-2000.

Note that if your Windows 2000 interface is set up to preview MPEG files when they
are opened, it's possible that the hardware decoder will be busy decoding the
preview and unable to display it in full size.
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To change this behavior:

Open the Windows Explorer

Select Tools -> Folder Options

Select the General tab

Use Windows Classic folders

Click on the View tab

Select the Remember each folder's view settings option,
Select Apply button

Select the Like Current Folder button

The Osprey-2000 handles streaming decode of MPEG content for playback or
transcoding purposes. The word streaming here is used to distinguish between
frame-based decoding requests (seeks, random access, frame accurate decode,
etc.) and playback of an entire file in a sequential manner. The Osprey-2000
can process:

. MPEG-1 system streams

. MPEG-2 program streams
) MPEG-1 layer-I or II audio
. Up to 8Mbits/sec

The primary end user decoding experience is intended to be through third-party
applications (Windows Media Player, Real Player, etc) where either the MPEG content
is decoded in software (MPEG-1) or hardware (MPEG-2). However, a very simple
decoding demo program is provided in executable form in the Osprey DirectShow
runtime package distributed with the Osprey-2000 [Windows 2000 only]. Source
code, in Visual C++, is included in the Osprey DirectShow software development kit
(SDK) distributed with the Osprey-2000. Installation of the Osprey-2000 DirectShow
runtime places the Osprey DirectShow filters on your system.

NV AN

Decode_demo

The program group name for the decoding demo is Decode_demo, and the purpose
of Decode_demo is to utilize the Osprey-2000 to decode MPEG content.

Decode_demo can direct (decode output) the resulting decoded audio and video to
three different locations:

¢ Selecting Video Out directs decoded data to the external ports on the
Osprey-2000. With this demo you could use an external NTSC/PAL monitor to
view the decoded video and speakers to hear the decoded audio. You could
also connect the external outputs to a VCR and record the decoded MPEG
content.

¢ The Window option directs decoded video to a window on the PC and
decoded audio to the PC audio device. This use of the application is similar
(although much more limited) to playing back an MPEG file through Windows
Media Player.
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+ The Application Capture option directs decoded audio and video data to the
capture inputs of the Osprey-2000. Refer to Video for Windows Capture of
Decoded Video for more details.

£ Dsprey-2000 MPEGZ Decode x|

.......... Load Play 2 o | = |

Decode Output
’V " application Capture © Video Out & Window
Filename: IC:\fw_m2_25.mpg Browsze |

Select a file to decode by either typing in the file name or using the Browse button
in the dialog box. Click a button on the screen or one of the links below for
information about these options:

Load
Play
Pause
Stop

Exit

Load

Prepares the Osprey-2000 to play back the current file.

Play

Plays the file. Note that while you can select Play without selecting Load first, it will
take longer to start playing the first frame. Therefore, if you are trying to use
Decode_demo to coordinate with another application, it's better to pre-load.

Pause

While playing an MPEG file, selecting Pause will temporarily stop playing back the
file until Play is selected again.
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Stop

Selecting Stop while playing an MPEG file will stop playing the file. Unlike Pause,
selecting Play again will restart the file from the beginning.

Exit

Exits the Program.

Output Options - Video Out or Application Capture

Depending upon the selection made in the Decode Output field, different Properties
screens display with additional options. When either Video Out or Application
Capture is selected, the following menu appears. Click the area of the window for
which you need an explanation.

Properties 5'

Oegprey-2000 Decode [video out) | About |

Board Mumber:

% Wideo Out & PCI by

Wideo Output
’7 & NTSC (" PAL

"Video Destination

0k I Cancel Ll

Board Number
Video Output
Video Destination

About Tab
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Board Number

When there are multiple Osprey-2000 boards in your system and you have selected
either Window in the Decode Output field, use this drop-down menu to determine
which board is active.

This field does not affect which board is used if you change the location in
the Decode Output field to either Application Capture or Video Out.

Video Output
Select NTSC or PAL video output.

Video Destination

This option can also be set on the main Decode_demo dialog. PCI Bus here is
equivalent to Application Capture in the main dialog.

About Tab

Provides information version numbers for the various filters.
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Output Options - Window

When Window is selected in the Decode Output field, the following menu appears.
Click the area of the window for which you need an explanation.

Audio | Video | About |

Board Mumber:

Yideo Standard
IV % NTSC PAL

@ Uze MPEG audio parameters

—&udio

" Resample audio:

Sample R ate: Chanmels:
lm ) Mano %) Steren
Format:
Bkt 5 6 kit

Ok I Cancel Apply

Audio Tab
Video Tab
About Tab
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Audio Tab

Audio | Video | About |

Board Mumber:

Yideo Standard
IV % NTSC PAL

@ Uze MPEG audio parameters

—&udio

" Resample audio:

Sample R ate: Chanmels:

|44.1 khz 'I  Mono % Stereo

Format:

L= A S | =1

Ok I Cancel Apply

Board Number
Video Standard
Audio

Board Number

When there are multiple Osprey-2000 boards in your system, and you have selected
either Application Capture or Video Out in the Decode Output field, use this drop-
down menu to determine which board is active.

Note that this field does not affect which board is used if you change the
location in the Decode Output field to Window.

Video Standard

Select either NTSC or PAL video output. An incorrect selection here will negatively
impact the appearance of the decoded video.

Audio

Use MPEG audio parameters is normally the recommended setting. If you select
to resample the audio, once audio is decoded it has to be changed to match the
target format. Resampling may result in degradation of audio quality. For this
release, audio upsampling is not supported.
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Video Tab

Selecting the Video Tab brings up another Properties page. Click the area of the
window for which you need an explanation.

Audio Midea | apout |

Board Mumber 1
— Output Video Size

% Use MPEG Stream size

" Resize video:

£ Fulll (B4 4501
@ 1/2 (32007 240
144 (16017 120

) st Iﬁ b W

ideo Format:

Ok I Cancel Aoply

Output Video Size

Video Format

Output Video Size

¢ To make decoded video the same size as the video encoded, select Use
MPEG Stream Size

¢ To choose an output size for decoded video, select Resize Video

Video Format

Instructs the capture filter to produce the selected format on its preview pin.
Normally, it is best to leave this format RGB 555.

About Tab

Provides information version numbers for the various filters.

100 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 6 - MPEG Decoding

MPEG Decode Configuration Applet

Many applications that use DirectShow interfaces for decoding MPEG do not expose
to the end-user a method for configuring the decoder options. This configuration
applet sets the defaults for some Osprey-2000 MPEG decoding options. Unless the
user application overrides these defaults, the settings in this configuration applet will
take effect.

1 0sprey-2000 MPEG Decoder Configuration : 5[
Board Mumber:
IDevice 1 'l
LCloze |
_Video ...................................................................
= Use MPEG Source Size & MPEG Source Settings; Help |
drecommendedl
{* Resize ta; ' Resample to:
£ Full [540 » 450] T
& CIF [320 % 240)
' OCIF (160 120) £ Moo, 85
= Steren, & 16bH . S
F NTSE O PAL Mlewicast il

Options that can be set with this applet are:

¢ MPEG decoding size: By default, the Osprey-2000 decode filter decodes to the
resolution of the MPEG content. You can change this option to scale the
decoded video to a few different sizes.

¢ MPEG decoded audio sample rate: By default, the Osprey-2000 decode filter
presents decoded audio to the host at the same sample rate as the audio in
the MPEG content. You can change this option to present a different decoded
audio sample rate to the host application.

In release 1.0 of the Osprey DirectShow filters, upsampling is not available. For
example, if the MPEG content was created with a 32.0 KHz sample rate, you can only
select sample rates of 32.0 KHz and lower. Selecting a higher rate will result in silent
audio.

Decoding Through OPI

The OPI interface also provides decoding of MPEG bitstreams. The MpegVCR mini-
application (written to use the OPI drivers) may be used for decoding MPEG files.
This application is installed as part of the optional OPI Runtime component. Source
code, in Visual C++, is included in the Osprey-2000 OPI SDK distributed with the
Osprey-2000. The intent of this demo is to allow for basic MPEG content creation and
playback and it does not represent the full capabilities of the SDK nor the underlying
options for the encoder.
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Chapter 7 - MPEG Transcode

All six models of the Osprey-2000 card provide hardware assist for MPEG
transcoding. The function of a transcoder is to convert from one data format to
another data format.

The Osprey-2000 can be used to decode the MPEG bitstreams and then allow
software compressors to re-encode the video and audio to new formats. Because the
Osprey-2000 decoder works in parallel with the computer’s main CPU, the
computational load on the main processor is reduced. Note that Chapter 5 - MPEG
Encoding details transcoding from DV to MPEG.

Depending on the application doing the software encoding portion of the transcode,
three different transcoding techniques may be used with the Osprey-2000:

Two pass transcoding, using an AVI file as an intermediate step.

Transparent transcoding, where the only user interaction is telling the
encoder to use an MPEG file as an input.

¢+ Video for Windows (VFW) capture of decoded MPEG, where two applications
are run. One application thinks it is doing live capture, while another
application sends decoded video to the video capture portion of the Osprey-
2000 as if it were live video.
Transcoding with RealProducer

Transcoding with Windows Media Encoder

Each of these techniques relies on DirectShow filters and requires both
Windows 2000 and the installation of the Osprey-2000 DirectShow
Runtime optional component.

Two Pass Transcoding

The two pass transcoding technique works with any application that can accept
uncompressed AVI files. The primary disadvantage of two pass transcoding is that it
requires enough disk space to support decoding and storing the entire decompressed
output.

The Decode to AVI demo program is provided in executable form in the Osprey
DirectShow runtime package distributed with the Osprey-2000. Source code, in
Visual C++, is included in the Osprey DirectShow software development kit (SDK)
distributed with the Osprey-2000.

The Decode to AVI demo starts in a DOS window. The DOS window displays a file
open dialog box, which obtains the path to the file for decoding. Alternatively, you
can specify the filename on the command line. If preferred, a second filename can be
provided for the resulting decompressed file. Once a filename has been selected, the
file is decoded to an application. If no output file is selected on the command line,
the output file is given the same name and location as the input file, with the
extension changed from .mpg to .avi.
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Once an AVI file is created it may be passed to any encoding application, including
RealProducer or Windows Media.

Use the decode configuration applet to modify the resulting video size and audio
sample rates of the AVI file. Refer to MPEG Decode Configuration Applet in
Chapter 6.

Transparent Transcoding

Transparent transcoding is enabled by applications which use DirectShow filters to
provide uncompressed video to their internal compression. For transparent
transcoding, all that is necessary is to select the MPEG file as the input of the
compression, and the DirectShow filters will decode the file and provide
uncompressed bitstreams to the application. RealProducer uses this technique,
discussed in more detail in Transcoding with RealProducer.

Current versions of RealProducer have some issues using this technique.
& Our recommendation is to use the VFW capture method of transcoding,
instead.

Video for Windows Capture of Decoded
Video

In order to transcode using VFW capture, the Osprey-2000 takes advantage of the
fact that the encoder, decoder, and video capture components of the card operate
fairly independently. This technique allows any application which can accept live
audio/video capture from the Osprey-2000 to accept decoded MPEG bitstreams,
instead. All the normal capabilities of the Osprey-2000 video capture (such as
cropping, etc) are available in this mode.

For this technique, first prepare your video capture application to capture video from
the Osprey-2000.
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1. Bring up the Video Format dialog (usually available from your VFW application
via a Video Format menu).
Dsprey-2000 Yideo Capture Driver, Yersion 1.01 2]
Faurce I Closed Eaptionl Configurationl Logo I
— Input Signal Bioard Select
™ Covpesl @ NTSCM C PALEDGHI | [T o]
s € NTSC € PALM
o  SECAM
= DV [IEEE 1334
% Decoded MPEG
—ideo Setting
_ N
IT -—J— Erightness “MIIS'-
108 -—J— LCantrast
127 -—J— 5 aturation
128 '_J— Hug Restore Previous |
d Restore Defaults |
Ok I Cancel I Help |
2.

the Start/Programs interface.

£ Dsprey-2000 MPEGZ Decode

Click on the Source tab, and set the Input to Decoded MPEG.
The Decode_demo is used to decode an MPEG file.

This demo can be started from

x|
........... e Play v Eren | = |
Decode Output
’7 " Application Capture ¢ Video Out €% Window
Filenarne: IE:\fw_m2_25.mpg Browsze |

o kAW

Select Play to decode the file.

Use either the Filename box or Browse to select the file to decode.
Select Application Capture in the Decode Output field.
Click Load to prepare the Osprey-2000 to start decoding.

Now, start encoding in your Video for Windows encoder program.

This technique can be used by virtually any video capture enabled application. It is
discussed further in Transcoding with Windows Media Encoder.
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Transcoding with RealProducer

Our recommendation is to use the VFW capture method of transcoding,

i Current versions of RealProducer have some issues using this technique.
instead.

1. Open RealProducer and set the Input Source to File.

x|
— Input Source — Output
" Media Device 1+ Realedia File
Frepare the media device that pou will be IC:\HealContent\mpegEfile.rm
capturing from and then select the inputs
that you want to capture. Saveds.. |
T s e ) Llive Broadzast
|1. Dzprey 2000 Audia j FealSener I
¥ | Eamtire Yiden Fatvst For IdDdD
[0 o2kve di- Dsprey-2000 Codec 1 <] | | Flename |
Wsemame I
Fassord I
% File
D vwideosmpeg2file. m
I £ed £ = | rctive Broadeast o s
Browse... I I
Save fe) I

Ok I Cancel | Help |

2. Select an MPEG2 file as the input source, and set the output source to the
desired RealMedia File. Click OK.

3. If you need to configure other aspects of RealProducer, such as Target
Audience settings, setting Two-Pass Encoding, or entering Clip
Information, do so at this time.

4.  Once RealProducer is configured and ready to start streaming, click Start on
RealProducer to begin encoding. The Osprey-2000 will decode the file on board
automatically.
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Transcoding with Windows Media Encoder

1. Open the Windows Media Encoder. The encoder offers three startup options:
. Using the Wizard
. Creating a custom encoding session
. Opening an existing session

For this example, select Create a custom encoding session and click OK.

The New Session window appears.

ENew Session 5[

Sources i Display Informationl Attributes} Pmﬂe] Uutputl Advanced

Set up source groups for this session Al source groups in & session must have the
same set of source types.

Group | widea Audia

MHew. .. Change... Hemove | move Up | MoveDownI

Source types for this session: M Video ¥ Audic [ Script
| ] 4 I Cancel | Help

2. Click New to create a New Source Group.
The New Source Group window displays.

New Source Group 5'

Mame: |02kvc.dll - Ogprey-2000 Codec 1

Sources and Archive | video Clipping | Wideo Optimization

Select the inputs for this source group. To specify a file input, select the
Browse for file optioh ih each list.

Wideo: |02kvc.dII-Dspre_l,l-2DDD Codec1 j Configure... I
Audio: IDspre_l,l 2000 Audio j Configure.... |

Script; I

Archive: & Fecord  FPause ) Stop

0] Cancel
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3. Select Osprey-2000 codec for Video, and Osprey-2000 Audio for Audio.

4. Click the Configure button to the right of the Video selection window. The
Audio device will not be configured from this page.

The Osprey Device Property Page windows displays.

5. The Osprey Device Property page will display selections for the Osprey-500
board. Select Driver Format Dialog.

The Osprey-2000 Video Capture Driver window displays.

Osprey-2000 Yideo Capture Driver, ¥ersion 1.01 2]

Faurce I Closed Eaptionl Configurationl Logo I

— InpLt Signal Bioard Select
¥ Covpesl @ NTSCM C RALEDGHI | [T o]
N
SVideo € NTSC € PALM
£ 5p)|

 SECAM
£ DW(IEEE 1234

% Decoded MPEG

—Wideo Setting: & ,_\
|128 -—J— Brightriess ﬁew(ns%
105 -—J— Cotitrazt
{27 -—J— 5 aturation

128 .—J— Hue: Restore Previous |

Restore Defaults |

Ok I Cancel I Help |

Click the Source tab and set the Input to Decoded MPEG.
Click OK to exit the Osprey-2000 Video Capture Driver.
Click OK to exit the Codec Properties.

Click OK to exit the New Source Group window.

10. Set the Profile and Output as desired, and click OK to exit the New Session
window.

The Windows Media Encoder window displays.

© N

Welcome to Windows Media Encoder |

wihat do pou want to do?

[
" Broadcast, capture, or corvert a file using the New Session Wizard

[N
¥ Create a custom encoding zession
ﬁ " Open an existing encoding session

N
%o ) Dpen a recent encading session:

Mame | Falder

¥ Show this dialog box at startup 0k I Cancel

Before encoding, the audio device must be configured.
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11. To set the audio properties, right click the Speaker Icon in the taskbar, and
select Open Volume Controls.

The Volume Control window displays.

Open ¥olume Controls

Adjust Audio Properties
[@ 4120 PM

12. Go to Options -> Properties, and set the audio device to Osprey-2000.
13. In the box for adjusting volume, select Recording and click OK.
The Record Control window appears.

Ef Record Conbrol =1=1 =]
Optians Help

Record Contral | UnBalanced Balanced #na | XLR AES/EBU | SDI D (1394) Mpeg Decode
Balance: Balance: Balance: Balance: Balance: Balance: Balance:
e lvaal Bt T ad P
Y olLimie: Wolume: Wolume: “ialime: Yol Wolurne: Yolurme:

cl e

™ Mute al [ Select ™ Select 7| Mute I b " Mue W Select

(Osprey 2000 Audio

14. Click in the checkbox to select the Mpeg Decode device, go to Options and
select Exit.

The Windows Media Encoder and the Osprey-2000 are now configured for
transcoding. The next step is to run the Decode_demo application.

To start the Decode_demo application:

1. At the system Start Menu, go to Programs -> Osprey-2000 -> DirectShow
-> Decode_demo.

£+ Dsprey-2000 MPEGZ Decode x|
T Play w— BT | = |
[ecode Output
’7 " Application Capture € Wideo Out % Window
Filename: IC:\fw_m2_25. mpg Browse |

2. Select an MPEG2 file for decoding.
3. Select Application Capture in the Decode Output field.
4. Select Load.
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5. As soon as you click Play, Decode_demo will start decoding, so be ready to
click Start on the Windows Media Encoder to start encoding.

The Windows Media Encoder window displays.

IF untitied - Windows Media Encoder - [¥ideo]
|m] Session Wiew Tools Help

Zonmcl][llR 'i Display: |Both 'i Freview Outpat: IEJZDKtDs o

Monitar

The Windows Media Encoder receives the decoded audio and video from the Osprey-
2000 board and encodes it to Windows Media format (WMV).

6. When the Decode_demo application has completed decoding the file, click Stop
to close the application.
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Chapter 8 - Osprey-2000 Video Control
Dialog

Accessing the Dialog
General Features of the Dialog

The easiest way to become familiar with the video capabilities of the Osprey-2000
cards is to run the included video viewing application VidCap32 and look at its menus
and dialogs. Chapter 10 - VidCap32, AmCap, and Included Demo Programs
focuses on the underlying video capture driver and the control dialogs that can be
accessed from VidCap32.

For information about controlling the MPEG features of the Osprey-2000, please see
Chapter 5 - MPEG Encoding and Chapter 6 - MPEG Decoding.

The Osprey-2000 video capture driver has a unified tabbed dialog for setting up all
driver parameters. There are five pages within the dialog:

The Source Page

The Format Page

The Closed Caption Page

The Logo Page

The Configuration Page

The Advanced Features Page

The SimulStream Page (described in detail in the SimulStreaming User's Guide)

The menu selections Options -> Video Source and Options -> Video Format
access the Control Dialog's Source and Format pages, respectively.

The selection Options -> Video Display accesses the Closed Caption page.

Accessing the Dialog

The normal way to access the dialog is through a menu entry or control button
belonging to the application program. For example, VidCap32 offers the following
three menu entries for accessing the dialog: Options -> Source, Options ->
Format, and Options -> Display. Once you are in the dialog, you can move to any
other page by clicking on its tab. For instance, to access the Configuration page from
an application, open the Source, Format, or Display (Closed Caption) page and
click the Configuration tab.
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For Windows NT, another way to access the Configuration page is through the
Control Panel.

Use the following command sequence:

Open the system control panel and Multimedia.
Click the Devices tab.

Open Video Capture Devices.

Highlight Osprey-2000 Video Capture Driver.
Click Properties.

Click Settings.

For Windows 2000 (only), another way to access the Configuration page is through
the Control Panel.

oA wWwNE

Use the following command sequence:

1. Open the Control Panel and double-click on System to open the System
Properties applet.

Click the Hardware tab.

Click the Device Manager button.

Open Sound, video and game controllers.

Double-click Legacy Video Capture Devices. Click the Properties tab.
Double-click Osprey-2000 Video Capture Driver.

Click the Settings button.

NoO U AW
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General Features of the Dialog

These are the common elements found on all pages of the dialog.

Source I Formatl Closed Eaptionl Logo I Advanced Featuresl Eonfigurationl SimuIStreamI
—Wideo Setting — lhpLit
|123 | Biightness
" SVideo
Img ———— |———— Contrast
. 5Dl
|12? e |———— Saturation
" DV (IEEE 1394)
|128 ——— |——— Hue

¢ Decoded MPEG

™| Eypass calor comection

— Wideo Standard

& NTSC-M " PAL-BDGHI

Riestore Previous |

Restore Defaults |

Ok I Cancel I Help |

OK

Cancel

Restore Defaults
Restore Previous
Apply to All Boards
Help

OK

The OK button exits the dialog, saving the settings you have currently chosen. If you
have made changes on two or more pages of the dialog, or for two or more boards,
all of these changes are saved.

Cancel

This button exits the dialog box without saving any changes. If you have made
changes on two or more pages of the dialog, or for two or more boards, all of these
changes are discarded.
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Restore Defaults

This button restores the settings on the current page, for the currently selected
board only, to the way they were when the Osprey software was installed.

Restore Previous

This button restores the settings on the current page, for the currently selected
board only, to the way they were at the start of the previous dialog session.

Apply to All Boards

This option displays on relevant dialog windows when more than 1 Osprey card is
installed in a system. The only dialog window tabs that can apply an operation to
multiple boards are Closed Caption and Logo. The settings for all the boards are
saved when you click OK; or all are discarded if you click Cancel.

Help

Clicking Help accesses the pages of this manual covering the currently selected tab.
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The Source Page

Source I Formatl Closed Eaptionl Logo I Advanced Featuresl Eonfigurationl SimuIStreamI
—Wideo Setting — lhpLit
|128 | Biightness %
" SVideo
Ima ———— |———— Contrast
. 5Dl

|12? e |———— Saturation

" " DV (IEEE 1394)
1248 e '— ue
I " Decoded MPEG
™| Eypass calor comection

— Wideo Standard

& NTSC-M " PAL-BDGHI

Riestore Previous |

Restore Defaults |

Ok I Cancel I Help |

Use the Source page to set the characteristics of the input video.

Input
Video Standard
Video Settings

Bypass Color Correction

Input

The Input field has buttons for the card’s Composite, S-Video, SDI and DV input
connectors.

If Preview or Overlay mode is enabled in your application, you can usually see the
results of your selection immediately without exiting the dialog. However, if you
switch between inputs that have two different signal formats, such as NTSC or PAL,
the video does not display correctly until you exit the dialog.

DV Decoding in hardware produces a decompressed video and uncompressed audio
stream that can be MPEG encoded or captured. This allows for DV->MPEG
transcoding or decompressed DV capture to feed applications. The Osprey-2000 does
not capture the DV compressed data stream to the host.
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Video Standard

Video Standard refers to whether the video signal format is NTSC or PAL. Depending
on the exact product version you have, buttons for some or all of the following
formats are displayed:

NTSC-M - North America

PAL-B, D, G, H, I - many countries in Europe and elsewhere. B, D, G, H, and I refer
to five nearly identical sub formats.

Full-sized NTSC-M and PAL-M have 525 lines total, 480 lines visible, per frame and a
display rate of 60 fields per second, or 30 interlaced frames per second.

Full-sized PAL (modes B, D, G, H, and I) has 625 lines total, 576 lines visible, per
frame and a display rate of 50 fields per second, or 25 interlaced frames per second.

The standard frame sizes are different for NTSC and PAL. For example, the half-
frame size in pixels is 320x240 for NTSC, and 384x288 for PAL. If you have selected
a standard frame size (Full, 1/2, 3/8, or 1/4), the driver automatically adjusts the
frame size to correspond to the standard. If you have created a custom size, it does
not change when you switch between NTSC and PAL.

Changes to the signal controls do not take effect until you exit the dialog.

Video Settings

These four slide controls set Brightness, Contrast, Hue, and Saturation. These
settings are stored separately for each video source.

overlay mode is enabled, so that you can immediately see the effects of

i NOTE: When using these controls, be sure that the preview mode or
your changes.

When a video source with PAL signal format is used, the Hue setting is not adjustable
and the Hue control is grayed out.

When using a digital source (SDI or DV), the Brightness, Contrast, and Saturation
settings do not affect encoded video. The Hue setting is not adjustable on SDI and
DV video sources.

Brightness/Contrast/Saturation/Hue adjustments can be applied to the analog inputs
prior to capture or encoding (hue not applicable to PAL signals). For digital inputs,
only the first three can be adjusted and only prior to capture.

The Restore Previous or Restore Defaults button can be used to restore the previous
video settings.

The circuit paths affect which of the sliders work, and whether they apply to video
before it is encoded. This drawing shows which features can be applied at what
stages in capture or encoding:
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Bypass Color Correction

This checkbox applies to digital video sources, only.

Check Bypass color correction to turn off all saturation, contrast, and brightness
conversion in hardware and pass digital video data directly to the host. This is most
useful for the SDI, DV and decoded MPEG input sources.
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The Format Page

Osprey-2000 DY Pro Yideo Capture Driver, ¥ersion 2.10 ed B4

Source  Format |Closed Eaptionl Logo I Advanced Featuresl Eonfigurationl SimuIStreamI

— Calor Farmat——————  — Propartions

& Standard
IHgb15 'l

£ CCIRBEOT

I Enable Cropping

—Wideo Size————— [~ Custom Size
 Ful 320 width
LI ] i
2R ViewCast
(‘ 3'?]8 CORPORATION
1 I Lock Ratio
" Custem Restore Previous |

Ok | Cancel I Help |

Use the Format page to set the color format and size of the image.
Color Format

Video Size

Custom Size

Proportions (Pixel Aspect Ratio)

Cropping and Scaling (please see the CropApp Manual for detailed instructions
on using this feature)

Source  Format |Closed Captionl Logo I Advanced Featuresl Configurationl SimuIStreamI
— Color Format———— Froportions
& Standard
IFIgb15 'l
 CCIREOT
¥ Enable Crapping
Source  Cropped  Left Output
Size Size Top Size
Harizontal |E4D |320 |n |3zu ViewCast
CORPORATION
Verlical |4ED |24D |n |24u
Restore Previous |
Ok | Cancel I Help |
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Color Format

The Color Format is the arrangement of data bits representing the colors of each
pixel. For example, in the RGB15 format, each pixel of data is stored as 5 bits of red,
5 bits of green, and 5 bits of blue color information.

Video delivered by the Osprey board to the system is in uncompressed format. It is
possible to compress the video at a subsequent stage of processing. However, this
dialog field refers specifically to the uncompressed raw video that the board delivers
to the system.

The color format you choose applies to Captured video and to Preview video. It does
not apply to Overlay video. Overlay video is always matched to the display adapter’s
current screen format - except when grayscale mode is selected. Overlay video is
therefore as fast and efficient as possible, but the color rendering may differ very
slightly from what you capture. Preview mode renders colors exactly, but it is slower
and consumes more system resources.

Color-Space Conversion can be applied in hardware before video is captured to the
host. Supported color formats are RGB (32/24/16/15) YUV (4:2:2 packed or planar
YVU9/YUV12) and grayscale (Y).

The Osprey-2000 supports both 4:2:0 and 4:2:2 color formats. YUV12 and 1420 are
examples of 4:2:0 color formats. 422packed is an example of 4:2:2 color format.

Changes to Color Format take effect only after you exit the dialog.

For a more detailed description of the color modes available, refer to Appendix B -
Color Modes.

Video Size

The Video Size field allows you to select between the various sizes given in the
following chart. Changes made to Video Size take effect only after you exit the
dialog.

Size Width x Height Also known as:
Full 640 x 480 X

1/2 320 x 240 CIF/SIF

3/8 240 x 180 X

1/4 160 x 120 QCIF/QSIF

The width and height shown are in pixels for the North American NTSC-M video
format in the square (standard) aspect ratio. For further details, refer to Appendix C
- Video Sizes.

There is a fifth button, Custom, that becomes selected whenever a non-standard
size is entered in the Custom Size field. See Proportion (Pixel Aspect Ratio) for
more detailed information.
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Custom Size

The Custom Size field allows you to set customized width and height values different
from the standard preset values of full, 1/2, 3/8, and 1/4.

If the Fixed Ratio box is checked, when you enter a new size in either the height or
width box, both dimensions are adjusted proportionately. If this box is unchecked,
the height and width may be entered independently. If the dimensions are different
from normal screen proportions, the image may appear stretched horizontally or
vertically.

The Osprey video hardware is not capable of drawing all possible widths. Depending
on the color mode selected, it may require a width that is an even number of pixels
or, for YVU9 and YUV12, a width that is a multiple of 16. The dialog lets you enter
numbers that the hardware cannot utilize, but adjusts them as soon as you click on
another field or button of the dialog.

See Proportion (Pixel/Aspect Ratio) for more detailed information.

Proportion (Pixel Aspect Ratio)

This dialog allows you to select between Standard (also called a Square aspect ratio)
and the CCIR601 aspect ratio.

The maximum resolution of the CCIR601 mode is 720 pixels for both NTSC and PAL.
The Standard/Square aspect ratio mode has a maximum resolution of 640 pixels for
NTSC and 768 pixels for PAL. However, the inputs to the Osprey-2000 all operate in
the CCIR601 mode. The Osprey-2000 can scale down to the square aspect ratio for
NTSC but not scale up to the square aspect ratio for PAL.

Since the sources are processed in a CCIR601 format, the full 768 pixels of the
standard/square aspect ratio mode of PAL is not available. Only 720 maximum pixels
are available. If the standard/square aspect ratio mode is selected for PAL, the
Osprey-2000 drivers will limit the maximum resolution to only 720 pixels.

Also, many digital sources provide only 704 true pixels and not 720 pixels per line.
Because of this, the Osprey-2000 scales down from 704 pixels (i.e., a crop of 720 to
704) to the desired size. If 720 pixels are desired, for example, the result is an
unscaled 720 pixels in width. If 704 pixels are desired, the result is an unscaled 704
pixels in width. If 352 pixels are desired, the result is a scaling from 704 down to
352 pixels in width (and not 720 down to 352).
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Cropping and Scaling

The Osprey-2000 driver package includes the capability to crop the incoming video
signal in hardware before it is encoded or captured. Cropping is done by the Osprey
card and imposes no extra load on the host computer. Use any of the following
methods to crop the incoming video signal:

Video Format dialog box
CropApp, the cropping application
SDK

Please see the CropApp Manual which is installed in the Osprey-2000 Program group
for details on using this feature. Note that scaling down can be applied in hardware
to any video source before capture. The MPEG encoding processing can also scale
input video sources providing for a range of MPEG encoding resolutions.

The Closed Caption Page

Dsprey-2000 DY Pro Yideo Capture Driver, ¥Yersi 2]
Source I Format  Closed Caption I Logo I Advanced Features I Configuration I SimulStream I
— Digplay on Screen—  —~ Save to File
v Enable [ Enable v #pply changes to
) all boards rather
& OverVideo Eym—y than just the one
@ IC' temphoc. et cumently selected
Browse |
— Made
% Video
© Tem \
ViewCast
CORPORATION
— Channel — Text Color
o el 15
ez Restore Defaults |
Ok I Cancel I Help |
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Use the Closed Caption page to enable or disable Closed Captioning and to control its
characteristics.

Display on Screen
Save to File

Mode

Channel

Text Color

Field

Apply to All Boards

Closed Captioning is a method of encoding and displaying text such as movie dialog
captions or stock quotes as part of NTSC video. The text is similar to movie subtitles
in appearance. Closed Captioning is widely available on broadcast video, cable,
videotapes, and videodisks.

The Osprey-2000 video driver provides a complete implementation of the Closed
Captioning standard and special extensions that are made possible by the capabilities
of a PC. At the moment, the Osprey-2000 only provides support for Closed
Captioning on the analog video inputs. (For more information, see No Closed
Captions on Digital Video in Chapter 11.)

You can use Closed Captioning whenever the following conditions are met:

¢ You must be viewing a videotape, videodisc, or broadcast material that has
Closed Captioning content. Look for a small CC logo on the packaging or in
the program listing.
Closed Captioning is for North American NTSC video only, not for PAL video.

Closed Captioning must be enabled in the Osprey driver, using the Closed
Caption dialog page.

+ Video Mode and 1 must normally be selected. You might use Text Mode or
Channel 2 in specialized instances.

+ In addition to the normal options of viewing or capturing Closed Captioning,
you have the special capabilities to save the text to file as you view or
capture it.

Display on Screen

The Enable checkbox enables display of Closed Captioning on the screen if it is
checked and disables it if it is unchecked. Closed Captioning currently only is enabled
for analog (Composite/S-Video inputs).

If you check or uncheck the Enable checkbox while Overlay or Capture mode is in
effect, the change does not take effect until Overlay or Capture is stopped and
restarted.

122 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 8 - Osprey-2000 Video Control Dialog

It is recommended that you disable Closed Captioning when using non-Closed
Captioned video. If you leave Closed Captioning enabled, the software attempts to
interpret regular video as Closed Captioning character codes, and may sometimes
display spurious characters. It also slightly increases the driver’'s CPU usage.

The normal display mode is Over Video. In this mode, the Closed Captioning is
superimposed on the video field.

The Own Window option is a special proprietary mode for Closed Caption display. A
separate window appears, and the text scrolls up in this window instead of appearing
on the video field. This window disappears while you are capturing video and
reappears after capturing video. This mode may be useful for some kinds of material,
as the lines of text are not erased as quickly. The Own Window option, however,
does not fully conform to Closed Caption standards, especially with regard to line
placement. It may therefore give undesirable results with some kinds of highly
formatted captions.

Save to File

A nice feature of Closed Captioning on a PC is that you can save the captions to a file
for later review. The Save to File field contains three controls:

1. If checked, the Enable checkbox enables saving to a file.
The Edit Box allows you to designate a file in which the captions will be saved.
3. The Browse button accesses a standard system dialog for locating a directory
and file in which the captions will be saved. When you choose a file that already
exists (either by entering the file name or using the Browse button), new
captions are appended to whatever was previously in the file.
You may enable saving to a file without enabling display of Closed Captioning on the
screen; the two checkboxes are independent.

Mode

Video is the normal Closed Captioning display mode used with almost all videos and
broadcast TV. Text is a specialized mode in which the entire 32 character by 15 row
Closed Captioning area of the screen is blanked and used to display text. Use Video
mode unless you know specifically that the material is Text mode.
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Channel

Channel 1 is the channel normally used in almost all Closed Captioning. Some
specialized material may use Channel 2.

Note that with most material, if you select Channel 2, you won’t see any
Closed Captions.

Text Color

Select the color in which you want the closed captioned text to display.

Field

Field 1 is the even field of interlaced video, Field 2 the odd field. Field 1 is usually the
only field that contains Closed Captioning.

Apply to All Boards

This option displays on relevant dialog windows when more than 1 Osprey card is
installed in a system. The only dialog window tabs that can apply an operation to
multiple boards are Closed Caption and Logo. The settings for all the boards are
saved when you click OK; or all are discarded if you click Cancel.
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The Configuration Page

The Configuration page controls several miscellaneous settings.

Sourcel Formatl Closed Eaptionl Logo I Advanced Features  Configuration | SimuIStreamI
— Owverlays — Default Capture Device
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% Prevent access to dialog's
farmat tab via zource dialog
[default - maximum compatibility]

 Allow this access
[mazimum flexibility]

Ok Cancel Help

Overlays
Access to Format Tab
Multiple Opens

Default Capture Device

Overlays

Direct Draw is a fast drawing method that moves video directly from the Osprey
capture card to the display adapter. If Use Direct Draw is selected, the driver uses
Direct Draw for Overlay drawing. If for some reason it cannot use Direct Draw, it
automatically defaults to DibDraw.

Direct Draw works with the vast majority of display adapters and software driver. We
recommend running with Direct Draw enabled unless you are having a problem
viewing overlay video, or want to use the doubled lines option discussed below. For
more details on Direct Draw, refer to Appendix E - Direct Draw.
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DibDraw is the default drawing method. Video is moved first into system memory
and copied to the display adapter. It is useful in the following cases:

1. For systems where Direct Draw does not work correctly.

2. If you want to enable line doubling. When DibDraw is selected, two radio
buttons are enabled that let you choose between interlaced and line-doubled
video.

Normally, video larger than 2-height (240 lines NTSC, 288 lines PAL) is interlaced.
NTSC and PAL video both consist of alternating odd and even fields of data. Odd
numbered lines come from the odd fields, even numbered lines come from the even
fields.

Interlaced video offers maximum resolution but suffers from a comb effect. When
there is rapid motion in the video, it appears blurred. It is recommended for still or
slow-motion video, but may not look good with high-motion content.

Line-doubled video uses video data from only one field. Each video line is copied to
two lines of your display. Line-doubling reduces the still-picture resolution by half;
however, it eliminates the comb effect of interlaced video and is therefore useful for
viewing rapid-motion video.

3. If you want to stretch the video on your screen beyond full size (640x480
NTSC, 768x576 PAL), you would need a special application to do this. DibDraw
video can be stretched but Direct Draw video cannot be.

Access to the Format Tab

The two options are:

+ Prevent access to a dialog’s format tab via source dialog
+ Allow this access

Video for Windows applications access the Source and Format pages as separate
commands and do not assume that the driver allows you to switch from one to the
other.

Some applications, when they access the Source page, do not check to see if you
also made changes to items in the Format page. The result is that the application
and the driver may assume different settings and not work properly together.

This control in its default prevent access setting prevents you from entering the
Source page or Closed Caption page, switching to the Format page, and
inadvertently making changes that the application cannot pick up. It also disables
the Board Select control on the Source and Closed Caption pages since the driver
maintains separate format information for different boards. The prevent access
setting is recommended for maximum compatibility with all applications.

The prevent access setting is, however, inconvenient. The alternative setting to allow
this access allows you to switch between pages without restriction. This works with
many applications; however, the responsibility lies with you to make sure no
problems arise.
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Multiple Opens

We recommend keeping this box checked unless you have a reason not to. This
ensures compatibility with the greatest number of present and future applications
that you might want to use.

If Multiple Opens is checked, a particular board can be opened for access from
multiple places, either within a single process or by multiple processes. However, the
features available through subsequent opens are limited. This mode is needed by
certain complex applications that, for example, use separate processes for capture
and overlay.

If Multiple Opens is unchecked (hunt mode), a particular board can be opened for
access from only one place in one process. If there are multiple boards in the
system, and an application tries to access a board that is already in use, the driver
hunts for the next available board. This is the easiest way to start multiple copies of
Windows Media Encoder or VidCap32, for example, to view multiple video inputs.

Changes you make take effect when you click OK to close the dialog. Applications
such as VidCap32 do not pick up changes until you restart them.

Review Appendix F - Multiboard Installations for more information.

Default Capture Device

This control is useful if you have multiple video capture devices of different kinds.
These could include cards from other vendors or different kinds of capture cards from
Osprey. In this context, the Osprey-50, -100, -101, and -200 are considered one
single device type. The Osprey-500, the Osprey-1000, and the Osprey-2000 are each
separate device types.

Some applications are capable of accessing only the primary or default device. With
this control, you can select which device will be the default device such an
application will use.

Changes you make are written to the registry when you click OK to close the dialog.
Applications such as VidCap32 will not pick up changes until you restart them. Some
DirectX-based applications may not detect changes until you restart the system.
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The Logo Page

g VidCap M=] E3
File Edit Options Capture Help

g VidCap

File Edt Option: Capture Help

The Osprey Video Capture Driver allows you to superimpose a logo on captured
video, as in the images above. The VCST logos shown illustrate some of the features
for color keying and translucency that are described in this section.

Use the setup dialog’s Logo page to set up a logo. The logo page is actually a

sequence of five pages that guide you through the steps of creating a logo and
placing it on the video.
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You cannot access the Logo page directly from most applications. Instead, open the
Source or Format page of the dialog, then click on the Logo tab.

Capabilities

Step O - Before You Start

Step 1 - Creating and Enabling the Logo
Step 2 - Selecting the Logo File

Step 3 - Setting Key Color and Style

Step 4 - Positioning the Logo

Step 5 - Reviewing and Saving the Changes

Notes on Logos

Capabilities

A logo can be any artwork that is formatted as a 24-bit BMP file. Typically, a logo is a
small graphic that is placed at the lower left of the image. In a technical application,
however, a logo could be a crosshair pattern placed at the center of the image. The
logo can theoretically be any size. However, the CPU must actively draw the image
on every frame of video, and drawing a very large image, even if it is mostly
transparent, degrades overall performance in high-throughput applications.

The driver can draw a logo on captured or streaming video, on preview video, or on
DibDraw overlays. However, the driver cannot draw a logo on DirectDraw overlays. If
you attempt to draw a logo on DirectDraw overlays, everything appears to work fine,
except that the logo is not visible.

A logo’s rectangle can be partially transparent so that the underlying video is visible.
The transparent areas are defined by a Key Color - a particular (red, green, blue)
value that is specially interpreted by the driver. For example, the sample logos use
cyan with red, green and blue values of (0, 128, 128) as the key color.

A logo displays in either of two styles — normal and embossed. In normal style, the
logo’s non-transparent pixels simply replace whatever video underlies it. In
embossed or translucent style, the logo's non-transparent pixels are averaged with
the underlying video pixels, resulting in a more subtle effect.
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For detailed instructions on setting up a logo, review the following steps:
Step O - Before You Start

Step 1 - Creating and Enabling the Logo

Step 2 - Selecting the Logo File

Step 3 - Setting Key Color and Style

Step 4 - Positioning the Logo

Step 5 - Reviewing and Saving the Changes

Notes on Logos

Step 0 - Before You Start

Create your artwork with the Windows Paint application or any other paint program
that you like to use. Save it in 24-bit BMP format.

Before creating your own logo, however, you may want to experiment with the
samples supplied with the driver. They are located in the Osprey program directory,
by default \Program Files\ Osprey-2000\Nt on the default drive.

Have Preview or DibDraw Overlay mode running when you enter the dialog to see
immediately the results of interactively defining and placing the logo. DirectDraw
Overlay mode does not work for this purpose. To change from DirectDraw to
DibDraw,- or to find out which one you are currently using — go to the dialog’s
Configuration tab, then stop and restart Overlay mode.
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Step 1 - Creating and Enabling the Logo

Additional links:
The Logo Page
Capabilities

The logo setup pages include detailed explanations at each step. The first page
handles only one consideration — whether or not logo drawing is enabled.

Osprey-2000 DY Pro Yideo Capture Driver, ¥ersion ed B4

Sourcel Formatl Closed Caption  Logo |Advanced Featuresl Eonfigurationl SimuIStreamI

— Stark

Fallaw theze steps to add a logo to captured videa.

The logo will be dizplayed on captured video, on
previewed video, and on overlay (on-screen] video when
DibDraw iz selected. |t wil not be visible on DirectDiraw
averlay video.

Befare pou start, set videa to either Preview or DibDiraw,

not to DirectDraw. You will then be able to interactively "\

place the logo on the video display. v-
iewCast
After the logo iz set up, set overlay video to DirectDiraw CORPORATION

mode far maximurn efficiency in capture and streaming.

<GBiey. | Mext »» I

Ok | Cancel I Help |

By default, the Enable box is not checked and therefore no logo displays. In this
case, when you click Next>> you go directly to the last page (Page 5 - Reviewing
and Saving the Changes) of the logo setup sequence.

If the Enable box is checked, you can click Next>> to step through all of the pages
of the setup sequence.
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Osprey-2000 D¥ Pro Yideo Capture Driver, ¥ersion 2.10 2]

Sourcel Formatl Closed Caption  Logo |Advanced Featuresl Eonfigurationl SimuIStreamI

— Bitrap File

|
Browse... |

Prepare vour logo in .BMP format. Use the Windows
Paint acceszory or any similar program.

MOTE: Save the bitmap in 24-BIT format.

There are zample bitmaps icons in the driver's Pragrani
Filez directory. Experiment with these to understand the viewca St

color keying options described on the next page. CORPORATION

Mext »> I

Ok | Cancel Help

Step 2 - Selecting the Logo File

Additional links:
The Logo Page
Capabilities

This screen should be self-explanatory. You are selecting a BMP file, either your own
artwork or one of the samples. You can type in the full pathname to the file or
browse for it. When you have selected the file, click Next>>.

The sample logos are located in the Osprey program directory, by default \Program
Files\Osprey-2000\Nt on the default drive.

Logo Bitmap File e |
Loak in: i {3 Osprey-2000 j - £k B3~
|_ 1 Directshaw
T
_10P1 SDK
_Jucode
ﬁVCLogo.bmp
westl, bmp
g\-'cstz.bmp
File hame: '-.-"I:ZL|:..:||:|. biriip L‘ Open I
Files of tppe: Ibmp files ;! Cancel |
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Step 3 - Setting Key Color and Style

Additional links:

The Logo Page

Capabilities
Sourcel Formatl Closed Caption  Logo |Advanced Featuresl Eonfigurationl SimuIStreamI
— Ky Calar
|_ MHone Dark Grey (128, 128, 128)
Cyan [ 0,128,128
Magenta [255, 0, 255)
Grey [192,192,192)

Fixelz of the logo rectangle that are the color selected
above are ransparent. o that the underlying videa is
wizgible thraugh that part of the logo. The key colar in your
logo must have the exact red/green/blue values of one of
the colors listed above.

— Embossed Vi ewca st

CORPORATION

The active pixel: of the logo are averaged
[~ Enable  with the underlying wideo. The result iz a
translucent, "embossed" effect.

Mext »> I

Ok | Cancel I Help |

As previously noted, a key color is a (red, green, blue) color value that the driver
treats specially. Logo pixels in that color do not display; the underlying video
appears instead. This dialog sheet lets you choose one of four fixed key colors, or no
key color. If you select None for the key color, all pixels from the logo display
including all pixels in any of the key colors.

A key color must be a precise (red, green, blue) value. For example, if cyan is
selected as a key color the pixel values must be exactly (0, 128, 128). A pixel of
value (0, 127, 127) does not display transparent - it displays as cyan.

All four key colors are standard stock colors in Windows Paint.

If the Embossed box is checked, each pixel color value displayed is the average of
the pixel value of the logo and the pixel value of the underlying video. If Embossed
is not checked, the pixel color value is simply the value from the logo.

The key color setting takes precedence over the Embossed setting; that is, logo
pixels in the key color are transparent, not averaged, even in Embossed style.
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Step 4 - Positioning the Logo

Additional links:

The Logo Page

Capabilities
Osprey-2000 DY Pro Yideo Capture Driver, ¥ersion 2 ed B4
Source I Format I Closed Caption  Logo | Advanced Features I Configuration I SimulStream I
— Pazition —Mudge
ul
S
o
ViewCast
CORPORATION
Drrag the logo to the desired position. Use the Mudge
buttons to make exact adjustments.
Mext »> I

Ok | Cancel I Help |

The Position control allows you to position the logo by dragging it with the mouse.
The Nudge controls move the logo up, down, left or right one pixel at a time. They
permit more precise adjustments than the Position control can achieve.

If Preview or DibDraw Overlay video is running, the logo moves on the video as you
move it in the dialog.

If you position the logo in a certain way and then change the video size, the driver
stretches the logo to maintain the same relative size, and places it in the same
relative position. The stretched artwork may have jagged diagonal edges and not
look as good as the previous artwork prepared with the intended video size in mind.
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Step 5 - Reviewing and Saving the Changes

Additional links:
The Logo Page

Capabilities

Osprey-2000 DY Pro Yideo Capture Driver, ¥ersior 2]

Sourcel Formatl Closed Caption  Lege | Advanced Features Eonfigurationl SimuIStreamI

—End

Here iz a summary of your curent logo settings:

Logo enabled.
File:

[:\Program FileshOzprey-20008M T4West] . brp
F.ey color: none
Style: embozzed
Size: 20 pivelz high % 67 pirels wide
Position: 132 pixels from top, 193 pixels from left

: _ _ ViewCast
If you check this button, pour changes will be applied to CORPORATION
all boards rather than just to the currently selected
board.
4< Prev I flewt > I
Ok | Cancel I Help |

This page shows a text summary of the current logo configuration.

If you have multiple boards in the system, a checkbox entitled Apply to All Boards
is shown. If you check this box, the logo changes you make to the current board are
made to all the boards in the system.

If you have multiple boards in the system and the only change you make
is to enable or disable logos, clicking OK with Apply to All Boards checked
changes the enable/disable status of all boards but doesn't change any of
the other settings. If, however, you make any logo changes other than
enable or disable, Apply to All Boards copies the entire current
configuration to all boards.

Notes on Logos

If you set up a logo with video set to one size, then resize video, the logo is scaled
correspondingly. For example, if the logo is originally set up for 320x 240 video, and

you change to 640 x 480 video, the logo displays at twice the size of the original
bitmap.
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1. If you edit the logo settings while the logo is scaled up or down, an additional
option entitled Rescale displays after Enable.

Osprey-2000 D¥ Pro Yideo Capture Driver, Yersion 2 2]

Sourcel Formatl Closed Caption  Logo |Advanced Features Eonfigurationl SimuIStreamI

— Rescale

Fescale |

“r'ou have changed video size zince zetting up the logo,
and the loga has been zcaled to the new video size.

Click thiz button to reset the logo to the unscaled size of
the original logo bitmap.

S\
ViewCast
CORPORATION
Mext »» I
Ok | Cancel I Help |

If you click the Rescale button on this page, the logo is resized to the same size as
the original source bitmap.

If you do not click the Rescale button, you can edit the logo settings using the
scaled logo. Even if you change to another bitmap image, the old scaling is
maintained.

2. The driver can display color logos on YUV video - 4:2:2 packed, YUV12 planar,
and YVU9 planar. The appearance may not be quite the same as the RGB
version, however.

3. Detail of colored features may not be as crisp, because in the YUV modes color
is not sampled at full pixel resolution.

DibDraw Overlay video is always RGB even when you have selected a YUV
color format in the dialog. Preview video is always in the exact YUV or

& RGB format you have selected. Therefore, when using a YUV mode be
sure to check the appearance of the logo in Preview mode before putting
it to use.

4. When Grey8 video format is selected, all logos including color logos are
displayed in gray scale.
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The Advanced Features Page

Select a link below the screen for more information.

Osprey-2000 DY Pro Yideo Capture Driver, ¥ersion ed B4

Sourcel Formatl Closed Eaptionl Logo Advanced Features | Eonfigurationl SimuIStreamI
r— Field Order
€ Force odd-even

 Force even-odd

% Allaw Either
— Deinterlacing
™ Software filter
ViewCast
CORPORATION
r Transfer mode
© Odd/Even
Restore Defaults |

Ok I Cancel I Help |

Field Order
De-Interlacing

The Transfer Mode

Field Order

The Osprey-2000 allows you to configure which pairing of fields will be used to
construct a frame. For interlaced capture devices (most current video cameras) the
field order does not matter and the 'Allow Either' setting will provide better
performance in VFW preview mode. The default setting for this feature is 'Allow
Either'. Use the force odd-even or force even-odd settings with a progressive scan
camera. Consult your camera's technical documentation for the correct setting to
use. Using the correct setting with a progressive scan camera will eliminate comb-
like interlacing artifacts.
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De-Interlacing

Most video is provided for viewing in an interlaced format. For simplicity, NTSC is
used in the following explanation of an interlaced format. NTSC video is basically
composed of images taken 60 times a second. Each image is called a field, and there
are odd and even fields. While these odd and even fields are temporarily adjacent to
each other in time, the horizontal lines that make up these fields are spatially
different.

Odd Field EwvenField
- - - - P P
e —————— [

The figure above is a simplistic view of interlaced video and fields. The two fields are
taken 1/60th of a second apart, and the lines of each field are not aligned, but
staggered. Most televisions are interlace display devices, where the 60 fields are
displayed individually and the viewer sees only one field at a time. However, most
computer monitors are progressive and not interlaced display devices. On a
computer monitor where video is viewed at its full resolution, viewers see both the
odd and even fields at once:

O dd/E wven

Lities from
the O dd Field

Lines from the
E-en Field

The problem with progressive display devices is that if an object is moving, its
position is not the same in both the odd and even fields. When odd and even fields
are merged together, interlaced artifacts occurs. The artifacts are seen and
commonly described as streaking or feathering.
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& VidCap M=

Fi= Edit Options Zapturs Eelp

e e el B )

The screen above illustrates the streaking or feathering problem that occurred when
the interlaced odd and even fields in this video were captured. Only a slight amount
of motion took place, yet streaking is obvious in the overall result. Note the
prominent horizontal lines outlining all the objects on this screen.

When feeding such images to an encoder, the encoder has a significantly harder time
processing and compressing such interlaced video. The result is loss of overall quality
and perhaps a loss of frame rate as well. While the encoding process may smooth
out some of these artifacts, the resultant compressed video may still display
somewhat streaked or feathered and may not play back smoothly.
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i VidCap M= E3
Fi= Edit Options Zapturs Eelp

e e el P )

The Osprey-2000's software de-interlacing motion filter can be applied to any video
source after the optional scale and color-convert phases of processing to eliminate
streaking or feathering and maintain motion content. In the screen above, where the
Osprey-2000’'s de-interlace motion filter has been turned on, note that the strong
horizontal streaking or feathering around the subject’s head have been smoothed to
a slight blur. While the blur is noticeable in a single screen snapshot, the human eye
perceives only natural motion when the video is played back at normal frame rates.

Feeding the de-interlaced image in the screen above to an encoder significantly
improves output of the encoder in terms of overall quality and smoothness. The
encoder has an easier time compressing the de-interlaced video and thus can expend
saved bits and CPU cycles to produce higher quality streams.

De-interlacing is optimized for Windows 2000 and above; it will consume fractionally
more CPU cycles when enabled under Windows NT.

The Transfer Mode

The Osprey-2000 captures video data to the host or to the display device via two
different transfer modes. The first mode, Odd/Even, transfers video such that the
odd lines of video are grouped together before the even lines. If the video source
was interlaced to start with and the hardware de-interlacing filter was not applied,
the Odd/Even mode basically places the odd field on top of the even field. If the de-
interlacing filter was applied (see description further down), this mode places the odd
lines of the resultant de-interlaced frame before the even ones. The Odd/Even
transfer mode only occurs when the resolution is greater than half the maximum
resolution (>240 for NTSC and >288 for PAL).
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The second mode, Interleaved, transfers video vertically in line order. For example,
line 1, line 2, line 3, etc. Basically, this is an interlaced mode. However, since the
video source may have been progressive to start with, or because the de-interlacing
filter may have been applied, the term ‘interlaced’ transfer mode is inappropriate.

The following images further describe the Odd/Even and Interleaved transfer modes:

1 VidCap M= E3
Fi= Edit Options Zapturs  Eelp

e e e 5
T

The first image is a snapshot of video captured using the Interleaved transfer mode.
The source is an interlaced DV camera, and the image size is 640x480.

) VidCap =

Fi= Edit Options Zapturs EFelp

e O el B

.....
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The second image is a snapshot of video captured using the Odd/Even transfer
mode. The source is an interlaced DV camera, and the image size is 640x480.

f#: YidCap =]

File Edit Options Capture Help

The third image is a snapshot of video captured using the Odd/Even transfer mode.
The source is an interlaced DV camera, and the image size is 320x480. This mode of
capture can be used to acquire video at 60 fields/sec. The Osprey-2000 already
horizontally scaled the video down to 320 pixels in width in hardware. Having the 60
fields/sec delivered 30 times a second in the format given here offers the advantage

of keeping the odd/even pairing of video consistent in the case of capture loss due to
performance of the application.
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The SimulStream Page

SimulStream is an added-cost upgrade option described in detail in the
SimulStreaming User's Guide - Revision 1.1.

Osprey-2000 DY Pro Yideo Capture Driver, ¥ersion 2. |

Sourcel Formatl Clozed Eaptionl Logo I Advanced Featuresl Configuration  Simul3tream |

E¥ w2

SimulStream is & purchasable option for Dsprey boards, Refer to
the SimulStream Users' Guide for a description of capabilities.

= fultiple Dpet:
¥ | il mnltinle apens of each boand \
[required far, SimulStreann] . \
ViewCast
Frefered Copy Mode: CORPORATION

& Copy-avoid [default - uges minimum CEU]

| Copy-prefer [copies identical data to multiple streams]

Ok Cancel Help

Cropping and Scaling

The Osprey video capture driver package includes the capability to crop the incoming
video signal in hardware before it is encoded or captured. Cropping is done by the
Osprey card and imposes no extra load on the host computer. Use any of the
following methods to crop the incoming video signal:

Video Format dialog box
CropApp, the cropping application
SDK

Please see the CropApp Manual which is installed in the Osprey 2000 Program group
for details on using this feature.
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Chapter 9 - Capturing Audio

Setup and control for audio are much simpler than for video. The basic steps are
covered in the following topics:

Selecting the Audio Source and Input Volume
Registry Settings Controlling Other Audio Parameters
Audio Formats

Missing Digital Audio Sources

Audio Playback

Note for DV users:

The Osprey-2000 is capable of converting sampling rates from a higher sampling
rate to a lower sampling rate. For instance, if you set your DV audio to 48 KHz, the
card can provide all common sampling rates (48 KHz, 44.1 KHz, 32 KHz, 22 KHz, 16
KHz, 11 KHz, 8 KHz).

However, if your DV audio is set to 32 KHz, the card can only convert to lower
sampling rates. Therefore, 48 KHz and 44.1 KHz are not supported if the DV audio is
set to 32 KHz.

Note for DVD users playing CD audio:

If you are playing a CD in a DVD player, the Osprey-2000 will be able to capture at
all sampling rates except 48 KHz. This is because the Osprey-2000 cannot convert
audio from a lower sampling rate to a higher sampling rate. The Osprey-2000
converts stereo audio to mono audio by summing the left and right channels and
dividing by 2 (conversion is (L+R)/2).

The Osprey-2000 converts stereo audio to mono audio by summing the left and right
channels and dividing by 2 (conversion is (L+R)/2).

Selecting the Audio Source and Input
Volume

The audio source is set using the Osprey-2000’s mixer driver interface. Most
applications, including the Windows Media Encoder applications, interface to the
mixer driver directly and expose the look and feel specific to that application.
However, the default Windows interface to the mixer driver can also be used. There
are two simple methods for getting to the mixer source and volume control dialog
box.
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0 Professional
copt, Build 2185

Open Yolume Controls
Adjust Audio Properties

N 26 PM

An easy method for accessing this interface is to right click the speaker symbol on
your taskbar (typically on the bottom right-hand side of your screen) and select the
Open Volume Controls option.

If you do not see the speaker symbol, click the Start button on the Start Menu,
select Programs->Accessories->Entertainment(or Multimedia) and select
Volume Control.

Either action brings forth the audio mixer interface for the audio play back device.

To locate the Osprey-2000 audio capture (recording) device, select Properties
under the Options menu. This pops up a dialog to select the Mixer device.

Properties il 21x]
Mimer device: |4, real Audio j
st el 2000 Audio

¢ Playback
" Recording
" Other I.-’-'«EEI? Cantrals j

Show the following volume controls:

Yalume Cantral -
Wi ave
Wavetable Synthesizer

] Phaone -
1| | 5
2k, I Cancel |

Do not select the Recording option within the Adjust Volume for section. Click the
dropdown list for Mixer device to see the list of audio input and output devices,
including the Osprey-2000.

If more than one Osprey-2000 card is in the system, eachOsprey-2000 card is
enumerated individually. Once an Osprey-2000 device has been chosen, select OK in
the Properties dialog box. Then, select Properties on the Options menu again. A
dialog displays. Select Recording and click OK.
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Properties 7| x|

Mixer device: | 0eprey 2000 Audio |

— &djust valume for

" Playback

Show the following wolume controls:

Recard Contral -
IInbalanced
#LA Balanced

=LA AES/EBU -
1 | »
k. I Cancel |

The Osprey-2000 Record Control panel appears.

EE FRecord Control [ =] =]
Options  Help

Fecord Contral | Unbalanced LR Balanced | xLR AES/EEBU | SDI D [1394] tpeg Decode
Balance: Balance: Balance: B alance: Balance: Balance: Balance:
C-F B DL B-FE B-FD D-fd B
Wolume: Yolurne: “olume: Yolurne: “olume: Yolurne: Wolurne:

R

T B 1 It T R I I et
TI = 2t hTLs B [ e et

™ Mute I Select ™ Select I Select ™ Select ™ Select
| Dsprey 2000 Audia

The Select checkbox at the bottom of each source sets which source is actually
being used. DV audio signals are embedded in DV video signals. If you select SDI or
DV audio, the video Signal selection for PAL/NTSC must match the type of the SDI or
DV source.

The Osprey-2000 device is not a mixer in that it does not allow for mixing
& the various audio sources. Therefore, when one audio input is selected,
any previously selected input is unselected.

When you are capturing audio, the vertical field in the Record Control Volume section
will light up with green, yellow, and red bars (like sound meters on home audio
equipment).

The Osprey-2000 card has a hardware gain on the analog audio inputs. To control
the hardware gain for the card, use the volume slider in the mixer applet. The
Osprey-2000 card has a software gain control on the digital audio inputs. For
instructions on changing the software gain (for digital sources only), refer to Gain
Selection. Gain does not apply to MPEG encoding for the digital audio inputs.
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The quick-access volume control on the task bar (left click on the speaker
& symbol) controls playback volume and recording volume. To change
record levels, go to Options -> Properties -> Recording.

It is necessary to set the Osprey-2000 as the preferred recording device before you
capture or encode audio.

0 Professional

Open Yolume Controls copy., Build 2155

Adjust Audio Properties

N 26 PM

Right-click the speaker symbol on your taskbar (typically on the bottom right-hand
side of your screen) and select the Adjust Audio Properties option.

Sounds and Multimedia Properkies 2=

Sounds Audio I Hardware ]

— Sound Plavback

'@’\j Erefemed devics:
[ =]

Yolume | .ﬁ.gvancedl

— Sound Becording

Frefemed device:

| Osprey 2000 Audio [

Yolume | .ﬁ.dvaﬂcedl

— MID| Muzic Plavback

Frefemed device:

vl i.ﬂ.ureal ' awetable j

Yiolume | Aot |

IV Use only prefered devices

| (] I Cancel | Apply |

If you are using Windows 2000, click the Audio tab. If you are using Windows NT
you do not need to choose among tabs in this applet.

Use the dropdown lists to select the Osprey-2000 card as the preferred Recording
device, and your sound card as the preferred Playback device.

Click in the Use preferred devices only checkbox to select it.
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& You must set the Use preferred devices only option in Step 8.

When you decode (or play) MPEG, the Osprey-2000's audio input port is set to 'MPEG
Decode'. If you want to later capture audio from another audio source, be sure to
remember to bring up the Record Control mixer and select the desired audio input
port. If '"MPEG Decode' is selected while you are trying to capture audio or
audio/video, and you are not currently decoding MPEG, you will not get any captured
audio data and this can have various side effects in capture applications (such as the
application stopping with a complaint about no audio data present, or very slow
video frame rates)." See My video/audio capture has a very low frame rate
and no audio for more details.

Registry Settings Controlling other Audio
Parameters

The Osprey-2000 mixer applet does not provide a mechanism for setting all of the
audio capabilities. Entries in the registry control include:

Rate Conversion Method

Gain Selection

Rate Conversion Method

This feature selects the method Osprey-2000 uses to convert audio from one
sampling rate to another. For example, audio from a DV source is typically48 KHz
stereo audio. For various reasons, you may want to capture audio at only 8 KHz. For
most purposes, the default setting of Filter Converter works well.

The registry values which control Rate Conversion are listed below. The X stands for
the device number of the Osprey-2000 card. Numbering starts at 0, so the first
Osprey-2000 card is Device 0.

HKEY_CURRENT_USER\Software\Osprey\Osprey2000\DeviceX\Audio\RateConversion
When Rate Conversion is:

¢ 1 - use filter converter (default)
¢ 2 - use skip converter (skips samples)
¢ 3 - use Microsoft PCM method
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Gain Selection

Gain Selection allows you to boost the audio level in software. This applies only to
digital audio sources (AES/EBU, DV, and embedded SDI).Analog audio sources
(unbalanced and balanced audio) have hardware gain, controlled by the volume
slider on the mixer applet).

The default value of 2 is sufficient for recording from most sources including
camcorders, CD players, and Walkman radios. If you have audio sources that are at
lower levels, increase the Gain value. The registry values which control this are
below. The X stands for the device number of the Osprey-2000 card. Numbering
starts at 0, so the first Osprey-2000card is Device 0.

HKEY_CURRENT_USER\Software\Osprey\Osprey2000\DeviceX\Audio\Gain

The default value of Gain is 2. Set it higher for increased software audio gain. Set it
below 2 to decrease gain.

Audio Formats

The only format that the Osprey-2000 audio capture driver supports is PCM. The
driver supports the following data rates:

8 KHz
11.025 KHz
16 KHz
22.05 KHz
32 KHz
44.1 KHz
48 KHz

* & 6 6 o o o

These data rates are supported in 8-bit and 16-bit, mono and stereo formats. The
actual Osprey-2000 hardware supports sampling of analog audio at 32, 44.1 and 48
KHz. Depending on the requested audio format, the Osprey-2000 driver
automatically selects the most appropriate hardware sampling rate. For example, if
22.05 KHz audio is desired, the audio driver selects the 44.1 KHz audio rate and
down samples it to 22.05 KHz.

The Osprey-2000 driver provides for optimal rate conversion from these base
sampling rates. For digital sources, the sample rate has already been determined.
The Osprey-2000 automatically determines the digital audio sample rate and
converts this as required by the application’s requested sample rate.

It should be noted that the Osprey-2000 does not currently dynamically readjust
sampling rates while audio capture is in progress. Audio capture should be stopped
and restarted whenever the audio input port changes.

For mono sources, the Osprey-2000 uses only the left audio channel. Optionally, this
can be configured to be the left channel or a mix of the left and right channels.
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Also note that the Osprey-2000 does not currently up sample audio. Thus, if a digital
audio source (SDI, AES/EB4, DV or decoded MPEG) is providing audio data at 44.1
KHz, you will not be able to capture or encode at 48 KHz.

Missing Digital Audio Sources

& Be sure to start the audio source before attempting capture.

When a digital audio source (such as DV, AES/EBU, or SDI) is selected before the
audio is turned on, the Osprey-2000 is unable to determine the sampling rate. The
sampling rate is a measure of the amount of binary data needed to reproduce the
audio being capture. If the audio source is not available, the Osprey-2000 cannot
determine the format of the incoming audio.

When a capture is started before the audio source is selected, the audio may not be
sampled at the correct rate. Audio sampled at an incorrect rate will sound slower or
faster than normal when it is played back. Should this occur, stop and restart
capturing audio.

The default digital audio sampling rate is 48 KHz. Some common sampling rates are:

48 KHz for DVD audio through AES/EBU

44.1 KHz for CD audio through embedded SDI

48 KHz for audio from many SDI or AES/EBU sources
32 KHz or 48 KHz for DV recordings

* & o o

Audio Playback

The Osprey-2000 provides audio capture only. It is not a general audio playback
device (like a system soundcard). Continue to play back captured audio using your
system soundcard.

The Osprey-2000 does provide external monitoring of any of the audio inputs during
MPEG encoding and file capture/streaming, as well as for audio of decoded MPEG.
The audio output is a stereo unbalanced RCA connector. There is no additional gain
or attenuation applied in the audio output path. You cannot change the balance or
volume controls on the Osprey-2000 playback device in the mixer applet.

It is necessary to enable the MPEG Decode portion of the Osprey-2000 playback
device in the mixer applet before you will be able to hear audio from the Osprey-
2000's audio-out jacks while playing an MPEG file.
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To get to the Osprey-2000 audio playback device:

1.  Bring up the audio mixer interface

Select Properties under the Options menu to pop up a dialog to select the
Mixer device

3. Do not select the Playback option within the Adjust Volume field. Click on the
dropdown list for Mixer device to see the list of audio input and output
devices, including the Osprey-2000

Properties : ll il
Miwer device: {4 real dudio j
At el ey 2000 Aucio

& Flayback
" Becording
£ Other I.&EEI? Contralz j

Show the following volume controls:;

Yalurme Contral -
Wave
Wi avetable Synthesizer

[ Phane -
1| | 3
k. I Cancel |

4.  If more than one Osprey-2000 card is in the system, each Osprey-2000 card is
individually listed.

5. Once an Osprey-2000 device has been chosen, click the Playback radio button.
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6. Click to select the Encode and Decode check boxes.

Properties

Mirer device:

— &djugt wolurne for
* Playback
™ Recording

) Miher I

Show the following wolume controls:

Flayback Control
[ Encode
[ Decode

I

i

] I Cancel |
7.  Click OK in the Properties dialog box.
EE Playback Control - 0] =|
Cptions  Help
Flayback. Encode Decode
Balance: Balance: Balance:
Y olurne: Walurme:
Vv Select [T Select
|Osprey 2000 Audio

There are two options for audio out: Encode (the audio selected as an input) or
Decode (the audio from the MPEG decoder). Note that volume sliders are not
adjustable since the Osprey-2000 does not provide gain control for audio outputs.

Note that you must select Decode in order to hear the audio produced by

7NN

Record Control mixer applet.

your MPEG file from the Osprey-2000's audio-out plugs while decoding
(playing) MPEG. If you select Encode while decoding, you will hear
whatever audio is coming from the audio input source last selected in the
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Chapter 10 - VidCap32, AmCap, and
Included Demo Programs

The Osprey-2000 Driver includes the following applications:
VidCap32

AmCap

Cropping and Scaling

DXMedia

Ligos Technology’s Indeo

Installed by the DirectShow Runtime optional components:
Decode (Screen)

Decode (Video Out)

Encode_demo

Installed by the OPI Runtime optional component:

MpegVCR Application
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VidCap32

{1 VidCap E o ] 34|

File Edit Options Capiure Help

I ] -I@

|
VidCap32 is a video capture application included with the Osprey package. It is
useful for testing the installation and for general purpose capture of video.

Instructions for using this applet are provided in the following sections. For
instructions about encoding an MPEG file, please see Chapter 5 - MPEG Encode.

VidCap32 Preview

Overlay

Single Frame Capture

Configuring the Video Capture Driver in VidCap32

Compression

Setting the Capture File in VidCap32 - Preallocating and Defragmenting
Capturing Video with VidCap32

VidCap32 Preview

The Preview button (first button on the left on the toolbar) toggles Preview mode on
and off. When Preview is enabled, the video you see is constantly updated. This
video has the exact format and appearance that uncompressed video captured to file
will have. If you are using a software compressor to compress the video before
writing it to file, the compressor's output will be slightly different.
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Overlay

The Overlay button (second button from the left on the toolbar) toggles Overlay
mode on and off. When Overlay is enabled, the video you see is also updated
constantly. However, the difference between Overlay and Preview is that Overlay
video does not have the exact appearance of the video that you are capturing
because the Osprey driver uses the fastest and most efficient drawing method it can.
In Overlay mode, Direct Draw trades speed for accuracy. Normally, with Direct Draw
enabled and working, it draws at the full frame rate (30 per second) with minimal
processor overhead.

Note that the Preview and Overlay buttons behave like radio buttons that cancel
each other. Starting either one of them shuts the other one off.

Single Frame Capture

The rightmost button on the toolbar (or the menu item File -> Save Single Frame)
is used to capture a single frame. Every time this function is selected, a single frame
is captured and displayed in the window. You can copy this image and paste it into
other applications.

Configuring the Video Capture Driver in VidCap32

Use the video capture application VidCap32 to access the Osprey driver Control
Dialog described in Chapter 8 - Osprey-2000 Video Control Dialog. The menu
selections Options -> Video Source and Options ->Video Access accesses the
Control Dialog's Source and Format pages, respectively. The selections Options ->
Video Display access the Closed Caption page.

VidCap32 is included with the Osprey package. VidCap32 is useful for testing the
installation and for general purpose viewing and capture of video. Refer to Chapter
10 - VidCap32, AmCap and Included Demo Programs for instructions on using
this applet.
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Compression

It is possible to compress video as it is captured to disk. Neither VidCap32 nor the
Osprey video capture driver performs video compression, although VidCap32 may be
connected to external software-based compression modules. While compression
results in a much smaller capture file, the downside is that many types of
compression are slower. With compression, you may have to reduce your frame rate
to avoid dropping an excessive number of frames. With a quick-compression method
running on a fast machine, however, the extra processing time is slight enough to be
fully compensated for by the reduced time required to write the compressed data to
disk.

When a compressor is enabled, video is passed from the Osprey capture driver to the
compressor, which then writes it to file. The compression dialog, accessed by
selecting Options->Compression, allows you to select a compressor, or to select
no compression. Refer to Ligos Technology's Indeo for detailed instructions for
performing this task.

Note that the list of available compressors is different for each video Color
Format selected in the Osprey video capture driver’s control dialog. You

& should therefore select the Color Format you will be using first, then
select the compressor. Otherwise, you may get an error message when
you try to begin video capture.

Setting the Capture File in VidCap32 - Preallocating and
Defragmenting

The leftmost button on the toolbar (or the menu item File -> Set Capture File)
opens the Capture File dialog box.

{# ¥idCap 2 B ] 54

File | Edit  Options Capture  Help
Load Palekte. .. El @

Allocate File Space...

Save Capkured Yideo &s...
Save Palstte. ..
Sawe 3ingle Frame...

| Select or create a fils to caphure the video to

Depending upon a number of factors, you may experience a significant percentage of
frames dropped. The percentage of frames dropped is a function of frame size, use
of a compressor, and the speed of your system. Performance can be substantially
improved by preallocating a capture file and defragmenting it.
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If you do not know the size of file that you are going to capture, it's best to allocate
a 1MB file and allow VidCap32 to dynamically allocate more space on the fly.

Preallocating a file means that space has been reserved for it on your hard disk. The
menu item File -> Allocate File Space brings up a dialog in AmCap or VidCap32 by
which you can preallocate a file and reserve space large enough to hold the largest
video clip that you are likely to capture. You can preallocate multiple files to hold
multiple video clips.

For preallocation to be useful, the hard drive should be defragmented afterwards.
Defragmenting a drive reorganizes its physical sectors so that each file occupies
contiguous sectors, rather than having different parts of it scattered about the disk.

AmCap and VidCap32 do not perform defragmentation; a third-party program is
required. Various defragmentation programs are available commercially, and
Windows 2000 contains a built-in defragmenter. Use AmCap and VidCap32 to
preallocate the files, then exit to run the defragmentation program.

& NOTE: Always defragment after you allocate and size the capture files.

After the disk is defragmented, return to AmCap/VidCap32. The files you
preallocated will now be located on contiguous areas of the hard drive and their
physical layout will remain the same until the file is resized or deleted.

An alternate technique that avoids the need for defragmenting is to set up a
separate disk partition dedicated to video capture, containing a single capture file.

Defragmenting is a time-consuming procedure, but is worth the trouble if you have
an ongoing need to capture high-quality video, particularly uncompressed video. Be
sure to plan the number and size of files you will need. Once you have the
defragmented files, be sure not to accidentally delete them. Think of these files as
your permanent working space for time-critical operations, not as containers of
specific video clips. Copy your clips to other files for storage and editing.

Capturing Video with VidCap32

The second button from the right (or the menu item Capture -> Video) opens the
Video Capture Dialog.

This dialog includes controls to set the number of frames per second, as well as an
optional time limit (in seconds) for the sequence. Buttons are provided to access
both the video capture driver’'s configuration dialog and the compression dialog. You
can also access and configure audio, assuming that it is installed and enabled. The
dialog allows a choice between capturing video directly to disk, or capturing via
memory.

For best quality video capture, use a capture rate (frames per second) that is slow
enough so that there are no dropped frames. Note that capturing via memory may
result in fewer frames dropped than capturing video directly to disk.
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Once the proper configuration is confirmed, click OK to capture the video. To end
capture, click the mouse anywhere in the VidCap32 window.

AmCap

{1 AMCAP

e A5 | .l
o2kye.dll - Deprep-2000 Codec 1 -

AmCap is a video capture application included with the Osprey-2000 package. It is
useful for testing the installation, for general purpose viewing of video, and for
capturing video to a file. For instructions about encoding an MPEG file, please see
Chapter 5 - MPEG Encode. AmCap differs from the other general purpose capture
application, VidCap32, included with the Osprey package in that:

¢ Because AmCap captures AVI 2.0 files, AmCap can handle captured file sizes
that exceed VidCap32's 2GB limit.

¢ AmCap is written using the DirectShow API; VidCap32 is written using the
VFW API. Another application that uses DirectShow is Windows Media
Encoder.

AmCap does not support software compression modules.
AmCap's Preview mode is equivalent to VidCap32's Overlay mode.
AmCap does not have an equivalent to VidCap32's Preview mode.

AmCap requires the DirectX Media runtime version 6.0 or later in order to run. This
runtime is included on this CD, and can be installed by the Osprey installation
program. More information about DirectX Media is available at DirectX Media Details.

Instructions for using AmCap are provided in the following sections. Note that this
applet has additional capabilities and settings that are beyond the scope of this brief
introduction. Refer to AmCap’s Help menu for a description of those capabilities and
settings.
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Selecting the AmCap Device

AmcCap Preview

Configuring the Video Capture Driver in AmCap

Setting the Capture File in AmCap - Preallocating and Defragmenting
Capturing Video with AmCap

Playback

Selecting the AmCap Device

{8 AMCAP - G:\junk.avi I [ S
Filz | Devices Options Capture  Help
i—! v o2kve.dll - Osprey-2000 Coder 1

—\l v Osprey 2000 Audio
Aureal Audio

Captured 334 frames in 22.6 sec [0 dropped): 14.7 fps 4.534 Meg.

AmCap requires selecting the input device(s) before you can preview or capture
video. Use menu item Devices to show a dropdown list of the audio and video
capture devices present. In this list, the video device portion of Osprey-2000 cards
appears as Osprey-2000 Codec and the audio device on the Osprey-2000 appears
as Osprey-2000 Audio.

If you have multiple Osprey-2000 cards present, you can select the audio device
from this list. For instructions on selecting among multiple video sources, please see
The Format Page.

Multiple board installations are a specialized subject discussed in Appendix F:
Multiboard Installations.
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AmCap Preview

fil AMCAP - G2 junk.avi ] 3
File Devices | Options Captre  Help
} ¥ Preview

Audio Format...

Video Format.. .
Yideo Source...

Yideo Display...

When you first start AmCap, there is nothing in the video field display. To see video,
you must enable Preview mode by clicking on the menu item Options -> Preview.

When preview is enabled, the video you see is updated constantly. What you see is a
close approximation to the appearance that uncompressed video captured to file will
have. However, with the AmCap applet preview video is optimized for fast screen
drawing rather than the exact capture format, possibly resulting in slight differences
in the appearance of the video.

Configuring the Video Capture Driver in AmCap

You can go through VidCap32 or AmCap to access the Osprey driver’s Control Dialog.
The menu selections Options-> Video Source and Options-> Video Format
access the Control Dialog’s Source and Format pages, respectively. The selection
Options-> Video Display accesses the Closed Caption page.

The recommended color format when capturing AmCap is “4:2:2packed”. This is set
in the Format Page of the Osprey driver's Control Dialog.

For more information about Control Dialog, refer to Chapter 8 - Osprey-2000
Video Control Dialog.
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Setting the Capture File in AmCap - Preallocating and
Defragmenting

The menu item File -> Set Capture File opens the Capture File dialog box.

{0 AMCAP - G\junk.avi -0l x|
File | Devices Options Caphwe Help

Set Capture File...

Allocate File Space. ..
Save Captured Yideo As...

Exit

e | ?:'._
Captured 334 frames in 226 sec (0 dropped): 14. fps 4.534 Meg,

Since several variables can affect the percentage of frames dropped, performance
may be substantially improved by preallocating a capture file and defragmenting it.
The percentage of frames dropped is a function of frame size, use of a compressor,
and the speed of your system.

If you do not know the size of file that you are going to capture, it's best to allocate
a 1MB file and allow VidCap32 to dynamically allocate more space on the fly.

Preallocating a file means that space has been reserved for it on your hard disk. The
menu item File -> Allocate File Space brings up a dialog in AmCap or VidCap32 by
which you can preallocate a file and reserve space large enough to hold the largest
video clip that you are likely to capture. You can preallocate multiple files to hold
multiple video clips.

For preallocation to be useful, the hard drive should be defragmented afterwards.
Defragmenting a drive reorganizes its physical sectors so that each file occupies
contiguous sectors, rather than having different parts of it scattered about the disk.

AmCap and VidCap32 do not perform defragmentation; a third-party program is
required. Various defragmentation programs are available commercially, and
Windows 2000 contains a built-in defragmenter. Use AmCap and VidCap32 to
preallocate the files, then exit to run the defragmentation program.

& NOTE: Always defragment after you allocate and size the capture files.

After the disk is defragmented, return to AmCap/VidCap32. The files you
preallocated will now be located on contiguous areas of the hard drive and their
physical layout will remain the same until the file is resized or deleted.

An alternate technique that avoids the need for defragmenting is to set up a
separate disk partition dedicated to video capture, containing a single capture file.
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Defragmenting is a time-consuming procedure, but is worth the trouble if you have
an ongoing need to capture high-quality video, particularly uncompressed video. Be
sure to plan the number and size of files you will need. Once you have the
defragmented files, be sure not to accidentally delete them. Think of these files as
your permanent working space for time-critical operations, not as containers of
specific video clips. Copy your clips to other files for storage and editing.

Capturing Video with AmCap

{1 AMCAP - G2 junk.avi oh O] x|
File Dewices Options | Capture Help
Start Capture

v Capture Audio
Master Stream
Set Frame Rate. ..

Set Time Limnit, ..

Captured 334 frames in 22.6 sec [0 dropped): 14.7 fps 4534 Meg.

AmCap requires setting a few options before starting Video Capture.

1. First, set the Frame Rate by selecting menu item Capture -> Set Frame Rate

Choose Frame Rate [ |

[V Use Frame Rate

Frame Rate: |1 4990000  fsec
Cancel |

2. Note that the maximum NTSC frame rate is 29.97 frames/sec and not 30
frames/sec. The maximum PAL frame rate is 25 frames/sec. If you want to
capture at the full NTSC frame rate, set the rate to 29.97 in this menu.

3. Capturing uncompressed video to disk is limited by disk throughput. You may
find that your system is not capable of capturing to disk, for example, at full
resolution full frame rate. In this case, you may be best served by reducing
either the frame rate, the resolution, or both.
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4. If you are capturing audio, use menu item Capture -> Capture Audio to turn
on the checkmark for audio capture.

[l AMCAP - G junk.avi :
Fil= Devices Options | Caphure Help
Start Capture

S0P apUne:

Captured 334 frames in 22.6 sec [0 diopped): 14.7 fps 4.534 Meg.

5. Set the master stream for audio/video synchronization by using the control
dialog brought up by Capture -> Master Stream to select whether Audio,
Video, or None is the master stream for synchronization.

Capture Time Limit E

[¥ Use Time Limit

Time Limit: 1484 3ec
Cancel |

6. You can optionally set a time limit on this capture through the Capture -> Set
Time Limit dialog.

7. Once the proper configuration is confirmed, click the Capture -> Start
Capture menu item, and click OK on the confirmation dialog to begin capture.

8. If you did not set a time limit, use the menu item Capture -> Stop Capture or
press the Esc button to end your capture.

Playback

The simplest way to play back a video clip is to find its icon in My Computer and
double-click on it. This will start Windows Media Player, which will automatically play
the clip.

Windows Media Player contains standard start, stop, and pause buttons and is self-
explanatory. Refer to Windows Media Player’s help for more information.
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Cropping and Scaling

The Osprey-2000 driver package includes the capability to crop the incoming video
signal in hardware before it is encoded or captured. Cropping is done by the Osprey
card and imposes no extra load on the host computer. Use any of the following
methods to crop the incoming video signal:

+ Video Format dialog box
¢+ CropApp, the cropping application
¢ VFW Software Developer Kit

Please see the CropApp Manual which is installed in the Osprey-2000 Program group
for details on using this feature. Note that scaling down can be applied in hardware
to any video source before capture. The MPEG encoding processing can also scale
input video sources, providing for a range of MPEG encoding resolutions.

Decode (Screen)

The included decode (screen) demo is a DirectShow program which will decode an
MPEG file to the screen. Please see Chapter 6 - MPEG Decoding for details. This
program works under Windows 2000, only.

Decode (Video Out)

The included decode (video out) demo is a DirectShow program which will decode an
MPEG file to the screen. Please see Chapter 6 - MPEG Decoding for details. This
program works under Windows 2000, only.

MpegVCR Application

A digital VCR application, MpegVCR, is included with the OPI Runtime optional
component. See the application's Help for information about using it. This application
can record and play MPEG files, and can loopback MPEG video.

Encode _demo

The included encode_demo is a DirectShow program which will encode MPEG files.
Please see Chapter 5 - MPEG Encoding for details. This program works under
Windows 2000, only.
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DXMedia

Under Windows NT 4.0, the included program AmCap cannot be run unless
Microsoft’s DirectX Media package (also known as DirectShow) has been installed.
This package is included on the Osprey-2000 Driver CD, and it can also be
downloaded from Microsoft’s website.

DirectX Media Details

DirectX Media Details

Microsoft DirectX Media is the media layer of the Microsoft Windows multimedia
system, providing multimedia playback and capture support, image transformations,
media integration, and animation for the Web and desktop.

Information Specific to Windows 2000

Windows 2000 installs version 6 of DirectX Media and version 7 of DirectX. Version 8
of DirectX is available for Windows 2000, and includes the DirectX Media/DirectShow
layer.

More information about DirectX version 8 is available at:

http://www.microsoft.com/presspass/press/2000/Nov00/DirectXLaunchP
R.asp

This version of DirectX® is not available for Windows NT.
Information Specific to Windows NT

The DirectX Media runtime is included on this CD, and can be installed by executing
DXMedia\dxmedia.bat on the Osprey-2000 CD. See the Readme.txt file for details.
DirectX Media requires that Microsoft DirectX 3.0 or later be installed. Windows
Service Packs 4 and later contain DirectX 3.0.

More information about DirectX and Windows NT is available at:
http://www.microsoft.com/directx/homeuser/faq.asp - dx4

More information about DirectX Media
http://www.microsoft.com/directx/homeuser/information/dx4nt.asp

http://www.microsoft.com/directx/homeuser/downloads/default.asp-
DirectX

The DirectX Foundation Layer consists of Microsoft DirectDraw, Microsoft Direct3D,
Microsoft DirectInput, Microsoft DirectSound, Microsoft DirectPlay, and Microsoft
DirectMusic. DirectDraw is part of DirectX, and is another reason that a video display
adapter which supports DirectDraw is desirable.
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For more information about DirectX
http://www.microsoft.com/directx/homeuser/faq.asp
http://www.microsoft.com/directx/homeuser/aboutdx.asp
The latest version of all DirectX downloads can always be found at:

http://www.microsoft.com/directx/homeuser/downloads/default.asp

Ligos Technology's Indeo

Demo Indeo

Ligos Technology’s Indeo is a software video compressor that works with the Osprey
Video Capture Driver. It allows you to capture video to disk using much less disk
space, at the cost of only a slight loss of picture clarity. On a 300 MHz Pentium II
system, you can capture 320x240 NTSC video at a full 30 frames per second with a
25:1 compression ratio.

Indeo is included on Osprey-2000 Driver CDs. Refer to Chapter 3 - Installing the
Software - Windows 2000 or Chapter 4 - Installing the Software - Windows
NT 4.0 for installation information.

You can also download the most up-to-date version for free on Ligos web site:
http://www.ligos.com/indeo/downloads/

The file to download is currently ivSsetup.exe. Download a version that compresses
as well as decompresses video.

Indeo Video compressor version 5.11 works with RGB24 and RGB15. It does not
work with YUV12 or YVU9. However, the Indeo package does include components
you can use to capture uncompressed YVU9 and 4:2:2 packed video.

Demo Indeo

Use the following steps to demo Indeo with the Osprey card:

1. Connect and adjust your video source. Start VidCap32.
Use the Options->Format menu entry to bring up the Osprey driver’s Control
Dialog Format page.

3. In the drop-down list in the Color Format field, select RGB24 (or RGB15).
Select 2 sized (CIF) video. Click OK.

4, Use the Options->Compression menu entry to bring up the compression
dialog. In the Compressor: field, select Indeo video 5.11.
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5.

Before leaving the compression dialog, click the Configure button. Enable
Quick Compress in the Encoder Controls field, and click OK.

& NOTE: If you do not enable Quick Compress, compression will be much

slower. Click OK again to close the Video Compression dialog box.

9.

Under the file menu, Select Set Capture File. Set the name that you want for
the file that will contain the captured video and click Open.

Select Capture->Video. Select 30 frames per second for NTSC or 25 for PAL.
Click OK.

When the confirmation dialog appears, click OK again to start capturing video.
Click anywhere on VidCap32 to stop capture.

To play back the file you just captured, open My Computer, navigate to the icon
of the file you want to play, and click on it.

If you experience more than one or two dropped frames, use a lower frames per
second capture rate.

f-_“j Useful rates for NTSC video are 30, 15, 10, and 7.5

Useful rates for PAL are 25, 12.5, 8.33, and 6.25

Indeo has numerous options. You can obtain higher quality video and more
compression options by capturing uncompressed video and then compressing it off-

line.
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Blue/Pink/Black/Orange/Green Video Screen
Black Preview Video Screen

Scrambled Video Image

Grainy, Dithered Image

Slow Overlay Drawing

Problems Using Direct Draw

Poor Video Quality at Large Frame Sizes
Wrong Capture Driver Being Accessed
Unwanted Closed Caption Text

No Closed Captions on Digital Video
Interrupt Conflicts

Multiple Horizontal Lines Across Video Image

Blue/Pink/Black/Orange/Green Video
Screen

The currently selected video input is not receiving an active video signal. Different
inputs may provide a different symptom when a video source is not supplied. For
example, with the Osprey-2000 DV Pro, Osprey-2000 D DV, or Osprey-2000 D DV
Pro, if no DV source is connected to the card, the DV video may appear as a solid
pink field. While playing a tape in a DV camcorder, you may see an orange screen at
end-of-tape. Video from composite/S-Video may appear as a black field (maybe with
a single horizontal line in it) or as a blue field. If no SDI source is connected, the
video will appear as a solid green field.

1.  Check that the camera, VCR, or other video source is powered and that its
output is connected to the Osprey card’s input.

2. Check that the correct video input is selected in the Control Dialog’s Source
page.
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Black Preview Video Screen

If you select a Color Format other than one of the RGBs or Grey8, you may get a
black preview screen. You may also get a message such as Error: Unable to draw
this data format. The problem is that Video for Windows does not know how to
decode these more specialized formats. It must be able to locate a software video
decompressor on your system that works with this format.

If you encounter this situation with a Color Format that you need or want to use, you
have to obtain a suitable compressor. For example, if you install Ligos Technology’s
Indeo compressor you can preview the YVU9 format. To download from Ligos
Technology's web site:

http://www.ligos.com/indeo/downloads/

Scrambled Video Image

You may have set the wrong video signal format for the signal input you are using.
For example, you may have told the driver to look for NTSC-M video but are using a
PAL-BDGHI video source. Make sure you know what signal format your video source
is generating. Go into the Signal field of the Control Dialog’s Source page, and click
the button for that signal format.

Grainy, Dithered Image

Check that you are using a display format with greater than 256 colors. If a 256
color format is used, the system can only approximate the actual colors, and does so
with a loss of resolution and precision.

Slow Overlay Drawing

You should be able to obtain 30 frames per second with minimal processor loading
by enabling Direct Draw. System requirements for realizing this speed are:

¢ avideo display card that supports Direct Draw
¢ avideo display device driver for the card that supports Direct Draw

Either or both of the two checkboxes in the Direct Draw field of the Control Dialog’s
Configuration page must be checked.

Refer also to Appendix E - Direct Draw.

172 - Osprey-2000 User's Guide Version 2.2.0 ViewCast Corporation



Chapter 11 - Troubleshooting

Problems Using Direct Draw

Direct Draw is a recent technology and it is possible that you may have problems
using it with your particular combination of display adapter, display driver, and
machine. For video capture, any problems should arise only when Overlay mode
screen drawing is in use; the Osprey video capture subsection does not use Direct
Draw at other times. Using DirectShow filters, or OPI applications, video preview will
use DirectDraw unless the Video Capture driver is configured to use DibDraw. If you
do have problems, disable either or both Direct Draw methods by deselecting their
boxes in the Direct Draw field of the Control Dialog’s Configuration page. We have
seen problems with Secondary Direct Draw on a few older display adapters. Refer
also to Appendix E - Direct Draw, for more details.

Poor Video Quality at Large Frame Sizes

Large frame sizes with the deep pixel depth (24- or 32-bit), or complex format
(YVU9 or YUV12 planar), impose heavy demands on the PCI bus’s data transfer
capacity. Our experience is that some systems cannot handle these formats at full
frame sizes.

Systems vary in their data transfer limits. The characteristics of the PCI bridge are
often more important than processor speed. If you are having problems, we
recommend that you:

Use a smaller frame size (480 x 320 or less).
Use a shallower color format (RGB15 or RGB24 instead of RGB32).

Try an RGB format instead of a YVU format, and a packed format instead of a
planar format.

+ If you have a choice of PCs for video capture, try using another system with a
different system board chipset.

Wrong Capture Driver Being Accessed

This might happen if you already had another capture board/capture driver on your
system when you installed the Osprey card. The Osprey installation procedure allows
you to set the Osprey driver as either the primary or secondary video capture driver.
Appendix D - Using the Osprey Video Capture Driver with Other Video
Capture Drivers gives a full description of how to set the Osprey driver as the
primary driver.

Some applications, including VidCap32, allow you to select which video capture
driver to use. In VidCap32, a list of installed video capture drivers is appended to the
bottom of the Options menu.
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Unwanted Closed Caption Text

Closed Caption text consists of white or colored characters drawn on black character
cells.

In video that contains Closed Captioning information, the first active line of video in
each field contains encoded Closed Caption text. In video that does not have Closed
Captioning information, that line is simply ordinary video.

If you leave Closed Captioning enabled and view non-Closed Caption video, the
Osprey video capture driver attempts to interpret the first line of each field of video
as Closed Caption character codes. Some video may appear sufficiently similar to
Closed Caption data that the software thinks it is Closed Caption text. The result is
occasional randomly drawn text appearing on the screen.

The solution is to turn off Closed Captioning when you are viewing sources that are
not Closed Captioned. To do so, open the Control Dialog’s Closed Caption page and
uncheck the Enable box in the Display field. The change takes effect when video is
restarted after exiting the dialog.

For more information about Closed Captioning, refer to The Closed Caption Page.

No Closed Captions on Digital Video

The Osprey-2000 is capable of decoding closed captions on NTSC video inputs. This
feature is supported on analog video sources - the composite and S-video inputs
only. It is not supported on the digital video inputs - SDI and DV.

Interrupt Conflicts

Failed network connections, failure of a device drive to initialize during start-up, or
failure of the Osprey card and driver to operate properly are often traced to interrupt
(IRQ) conflicts. In our experience, IRQ conflicts are most commonly seen when a PCI
SCSI adapter, or possibly a PCI network adapter, is present in the system.

Conflicts Between PCI Cards

Conflicts of PCI Cards with ISA Cards
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Conflicts Between PCI Cards

PCI cards and drivers do not choose which IRQs they use, rather, the operating
system assigns IRQ lines to PCI cards. The IRQ configuration for the Osprey card or
cards is determined by the operating system, and the Osprey driver cannot change
this configuration. However, you can cause the operating system to assign IRQs
differently by rearranging cards or changing BIOS settings.

Multiple PCI cards are supposed to be able to share the same IRQ line. In practice,
occasionally you may encounter a device driver that is not implemented correctly for
interrupt sharing. If this problem arises, you have to rearrange the PCI cards so that
the non-compliant card does not share its IRQ line with any other device.

Another problem is that some PCI device drivers expect to use a particular IRQ line.
When a new card is added, it causes the system to assign IRQs differently. If the IRQ
assignment for a particular card is changed and its device driver does not detect the
change, this causes the system to work incorrectly.

The simple answer to this problem is it can sometimes be solved by physically
rearranging the PCI cards such that their arrangement in the PCI slots is different.
When doing this, keep careful notes of the arrangements you have tried.

Another approach to PCI card conflicts is at the BIOS level. Depending on what kind
of system BIOS you have, you may be able to change which IRQ lines are allocated
to PCI devices versus ISA devices. You may be able to allocate more IRQ lines for
PCI devices and thereby solve a PCI conflict.

If these approaches do not work, see Getting Help in Chapter 1.

Conflicts of PCI Cards with ISA Cards

A PCI card and an older-style ISA card can never share IRQ lines. Windows NT
cannot detect with certainty what IRQ line an ISA card is using and cannot always
prevent the conflict.

You can view the system’s IRQ assignments under Windows NT by running the
Windows NT Diagnostics program in the Administrative Tools menu or program
group. Select the Resources tab and click the IRQ button at the bottom of the field.
Under Windows 2000, open Administrative Tools -> Computer Management,
and click on Computer Management. Then double-click on Hardware Resources,
and open IRQs. If the list of cards shows an ISA card using the same IRQ as another
device, the conflict should be resolved by changing the IRQ of the ISA card.

Unfortunately, if a device driver for an ISA card has failed to initialize because of an
IRQ conflict, the card’s IRQ does not appear in the list. To find the conflict, you have
to examine all your ISA cards with the Control Panel to find out what IRQs they are

trying to use.
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Multiple Horizontal Lines Across Video
Image

If there are multiple, regularly spaced, horizontal lines across your video image and
your source material is copyrighted and copy-protected, you are seeing Macrovision
™ copy protection. It looks like this:
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The lines can vary in color from yellow to blue to green. These lines are not present
in every frame of video. There may also be a black band at the top of the frame.

The Osprey-2000 cannot eliminate these video artifacts. These artifacts will only be

present when you are using a copy-protected source, such as a high-quality DVD, for
testing a card.
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The physical specifications for the Osprey-2000 Capture cards are as follows.

Table A-1 Physical Dimensions

Length 175 mm

Width 22 mm

Height 106 mm

Weight 68 grams

Table A-2 Environmental Specifications

Operating temperature range 0° to 40° C

Non-operating temperature range -40° to +75° C (RH)

Operating humidity range Between 5% and 80% (non-condensing)
@ 400 C

Non-operating humidity range 95% RH (non-condensing); gradient 30%
per hour

Operating altitude range 0 to 3,048 meters (10,000 feet)

Non-operating altitude range 0 to 15,240 meters (50,000 feet)
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The Color Format field of the Control Dialog’s Format page allows you to select the
following video formats.

YUV Format Details

RGB32 - Each pixel has four bytes (32 bits) of data - one each for red, green, and
blue, plus one byte of padding. The pixel has 256 shades of each of the three colors,
for a total of 16.7 million colors. This is a true color mode.

RGB24 - Each pixel has three bytes (24 bits) of data - one each for red, green, and
blue. This is another true color mode with 16.7 million colors, and is a recommended
format for capturing images with the highest possible color accuracy.

RGB15 - Each pixel has two bytes (16 bits) of data. There are 5 bits each of red,
green, and blue data; the sixteenth bit is unused. This is a high color mode, also
known as “5:5:5.”

Grey8 - Each pixel has one byte of data, representing one of 256 grayscale levels.

4:2:2 packed - Also known as YUY2. This mode represents each pixel with a total
of 2 bytes (16 bits) of data. The data is encoded as separate data for luminance
(intensity) and chrominance (color). This mode is mainly used as an input to
software compressors. See YUV Format Details.

YUV12 planar - Also known as I420. This is a complex format in which there are in
the aggregate 12 bits of data per pixel. Each pixel has 8 bits of luminance data. Each
group of 4 adjacent pixels shares two bytes of chrominance data. See YUV Format
Details.

YVU9 planar - Similar to YUV12 planar, except that there are in the aggregate 9
bits of data per pixel, and each byte pair of chrominance data is shared by 16
adjacent pixels. See YUV Format Details.

YUV Format Details

4:2:2, YVU9, and YUV12 are YUV formats. In these formats, each pixel is defined by
an intensity or luminance component, Y, and two-color or chrominance components,
U and V. Since the human eye is less sensitive to color information than to intensity
information, many video formats save storage space by having one luminance byte

per pixel while sharing the chrominance byte among two or more pixels. YUV is also
very similar to the color encoding used for analog color television broadcast signals.

4:2:2 packed mode consists of a single array of mixed Y, U, and V data. Each pixel
has one Y (intensity) byte. Each pixels shares its U and V bytes with one of the pixels
horizontally next to it:
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Pixels 1 and 2:

byte 1 =yl byte 1 intensity

byte 2 = u1/2 shared U color information for bytes 1
and 2

byte 3 = y2 byte 2 intensity

byte 4 = v1/2 shared V color information for bytes 1 and
2

Pixels 3 and 4:

byte 5 = y3

byte 6 = u3/4

byte 7 = y4

byte 8 = v3/4

4:2:2 packed mode uses the same number of aggregate bytes per pixel as RGB15,
which is two. However, 4:2:2 is more efficient than RGB15 because it stores
relatively more of the intensity information to which that the human eye is most
sensitive.

YVU9 and YUV12 are planar modes - the Y, U, and V components are in three
separate arrays. It is easiest to explain the format with an example. Let's say you
have a 320x240 YVU9 format. The buffer has 320x240 bytes of Y data, followed by
80x60 bytes of V data, followed by 80x60 bytes of U data. So each U and each V
byte together contain the color information for a 4x4 block of pixels.

Similarly, a 320x240 YUV12 format has a 320x240 Y array, followed by a 160x120 U
array, and then a 160x120 V array.

Note that in the 1420 format used by Osprey, the order of the U and V
arrays is reversed from the order in the YVU9 format.
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The following table gives the standard video sizes available through the Control
Dialog’s Format page.

The 525-line video formats are NTSC-M, NTSC-J, and PAL-M.

The 625-line video formats are PAL-BDGHI, PAL-N, and PAL-NC.

CCIR601 is a video proportioning standard that can be selected on the Control
Dialog’s Format page.

Available Video Sizes (Width x Height:)

X 525-line 525-line 625-line 625-line
(Sqr Pixels) (CCIR601) (Sqr Pixels) (CCIR601)
Full 640 x 480 720 x 480 768 x 576 720 x 576
1/2 (CIF) 320 x 240 360 x 240 384 x 288 360 x 288
3/8 240 x 180 270 x 180 288 x 216 270 x 216
1/4 (QCIF) 160 x 120 180 x 120 192 x 144 180 x 144
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Appendix D - Using the Osprey Video
Capture Driver with Other Drivers

If you already have a video capture driver installed in your system, the Osprey
installation software offers the option of installing the Osprey driver as your primary
video capture driver. A dialog box with that option displays near the end of the
installation sequence.

The Windows 2000 installer does not offer this option.

After installation, you can change the primary video capture driver by going to the
Configuration Page of the driver's setup dialog and then to the Default Capture
Device option.

If the Osprey driver is set as your primary video capture driver, it will automatically
connect to Video for Windows applications as the default driver. If you install it as a
secondary or auxiliary video capture driver, it will not be accessible to Video for
Windows programs and utilities that lack a control for selecting a specific capture
driver. Your other driver, however, remains immediately accessible as the default
driver.
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Direct Draw is a fast on-screen drawing method. The Osprey video capture driver
utilizes Direct Draw for drawing video Overlays. Video overlay is a display mode
available in most video capture applications, including VidCap32. It is enabled by
clicking an Overlay button, or by selecting an Overlay menu entry. It is distinct from
Preview mode. Preview mode does not utilize Direct Draw.

Direct Draw is enabled by the Direct Draw Enable checkbox on the Control Dialog’s
Configuration Page. When Direct Draw is enabled, the Osprey driver attempts to use
it for overlays. If it cannot (e.g., the display driver does not support Direct Draw),
the Osprey driver defaults to DibDraw.

When Direct Draw is used, video is copied by direct memory access (DMA) directly
from the Osprey board to the visible screen memory, and video is overlaid at 30
frames per second with very low main processor utilization. When Direct Draw is not
used, video is copied by DMA into system memory, and then copied again into
display memory. Frame rate without Direct Draw is 30 per second for smaller frame
sizes, but less for larger sizes, and processor loading is substantial.

To utilize Direct Draw, the following conditions must be met:

1.  You have to enable Direct Draw by checking the Enable button on the Control
Dialog’s Configuration page.

2. Your video display card must support Direct Draw.

3. The software device driver for your video display card must support Direct
Draw. It is recommended that you use the most recent driver available. The
drivers on the Windows NT 4.0 CD-ROM do not support Direct Draw in all cases.
You can obtain the most recent version from your video card manufacturer’s
web site.

4.  You must be using a video format other than Grey8. The Osprey driver does not
support Direct Draw of grayscale video.

5.  You can tell whether the system is using Direct Draw as follows: When Direct
Draw is in use, the display near the video capture window flickers when either
the video capture window or an overlapping menu or window is moved. When
DibDraw is being used, there is no flicker.

6. You can also measure CPU utilization using the Task Manager’s performance
meter. When measuring CPU utilization, first shut down any applications that
might be actively consuming significant CPU time. CPU utilization will be just a
few percent when Direct Draw is running. If DibDraw is running, CPU utilization
will be substantial, especially if the image is large.
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The multiboard capability of the Osprey-2000 Capture Driver allows both single and
multiple applications to simultaneously access multiple boards. However, the driver
does not allow multiple applications or processes to access a single board unless the
added-cost SimulStreaming option has been enabled for the board, or another
special circumstance exists.

First, some background on the logic by which the Osprey-2000 driver determines
connection or startup order for multiple boards. The numbering of the boards is
determined by the order in which the operating system recognizes their presence in
the slots in which they are installed. The arrangement of logical PCI slots is different
for different machines, and you should experiment to determine which physical
board is Board 1. Also, the humbering under Windows 2000 may differ from the
numbering under Windows NT 4.0.

Every time the system is rebooted, the Osprey-2000 drivers re-enumerate the
boards in the system and make unique video capture entries for each board. If the
Multiple Opens box is not checked under Access for Multiple Boards on the
Configuration Page of the Osprey-2000 Video Control Dialog, a "default" registry
entry is made that represents the legacy method of opening multiple devices, as well
as registry entries for individual boards. If the box is not checked (selecting the
check box is recommended), only entries for specific cards are created.

The Recommended Multi-Board Selection Approach

The Legacy Multi-Board Selection Approach

The Recommended Multi-Board Selection
Approach

The recommended method is to check the Multiple Opens box on the Configuration
Page of the Osprey-500 Video Control Dialog. Checking this box should result in the
generation of only individual device names as video capture device entries. For
example, the following msvideo entries display for two Osprey-500 devices in the
system:

¢ o02kvc.dll - Osprey-2000 Card 1
¢ 02kvc.dll - Osprey-2000 Card 2
These "Card 1" / "Card 2" names should be used when opening the Osprey-2000. In

the event that you see a "Card Default" entry (see the legacy approach below), this
is for legacy applications that did not allow for specific device selection.
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The Legacy Multi-Board Selection
Approach

The non-recommended method is to not check the Multiple Opens box on the
Configuration Page of the Osprey-2000 Video Control Dialog. Not checking this box
should result in the generation of individual device names as well as Card Default
name as video capture device entries. For example, the following msvideo entries
display for two Osprey-500 devices in the system:

¢ 02kvc.dll - Osprey-2000 Card Default
¢ 02kvc.dll - Osprey-2000 Codec 1
¢ 02kvc.dll - Osprey-2000 Codec 2

If two or more boards are installed and you use the default device nhame to access
the Osprey driver, it first connects to the default board. Normally, the default board
is whichever board was most recently selected in the Control Dialog's Board Select
field. If this default board is in use (and the MultiOpen option is turned off), the next
available board is automatically selected. Once any board is selected, you can
change it to a different board by selecting the desired board in the application you
are using (often under a menu titled Options or Board Select).

Multiple boards may be accessed according to two main scenarios:

¢ Multiple processes accessing multiple boards: Start two standard applications
- or two copies of one application - such as VidCap32. The first copy comes up
connected to the default board and starts normally. The second copy
automatically hunts for the next available board in ascending numerical order.

¢ A ssingle application accessing multiple boards: A single custom application
can access two or more different boards. If the standard Video for Windows
interface is used, the access order is the same as described above.

¢ Multiple applications accessing single board: If you have the added-cost
SimulStream upgrade, then multiple applications can access a single board.
This option is described in detail in the SimulStreaming User's Guide.

Multiple Opens is much more precise and flexible for custom applications that use the
Osprey Video For Windows NT/2000 Software Developers' Kit (VFW SDK). This kit
allows you to override the default board in order to access any board at any time.
Please inquire at mailto:info@ospreyvideo.com for more information.
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Appendix G - File and Registry Usage

The following are files that are written and registry entries that are set when Osprey
drivers are installed. This information allows a technically proficient user to remove
the Osprey-2000 installation if the uninstaller is deleted or damaged. Not all of these
files will be present on your computer. The files and registry branches for all of the
optional software components for the Osprey-2000 Runtimes and SDKs, and the
driver are listed here. The files belonging to the individual components which you did
not choose to install will not be present on your computer.

Instructions for Windows NT 4.0

Instructions for Windows 2000

These instructions are for advanced users only!

Refer to Chapter 3 - Installing the Software - Windows 2000 or

& Chapter 4 - Installing the Software - Windows NT 4.0 to remove the
software. Be careful not to delete or alter any items other than the ones
described here!
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Instructions for Windows NT 4.0

1. Entries are added in the multimedia and system portions of the registry. When
manually removing the software, use the Control Panel to Remove the driver
(and delete these entries) before deleting individual files and registry entries.

2. In the main Windows NTSystem32 directory, these files can be removed:

o2kboard.dll
o2kvc.dll
02k_mix.dll
o2keusr.dll
o2k_wav.dll
o2komc.dll
opio2ka.dll
opio2kd.dll
opio2ke.dll
opio2kp.dll
oti.dll

otiopi.dll
otiyuv.dll
han.rbf
han2.rbf
hutt_merge.rbf
o2komc_transcoder.dll
SimulKey?2.dll

3. In the main Windows NT\System32\drivers directory, these files can be
removed:

o2kdrv.sys
o2ke.sys

4.  The Osprey-2000 install driver directory, its subdirectories, and its files can be
removed. Typically, this directory is \Program Files\ Osprey-2000 on the
default drive. The installation procedure puts the following files common to
Windows NT in that directory:

AmCap.exe

CropApp.exe

CroppingManual.pdf
MpegVCR.exe

Readme.txt

UsersGuide.htm

VidCap32.exe

Vidcap.hlp
Osprey-2000UsersGuide.pdf
SimulStreaming_Users_Guide.pdf

The subdirectory ucode and all its contents The subdirectory DirectShow and all its
contents The subdirectory OPI SDK and all its contents The subdirectory VFW SDK
and all its contents
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The installation program also creates a directory called NT within the Osprey-
2000 install directory which contains the following files:

Files Uninst*.isu
Files*.bmp
Oemsetup.inf

The subdirectory Help and all its contents The subdirectory Osprey Help and all its
contents

6.

In the registry the following branches are added and can be deleted without
affecting the rest of the system. Use RegEdit to delete them.

. HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\Drivers32 entries:

“vidc.i420"="otiyuv.dll” “vidc.yuy2"="otiyuv.dll”

HKEY_CURRENT_USER\Software\Osprey\OPI\Devices

HKEY_CURRENT_USER\Software\Osprey\Osprey2000

HKEY_LOCAL_MACHINE\HARDWARE\RESOURCEMAP\OtherDrivers\o2kdrv

HKEY_LOCAL_MACHINE\HARDWARE\RESOURCEMAP\OtherDrivers\o2ke

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\A

pp Paths\vidcap32.exe

. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\U
ninstall\ Osprey-2000

. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\drivers.desc entries:

“02k_mix.dll"="0Osprey-2000 Audio Mixer Driver”
“02k_wav.dll"="0sprey-2000 Audio Wave Driver”
“o2kvc.dll”="0sprey-2000 Video Capture Driver”
“otiyuv.dll”="0sprey Software Decoder”

* & & o o

& In this branch of the registry, the 1 on wave, mixer, and msvideo may be

a different numeral, or may not be present.

. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Drivers32 entries:

“msvideo”="02kvc.dll - Osprey-2000Codec 1" “mixer1”="02k_mix.dll”
“wavel”="02k_wav.dll”

. HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey2000

. HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast.com / Osprey Technologies,
Inc.\ Osprey-2000

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2kdrv
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ke
. HKEY_USERS/.DEFAULT\Software\Osprey\Osprey2000

Note: You can delete the Taskbar entry by selecting Taskbar Properties-> Start
Menu Programs -> Remove.
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Instructions for Windows 2000

1. Entries are added in the multimedia and system portions of the registry. When
manually removing the software, use the Control Panel to Remove the driver
(and delete these entries) before deleting individual files and registry entries.

In the main Windows 2000 \System32 directory, these files can be removed:

o2kvc.dll
o2k_wav.dll
o02k_mix.dll
o2keusr.dll
o2kboard.dll
o2komc.dll
o2kun.dll
opio2ka.dll
opio2kd.dll
opio2ke.dll
opio2kp.dll
oti.dll

otiopi.dll
otipnp.dll
otiyuv.dll
hutt_merge.rbf
o2komc_transcoder.dll
SimulKey?2.dll

2. In the main Windows 2000 \System32\drivers directory, these files can be
removed:

o2kdrv.sys
o2ke.sys

3. The Osprey-2000 install driver directory, its subdirectories, and its files can be
removed. Typically, this directory is \Program Files\ Osprey-2000 on the default
drive. The installation procedure puts the following files common to Windows
2000 in that directory:

AmCap.exe

CropApp.exe

CroppingManual.pdf
MpegVCR.exe

Readme.txt

Uninst.isu

VidCap32.exe

VidCap.hlp
Osprey-2000UsersGuide.pdf
SimulStreaming_Users_Guide.pdf

The subdirectory DirectShow and all its contents The subdirectory OPI SDK and all its
contents The subdirectory ucode and all its contents The subdirectory VFW SDK and
all its contents
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The installation program also creates a directory called NT within the Osprey-
2000 install directory which contains the following files:

files Dels*.isu

Files*.bmp

The subdirectory Help and all its contents The subdirectory w2000 and all its
contents The subdirectory Osprey Help and all its contents

5.

In the registry the following branches are added and can be deleted without
affecting the rest of the system. Use RegEdit to delete them.

& In this branch of the registry, the 1 on wave, mixer, and msvideo may be

a different numeral, or may not be present.

L2

*
*
*

Note:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Drivers32 entries:

"wavel"="02k_wav.dll"

"mixerl"="02k_mix.dll"

"msvideol"="02kvc.dll - Osprey-2000Codec 1"
HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\Drivers32 entries:

“vidc.i420"="otiyuv.dll”

r__n I n”

“vidc.yuy2”="otiyuv.dl
HKEY_CURRENT_USER\Software\Osprey\Osprey2000
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\drivers.desc entries:

"o2kvc.dll"="0sprey-2000 Video Capture Driver"
"o2ke.dll"="0sprey-2000 Audio Driver"
"o02k_wav.dll"="0Osprey-2000 Audio Wave Driver"
"02k_mix.dll"="Osprey-2000 Audio Mixer Driver"
"o2kboard.dll"="0Osprey-2000 Audio Board Driver"
HKEY_CURRENT_USER\Software\Osprey\OPI\Devices
HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\Drivers32 entries:

“vidc.i420"="otiyuv.dIl”

4 ”

“vidc.yuy2”="otiyuv.dll”
HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey2000

HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast.com / Osprey Technologies,
Inc.\Osprey-2000

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey-2000

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\MediaResources\
msvideo\!default entry: "Driver" = "o2kvc.dll - Osprey-2000Codec 1

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2kdrv
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ke
HKEY_USERS\.DEFAULT\Software\Osprey\Osprey2000

You can delete the Taskbar entry by selecting Taskbar Properties -> Start

Menu Programs -> Remove.
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Appendix H - Adding/Moving Boards in
Windows 2000

Under Windows 2000, when the driver has been installed and another Osprey-2000
board is put into a slot that has not previously contained a board, the following
sequence of windows is initiated. This can happen because an Osprey-2000 board
has been moved to a different PCI slot or when a board is been added to the
machine. It occurs because of the manner in which Windows 2000 enumerates
devices.

The New Hardware Wizard runs and displays two windows. A smaller window with
the text Found New Hardware, Osprey-2000 Video Capture Device, Installing (not
shown here) may be obscured by the larger Digital Signature Not Found window.

Digital Signature Nok Found P - |

The Microzoft digital signature affirms that zoftware haz
been tested with Windows and that the software has not
been altered since it was tested.

The zoffware pou are about to inztall doez not contain a
bicrosoft diptal signature. Therefore, there iz no
guarantes that this software works comrecth with
efindowes.

O zprey-2000 Yiden Caphure Device

I vou want bo search for Microzoft digitally signed
software, visk the Windows Update Web site at

hittp: £ fwindowsupdate microzoft.com to see if one iz
avallable.

Do you want bo conbinue the nstallation’?

Ho More Info

1. Click Yes.
The Multimedia Video Controller installing window displays.

The text inside this window will change to Osprey-2000 Audio Capture Device,
Installing (not shown here) and the following Digital Signature Not Found window will
appear on top of it.
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Digital Signature Not Found _ . X|

The Microzoft digital signature affirms that zoftware haz
besn tested with Windows and that the saftware has not
been altered since it was tested.

The zoffware pou are about bo inztall does not contain a
Picrosoft digtal sianature. Therefore, there iz no
guarantes that thiz software works comrecth with
efidiows.

D zprey-2000 Yiden Capture Device

I vou want bo search for Microzoft digitally signed
software, visk the Windows Update Web site at
hittp: £ fwindowsupdate microzoft.com to see if one iz
avallable

Do you want bo conbinue the nstallation’?

Ho tore [nfo

2. Click Yes.

Completing the Found Mew Hardware Wizard

\@E Dzprey-2000 Audio Capture Device

_—
-

Windows has finished ingtaling the zoftware for this device.

The hardware you installed will not wark, until you restart
Your cormputer.

To cloge thiz wizard, click Finizh.

< Back

Canzel |

3.  When the Completing the Found New Hardware window displays, click Finish.
4.  Note that you will see two Digital Signature Not Found windows for each
Osprey-2000 board that you have added or removed.

5.  When the Systems Settings Change window displays indicating that you must
restart your computer before the new settings will take effect, click Yes to
restart your computer.
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